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概要

				このガイドでは、Red Hat Fuse Tooling の使用方法について説明します。Fuse Tooling は、統合アプリケーションの設計、開発、テスト、およびデバッグを実行する際の生産性向上を目的として設計された開発者ツールを提供します。
			






はじめに




			Red Hat Fuse Tooling は、Red Hat CodeReady Studio 内で統合アプリケーションを開発するプロセスを簡素化および合理化する Eclipse ベースの IDE です。Fuse Tooling は、以下で動作するように特別に設計された一連の開発者ツールを提供します。
		
	
					Red Hat Fuse
				
	
					Red Hat JBoss EAP
				
	
					Apache Camel
				
	
					Apache CXF
				
	
					Apache Karaf
				
	
					Spring Boot
				



			このガイドでは、FuseTooling を使用して以下を行う方法について説明します。
		
	
					Maven 依存関係を含むアプリケーションのプロジェクトを作成する
				
	
					エンタープライズ統合パターンを接続および設定してルートを構築する
				
	
					エンドポイントとルートを参照する
				
	
					実行中のルートにメッセージをドラッグアンドドロップする
				
	
					JMX を介してランタイムプロセスを参照および可視化する
				
	
					ローカルで実行されている Camel コンテキストとルートをデバッグする
				
	
					以下の方法でアプリケーションをテストする
				
	
							Apache Camel ルートで JUnit テストケースを作成および使用する
						
	
							JMX を使用して実行中のコンポーネントを分析する
						
	
							Apache Camel ルートを介してメッセージをトレースする
						



	
					アプリケーションをデプロイする
				



			新規ユーザー用に、Tooling チュートリアル は、サンプル Camel アプリケーションを作成、デバッグ、テスト、およびデプロイするためのステップバイステップの手順を提供します。
		

多様性を受け入れるオープンソースの強化




			Red Hat では、コード、ドキュメント、Web プロパティーにおける配慮に欠ける用語の置き換えに取り組んでいます。まずは、マスター (master)、スレーブ (slave)、ブラックリスト (blacklist)、ホワイトリスト (whitelist) の 4 つの用語の置き換えから始めます。この取り組みは膨大な作業を要するため、今後の複数のリリースで段階的に用語の置き換えを実施して参ります。詳細は、Red Hat CTO である Chris Wright のメッセージ をご覧ください。
		

パート I. アプリケーションの開発






第1章 新しい Fuse Integration プロジェクトの作成



概要




				新しい Fuse Integration プロジェクトの作成には、次の主な手順が含まれます。
			
	
						プロジェクト名とワークスペースの指定
					
	
						プロジェクトデプロイメント環境の設定
					
	
						プロジェクトテンプレートの選択
					
	
						必要な場合: Maven 依存関係エラーの解決
					



				ツールは、プロジェクトを設定した後、必要なすべての Maven 依存関係をダウンロードし、プロジェクトの実行と公開に必要な POM ファイルを作成します。
			
注記

					CodeReady Studio で初めて Fuse プロジェクトをビルドする場合、リモート Maven リポジトリーから依存関係をダウンロードするため、ウィザードがプロジェクトの生成を完了するまで数分かかることがあります。
				


作業を開始する前に




				新しい Fuse Integration プロジェクトを作成する前に、次の情報が必要です。
			
	
						ターゲットランタイム環境: OpenShift 上の Fuse またはスタンドアロンの Fuse (Spring Boot、Karaf 上の Fuse、または EAP 上の Fuse)
					
	
						Camel バージョン (ツールでデフォルト以外が使用される場合)
					



プロジェクト名とワークスペースの指定




				新しい Fuse Integration プロジェクトを作成するには、次の手順を実行します。
			
	
						New → Project → Red Hat Fuse → Fuse Integration Project を選択して、New Fuse Integration Project ウィザードを開きます。
					

						ウィザードが開き、Location ペインの Use default workspace location オプションが選択されています。
					
[image: nfpProjectName1]


	
						Project Name に、新規プロジェクトの名前を入力します (例: MySampleProject)。
					
	
						プロジェクトのデータを保存するワークスペースの場所を指定します。
					
	
								デフォルトのワークスペースを使用するには、Use default workspace location オプションを有効のままにします。
							
	
								別の場所を使用するには、Use default workspace location オプションをオフにし、Path フィールドで場所を指定します。
							

								[image: BrowseButton]
								 をクリックし、簡単に別のワークスペースを検索して選択します。
							




	
						Next をクリックして Select a Target Environment ページを開きます。
					



プロジェクトデプロイメント環境の設定




				新規プロジェクトを作成する際に、プロジェクトのターゲットデプロイメント環境を指定して、プロジェクトが実行時に必要なリソースを確保します。デプロイメントプラットフォームと Camel バージョンを選択する必要があります。オプションで、ランタイム設定を指定できます。
			

				Select a Target Environment ページを開いた状態で、次の操作を行います。
			
	
						プロジェクトを、Kubernetes/OpenShift と Standalone のどちらのプラットフォーム上にデプロイするか選択します。
					
[image: NFPcamelVersion]


						デプロイメントプラットフォームに Kubernetes/OpenShift を選択すると、Sprint Boot ランタイムが自動的に選択されます。その場合、ステップ 3 に進みます。
					

	
						デプロイメントプラットフォームに Standalone を選択した場合、以下を実行します。
					
	
								ターゲットランタイム環境を選択します。
							
	
										Spring Boot
									
	
										Karaf/Karaf 上の Fuse
									
	
										Wildfly/EAP 上の Fuse
									



	
								Karaf および EAP スタンドアロンランタイム環境の場合、ランタイム設定として次のいずれかのオプションを選択します。
							
	
										None selected オプションを選択します (後でランタイム設定を定義できます)。
									
	
										ドロップダウンメニューから既存のランタイム設定を選択します。
									
	
										「新しいターゲットランタイムの作成 (オプション)」 の説明に従って、新規ランタイム設定を作成します。
									






	
						Select the Camel version for your new project ペインで、ランタイムに関連付けられているデフォルトの Camel バージョンを選択するか、次の方法でデフォルトを変更します。
					
	
								ドロップダウンリストから Camel バージョンを選択します。Fuse Tooling は、リストされている製品化バージョンをサポートしています。
							
	
								製品化されていない (サポートされていない) バージョンを試す場合は、別の Camel バージョンを入力します。
							

								Verify ボタンをクリックすると、ツールが指定したバージョンにアクセスできるか確認できます。そうでない場合は、次の例のような通知が Select a Target Runtime ページのヘッダーに表示されます。
							
[image: Camel の検証]

注記

									プロジェクトを作成、設定、および保存した後、Camel のバージョンを変更できます。12章Camel バージョンの変更を参照してください。
								





	
						新しい Fuse Integration プロジェクトのベースとなるランタイム環境と Camel バージョンを選択したら、Next をクリックしてウィザードの Advanced Project Setup ページを開き、「プロジェクトテンプレートの選択」 の手順に従います。
					


新しいターゲットランタイムの作成 (オプション)




				Karaf および EAP スタンドアロンランタイム環境の場合、オプションで、New Fuse Integration Project ウィザードから新しいランタイム設定を作成できます。
			
	
						ウィザードの Select a Target Runtime ページで、New をクリックして New server runtime environment ページを開きます。
					
[image: 新しいサーバーのランタイム環境]


	
						Red Hat JBoss Middleware フォルダーを展開し、Red Hat Fuse のランタイム環境を選択します。
					

						Create a new local server オプションをオフのままにします。プロジェクトを公開する準備ができたら、後でローカルサーバーを作成できます (「サーバーの追加」 を参照)。
					
注記

							Create a new local server オプションをオンにすると、New Fuse Integration Project ウィザードに Fuse サーバーランタイムを定義および設定するための追加手順の説明が表示されます (「サーバーの追加」 の説明を参照)。次に、プロジェクトをビルドするときに、Fuse Integration パースペクティブの Servers ビューにもサーバーランタイムが追加されます。
						


	
						Next をクリックして、サーバーの New Server Runtime Environment ページを開きます。
					
[image: nfpRuntimeDefJBF1]


	
						サーバーランタイムの Name、Home Directory、Execution Environment を指定します。
					
	
								Name — デフォルトを使用するか、ランタイム環境の新しい名前を入力します。
							
	
								Home Directory — Browse ボタンをクリックして、サーバーランタイムのインストールディレクトリーを見つけて選択します。
							
注記

									サーバーがマシンにインストールされていない場合は、ここで Download and install runtime リンクをクリックし、サイトのダウンロード手順に従ってサーバーをインストールできます。サイトによっては、ダウンロードプロセスを続行する前に、有効なクレデンシャルの提供が必要なこともあります。
								


	
								Runtime JRE: Execution Environment — デフォルトを使用するか、ドロップダウンリストから別の JavaSE バージョンを選択します。
							

								目的のバージョンがリストに表示されない場合は、Environments ボタンをクリックして、そのリストからバージョンを選択します。選択した JRE バージョンがマシンにインストールされている必要があります。
							
注記

									Fuse 7.x には JRE バージョン 1.8 が必要です。
								


	
								Runtime JRE: Alternate JRE - プロジェクトで異なるバージョンの Java が必要な場合は、このオプションを使用できます。
							



	
						Finish をクリックして、New Fuse Integration Project ウィザードの Select a Target Runtme ページに戻ります。
					

						新しく設定されたターゲットランタイムが Target Runtime ペインのドロップダウンメニューに表示され、ランタイムでサポートされている Camel バージョンが Camel Version ペインにグレー表示されます。
					

						Fuse Integration プロジェクトを作成した後は、Camel のバージョンを変更できます。12章Camel バージョンの変更を参照してください。
					

	
						Next をクリックして、「プロジェクトテンプレートの選択」 で説明されているようにプロジェクトのテンプレートを指定します。
					




プロジェクトテンプレートの選択




				Advanced Project Setup ページには、新しいプロジェクトの開始点として使用できるテンプレートのリストが表示されます。テンプレートは一般的なユースケースに基づいており、サンプルコードとデータが提供されているため、すぐに使い始めることができます。使用可能なテンプレートのリストは、前のページで選択したランタイム環境によって異なります。テンプレートを選択すると、右側のペインにその説明が表示されます。
			
注記

					要件を満たすテンプレートが表示されない場合は、Where can I find more examples to use as templates? をクリックすると情報ダイアログボックスが開き、さらに多くの例を含む URL リストが表示されます。
				
[image: nfpTemplateExamples]


					これらの例の 1 つを使用するには、以下を実行します。
				
	
							Cancel を選択して、New Fuse Integration Project ウィザードを終了します。
						
	
							リストされた URL の 1 つからリポジトリーのクローンを作成します。
						
	
							13章既存 Maven プロジェクトのインポート で説明されているとおり、サンプルプロジェクトを CodeReady Studio にインポートします。
						



	
						Fuse on OpenShift には、Spring XML 設定ファイルを使用して Spring Boot で Camel ルートを設定する方法を示すテンプレートが 1 つあります。このテンプレートは Fuse Integration プロジェクトを作成します。また、2.18.1.redhat-000012 より新しい Camel バージョンが必要です。
					

						このテンプレートは、OpenShift サーバーで実行されるプロジェクトを作成し、Spring DSL のみサポートします。このテンプレートの使用の詳細については、7章Fuse on OpenShift の使用 を参照してください。
					
[image: nfpTemplateOpenShift]


	
						Wildfly または Fuse on EAP の場合、こんにちはと言うために Bean サービスを呼び出すサンプル Camel ルートを提供するテンプレートが 1 つあります。このテンプレートは、Red Hat EAP サーバーで実行されるプロジェクトを作成し、Spring DSL のみサポートします。
					
[image: nfpTemplateEAP]


	
						Karaf または Fuse on Karaf の場合、テンプレートを選択できます。サポートされている 3 つのドメイン固有言語 (DSL) のいずれかに基づいてスケルトン Camel コンテキストのルーティングファイルを作成する空のプロジェクトを作成するか、事前定義されたテンプレート (それぞれ一般的なユースケースに基づく) を使用できます。個々のテンプレートがすべての DSL オプションをサポートしているとは限りません。
					
注記

							Java DSL の場合、ツールはツールの Java エディターで編集することができる CamelRoute.java ファイルを生成しますが、グラフィカルダイアグラム表現を生成しません。
						

	
								Content Based Router — 特定の場所からファイルを読み取り、メッセージの内容に応じて異なる出力フォルダーにルーティングするサンプル Camel ルートを提供します。
							

								このテンプレートは、Red Hat Fuse サーバーで実行されるプロジェクトを作成し、3 つの DSL をすべてサポートします。
							

	
								CXF code first — CXF Web サービス呼び出しによって開始されるサンプル Camel ルートを提供します。
							

								このテンプレートは、Red Hat Fuse サーバーで実行されるプロジェクトを作成し、Spring および Java DSL のみサポートします。
							
[image: nfpTemplateKaraf]

	
										リストからテンプレートを選択します。
									
	
										Finish をクリックします。
									

										ツールはプロジェクトの構築を開始し、それを Project Explorer ビューに追加します。
									

										Fuse Integration パースペクティブがまだ開いていない場合、ツールは今すぐそれに切り替えるかどうかを尋ねます。
									
[image: OpenAssociatedPerspective]


	
										Yes をクリックして、Fuse Integration パースペクティブで新しいプロジェクトを開きます。
									
[image: nfpTemplateProjectOpen]


										プロジェクトが Project Explorer ビューに表示されます。デフォルトでは、プロジェクトには Apache Camel コンテキスト (XML) ファイルが含まれています。
									

	
										キャンバスの下部にある Source タブをクリックして、生成された Camel コンテキストファイルを表示します。
									
[image: nfpTemplateCBRsource]










注記

					プロジェクトに別の新しい Camel コンテキストファイルを追加する場合は、11章新規 Camel XML ファイルの作成 を参照してください。
				

					CXF を使用するプロジェクトをビルドする場合、Java ファイルでビルドプロセスが自動的に実行されて WSDL ファイルが生成されるようにできます。そのためには、プロジェクトの .pom ファイルで java2ws Maven プラグインを設定します。Apache CXF 開発ガイドの Maven ツーリングリファレンスの java2ws を参照してください。
				


Maven 依存関係エラーの解決




				新しい Fuse Integration プロジェクトを作成した後、Maven 依存関係エラーが発生することがあります。
			

				他の場合でも発生する可能性はありますが、通常は、プロセスが完了する前にプロジェクトのビルドをキャンセルした場合に発生します。この方法でプロセスを中断すると、プロジェクトのすべての依存関係が Maven リポジトリーからダウンロードできなくなることがよくあります。これには時間がかかる場合があります。
			

				多くの場合、これらの依存関係エラーは、Maven 依存関係を次のように更新することで解決できます。
			
	
						Project Explorer ビューで、ルートプロジェクトを右クリックしてコンテキストメニューを開きます。
					
	
						Maven → Update Project を選択します。
					
	
						Update Maven Project ウィザードで、以下を実行します。
					
	
								ウィザードのリストに複数のプロジェクトが表示されている場合は、更新するプロジェクトを選択します。
							
	
								Force Update of Snapshots/Releases オプションをクリックして有効にします。
							



	
						OK をクリックします。
					

						欠落している依存関係が Maven リポジトリーからダウンロードされる際に、ワークベンチの右下隅に進行状況を示すバーが表示されます。
					





第2章 ルートエディターを使用したルーティングコンテキストの編集



The following sections describe how to edit a routing context.
ルートへのパターンの追加




					ルートは、接続されたパターンのシーケンスで設定されます。これは、Route コンテナーノード内のキャンバスに配置されると ノード と呼ばれます。完全なルートは通常、開始エンドポイント、一連の処理ノード、および 1 つ以上の宛先エンドポイントで設定されます。
				

					キャンバス上のルートコンテナーにパターンを追加すると、パターンはノードのタイプを示す色になります。
				
	
							青: コンテキストファイルのルート要素に対応するルートコンテナー、および when やロジックを完了する他の EIP が含まれる otherwise EIP 等の他のコンテナーノード
						
	
							緑: ルートに入力するデータを入力するコンシューマーエンドポイント
						
	
							オレンジ: データ転送ルートのフローをルーティング、変換、処理、または制御する EIP
						
	
							紫: ルートを出るデータを出力するプロデューサーエンドポイント
						


手順




					ルートにパターンを追加するには、以下を実行します。
				
	
							Palette で、ルートに追加するパターンを見つけます。
						
	
							以下の方法のいずれかを使用します。
						
	
									Palette でパターンをクリックしてから、キャンバスでルートコンテナーをクリックします。
								
	
									パターンをターゲット Route コンテナーにドラッグし、ドロップする。
								

									または、発信接続がない既存のノード、または 2 つのノード間に存在する接続にパターンを追加して、ツールが関係するすべてのノード間の接続を自動的にワイヤリングするようにもできます。
								

									ツールは、その結果として得られる接続が有効かどうかをチェックし、ターゲットにパターンを追加することを許可または禁止します。有効な接続の場合、ターゲットがノードであるか接続であるかによって、ツールの動作が異なります。
								
	
											既存ノード の場合、ツールは新しいノードをターゲットノードの発信側 (エディターの設定方法 に応じてその下または右側) に追加し、それらの間の接続を自動的にワイヤリングします。
										
	
											既存の接続 の場合、ツールは接続された 2 つのノードの間に新しいノードを挿入し、3 つのノード間の接続を自動的に再度ワイヤリングします。
										






	
							オプションで、2 つのノードを手動で接続できます。
						
	
									キャンバスの Route コンテナーで、ソースノードを選択して、そのコネクター矢印を表示します。
								
	
									ソースノードのコネクター矢印 ( 
									[image: ConnectorArrow]
									 ) をターゲットノードにドラッグし、マウスボタンを解放してコネクターをドロップします。
								
注記

										すべてのノードを接続できるわけではありません。ソースノードを無効なターゲットノードに接続しようとすると、ツールは 
										[image: unconfigured co gray]
										 シンボルをマウスカーソルに付けて表示し、コネクターをターゲットノードに付ける操作に失敗します。
									





	
							ルートコンテナー内にパターンを追加した後、有効な接続を確立できる限り、ルートコンテナー内の別の場所またはキャンバス上の別のルートコンテナーにパターンをドラッグできます。移動によって別の有効な接続を確立できる限り、すでに接続されている既存のノードを再配置することもできます。
						

							こちら をクリックすると、エンドポイントを再配置する方法を説明する短い動画を閲覧できます。
						

	
							File → Save を選択します。ツールは、ルートが完全であるかどうかに関係なく、ルートをコンテキストファイルに保存します。
						



					Route コンテナーのキャンバスに新しいパターンが表示され、選択したノードになります。Properties ビューには、編集可能な新しいノードのプロパティーのリストが表示されます。
				

レイアウト方向の変更




					あるノードを別のノードに接続すると、ツールはルートエディターのレイアウト設定に従ってレイアウトを更新します。デフォルトは Down です。
				

					ルートエディターのレイアウト設定にアクセスするには、以下を実行します。
				
	
							Linux および Windows マシンでは、Windows → Preferences → Fuse Tooling → Editor → Choose the layout direction for the diagram editor を選択します。
						
	
							OS X では、CodeReady Studio → Preferences → Fuse Tooling → Editor → Choose the layout direction for the diagram editor を選択します。
						



関連トピック



	
							「パターンの設定」
						
	
							「ルートからパターンを削除」
						




パターンの設定



概要




					ほとんどのパターンでは、明示的な設定が必要です。たとえば、エンドポイントには明示的に URI を入力する必要があります。
				

					ツールの Properties ビューには、特定のパターンがサポートするすべての設定詳細を一覧表示するフォームがあります。Properties ビューには、次の便利な機能もあります。
				
	
							すべての必須プロパティーに値があることを検証する機能
						
	
							指定された値がプロパティーの正しいデータ型であることを検証する機能
						
	
							値のセットが固定されているプロパティーのドロップダウンリスト
						
	
							Apache Camel Spring 設定から利用可能な Bean 参照が入力されたドロップダウンリスト
						



手順




					パターンを設定するには、以下を実行します。
				
	
							キャンバスで、設定するノードを選択します。
						

							Properties ビューには、選択したノードのすべてのプロパティーが一覧表示され、編集できます。EIP の場合、Details タブには、パターンのプロパティーがすべて一覧表示されます。Components ドロワーのコンポーネントの場合、Details タブには一般的なプロパティーと値が必要なプロパティーが一覧表示され、Advamced タブには機能ごとにグループ化された追加のプロパティーが一覧表示されます。
						

							Documentation タブには、パターンとそのそのプロパティーが記載されています。
						

	
							Properties ビューのフィールドを編集して、ノードを設定します。
						
	
							完了したら、メニューバーから File → Save を選択して作業を保存します。
						




ルートからパターンを削除



概要




					ルートを開発および更新するときに、ルートのノードを 1 つ以上削除する必要がある場合があります。ノードの 
					[image: garbageIcon]
					 アイコンを使用すると、これを簡単に実行できます。キャンバスからノードを削除すると、ルート内の他のノードとの接続もすべて削除され、そのノードはコンテキストファイル内の対応するルート要素から削除されます。
				
注記

						ノードのコンテキストメニューを開いて Remove を選択しても、ノードを削除できます。
					


手順




					ルートからノードを削除するには、以下を実行します。
				
	
							削除するノードを選択します。
						
	
							その 
							[image: garbageIcon]
							 アイコンをクリックします。
						
	
							この要素を削除するかどうかを確認するメッセージが表示されたら、Yes をクリックします。
						



					ノードとそのすべての接続がキャンバスから削除され、ノードがコンテキストファイルの対応するルート要素から削除されます。
				

関連トピック



	
							「ルートへのパターンの追加」
						




ルーティングコンテキストへのルートの追加



概要




					XML コンテキストファイル内の camelContext 要素は、ルーティングコンテキストを作成します。camelContext 要素には 1 つ以上のルートが含まれ、キャンバスに Route コンテナーノードとして表示される各ルートは、生成された camelContext 要素のルート要素にマッピングされます。
				

手順




					camelContext に別のルートを追加するには、以下を実行します。
				
	
							Design タブで、次のいずれかを実行します。
						
	
									Palette の Routing ドロワーで Route パターンをクリックし、ルートを配置するキャンバスをクリックする。
								
	
									Palette の Routing ドロワーから Route パターンをドラッグしてキャンバスにドロップする。
								

									Properties ビューには、編集可能な新しいルートのプロパティーのリストが表示されます。
								




	
							Properties ビューで、以下を入力します。
						
	
									ルートの Id フィールドの新しいルートの ID (例: Route2)
								
注記

										ツールは、キャンバスにドロップされた EIP およびコンポーネントパターンに ID を自動的に割り当てます。これらの自動生成された ID を独自の ID に置き換えて、プロジェクト内のルートを区別することができます。
									


	
									Description フィールドのルートの説明
								
	
									必要に応じて、その他のプロパティーの値。必要なプロパティーはアスタリスク (*) で示されます。
								



	
							メニューバーで、File → Save を選択して、ルーティングコンテキストファイルに加えた変更を保存します。
						
	
							複数のルートを切り替えるには、Project Explorer ビューでプロジェクトの Camel Contexts フォルダーにあるエントリーをクリックして、キャンバスで表示するルートを選択します。
						
[image: routeEntriesProjectExplorer]


	
							スペースが許す範囲でコンテキスト内のすべてのルートを表示するには、Project Explorer ビューでコンテキストファイルエントリーをクリックします。
						
	
							キャンバスにルートを追加するときにツールによって生成されたコードを表示するには、Source タブをクリックします。
						
注記

								また、camelContext 要素内の既存リストに <route/> 要素を追加すると、Source タブでルートを追加できます。
							






ルートの削除



概要




					場合によっては、ルーティングコンテキストからルート全体を削除する必要があります。Route コンテナーの 
					[image: garbageIcon]
					 アイコンを使用すると、これを簡単に実行できます。ルートを削除すると、ルートコンテナー内のすべてのノードも削除され、コンテキストファイル内の対応するルート要素が削除されます。
				
注記

						ルートコンテナーのコンテキストメニューで Remove を選択しても、ルートを削除できます。
					

重要

						この操作を元に戻すことはできません。
					


手順




					ルートを削除するには、以下を実行します。
				
	
							ルーティングコンテキストに複数のルートが含まれている場合は、最初に Project Explorer ビューで削除するルートを選択します。
						
[image: routeEntriesProjectExplorer]


	
							キャンバスで Route コンテナーの 
							[image: garbageIcon]
							 アイコンをクリックします。
						
[image: routeDelete]


	
							この要素を削除するかどうかを確認するメッセージが表示されたら、Yes をクリックします。
						



					キャンバス、コンテキストファイル、および Project Explorer ビューからルートが削除されます。
				


グローバルエンドポイント、データ形式、Bean の追加



概要




					一部のルートは、グローバルエンドポイント、グローバルデータ形式、またはグローバル Bean によって提供される共有設定に依存しています。ルートエディターの Configurations タブを使用して、プロジェクトのルーティングコンテキストファイルにグローバル要素を追加できます。
				

					ルーティングコンテキストファイルにグローバル要素を追加するには、以下を実行します。
				
	
							ルートエディターでルーティングコンテキストファイルを開きます。
						
	
							グローバル設定がある場合は、ルートエディターの下部にある Configurations タブをクリックしてそれを表示します。
						
[image: ConfigurationsView]


	
							Add をクリックして、Create a new global element ダイアログボックスを開きます。
						
[image: CnfigsVAddButton]


							オプションは次のとおりです。
						
	
									エンドポイント: 「グローバルエンドポイントの追加」 を参照してください。
								
	
									データ形式: 「グローバルデータ形式の追加」 を参照してください。
								
	
									Bean: 「グローバル Bean の追加」 を参照してください。
								






グローバルエンドポイントの追加



	
							Create a new global element ダイアログボックスで Endpoint を選択し、OK をクリックして Select component ダイアログボックスを開きます。
						
[image: CnfigsVSelectCamComponent1]

注記

								デフォルトでは、Select component ダイアログボックスが開き、Show only palette components オプションが有効になっています。使用可能なすべてのコンポーネントを表示するには、このオプションのチェックを外します。
							

注記

								Grouped by categories オプションは、コンポーネントをタイプ別にグループ化します。
							
[image: CnfigsVSelectCamComponentGrouped]



	
							Select component ダイアログで Camel コンポーネントのリストをスクロールして、コンテキストファイルに追加するコンポーネントを見つけて選択し、次に Id フィールドにその ID を入力します。
						
[image: CnfigsVCamComponentSelected]


							この例では、JMS コンポーネントが選択され、myJMS が Id の値になります。
						

	
							Finish をクリックします。
						
[image: CnfigsVmyEndptAdded2]


							これで、必要に応じて Properties ビューでプロパティーを設定できるようになりました。
						

							ツールによって、[globalEndptSelect]でコンポーネントの Id フィールドに入力した値が Id に自動入力されます。この例では、Camel はコンポーネントのスキーマ (ここでは jms:) で始まる uri (必須フィールド) を構築しますが、destinationName と destinationType を指定してコンポーネントの uri を完了する必要があります。
						
注記

								JMS コンポーネントの場合、宛先のタイプはデフォルトで queue に設定されます。このデフォルト値は、Destination Name (必須フィールド) に値を入力するまで、Details ページの uri フィールドに表示されません。
							


	
							コンポーネントの URI を完了するには、Advanced をクリックします。
						
	
							Destination Name フィールドに、宛先エンドポイントの名前を入力します (例: FOO.BAR)。Destination Type フィールドにエンドポイント宛先のタイプを入力します (例: queue、topic、temp:queue、または temp:topic)。
						
[image: JMSCompAdvanPathProp]


							Properties ビューの Details タブと Advanced タブから、特定のコンポーネントの設定に使用できるすべてのプロパティーにアクセスできます。
						

	
							Consumer (advanced) タブをクリックします。
						
[image: JMSCompConsumerAdvanProps2]


							プロパティーの Eager Loading Of Properties と Expose Listener Session を有効にします。
						

	
							ルートエディターで Source タブに切り替えて、最初のルート要素の前にツールがコンテキストファイル (この例では、設定された JMS エンドポイント) に追加したコードを確認します。
						
[image: CnfigsEndptSourceView]


	
							完了したら、メニューバーで File → Save を選択して変更を保存します。
						



グローバルデータ形式の追加



	
							Create a new global element ダイアログボックスで、Data Format を選択し、OK をクリックして Create a global Data Format ダイアログボックスを開きます。
						
[image: CnfigsVCreateGlobalDF1]


							データフォーマットのデフォルトは、利用可能なフォーマットリストの一番上の avro です。
						

	
							Data Format ドロップダウンメニューを開き、xmljson などの形式を選択します。
						
	
							Id フィールドに、フォーマットの名前を入力します (例: myDataFormat)。
						
[image: CnfigsVCreateGlobalDF2]


	
							Finish をクリックします。
						
[image: CnfigsVEditGlobalDFprops1]


	
							Properties ビューで、プロジェクトに応じてプロパティー値を設定します。以下はその例です。
						
[image: CnfigsVEditGlobalDFprops2]


	
							ルートエディターで、Source タブをクリックして、ツールがコンテキストファイルに追加したコードを確認します。この例では、設定された xmljson データ形式は最初のルート要素の前にあります。
						
[image: CnfigsVGlobalDFSourceV]


	
							完了したら、メニューバーで File → Save を選択して変更を保存します。
						



グローバル Bean の追加




					グローバル Bean は、ルート内のどこからでも参照できるルート外の Bean 定義を有効にします。Bean コンポーネントをパレットからルートにコピーすると、Properties ビューの Ref ドロップダウンで定義済みのグローバル Bean を見つけることができます。Bean コンポーネントが参照するグローバル Bean を選択します。
				

					グローバル Bean 要素を追加するには、以下を実行します。
				
	
							Create a new global element ウィンドウで、Bean を選択し、OK をクリックして Bean Definition ダイアログボックスを開きます。
						
[image: CnfigsVCreateGlobalBean1]


	
							Id フィールドに、グローバル Bean の ID (例: TransformBean) を入力します。ID は、設定内で一意である必要があります。
						
	
							Bean クラスまたはファクトリー Bean を識別します。
						

							ファクトリー Bean を指定するには、ファクトリークラスが指定された別のグローバル Bean をすでに追加している必要があります。次に、そのグローバル Bean を選択して、グローバル Bean ファクトリーとして宣言できます。Bean ファクトリークラスの 1 つのインスタンスがランタイムにあります。他のグローバル Bean は、そのクラスのファクトリーメソッドを呼び出して、他のクラスの独自のインスタンスを作成できます。
						

							Class フィールドに入力するには、次のいずれかを実行します。
						
	
									プロジェクトまたは参照プロジェクトにあるクラスの名前を入力します。
								
	
									… をクリックして、プロジェクトまたは参照されるプロジェクトのクラスに移動し、選択する。
								
	
									+ をクリックして新しい Bean クラスを定義し、それをグローバル Bean として追加します。
								



	
							追加する Bean で 1 つ以上の引数が必要な場合、Constructor Arguments セクションで各因数に対して以下を実行します。
						
	
									Add をクリックします。
								
	
									必要に応じて、Type フィールドに引数のタイプを入力します。デフォルトは java.lang.String です。
								
	
									Value フィールドに、引数の値を入力します。
								
	
									OK をクリックします。
								



	
							オプションで、グローバル Bean にアクセス可能な 1 つ以上のプロパティーを指定します。Bean Properties セクションで、プロパティーごとに以下を実行します。
						
	
									Add をクリックします。
								
	
									Name フィールドにプロパティー名を入力します。
								
	
									Value フィールドに、プロパティーの値を入力します。
								
	
									OK をクリックします。
								



	
							Finish をクリックして、グローバル Bean を設定に追加します。指定したグローバル Bean ID は、次のように Configurations タブに表示されます。
						
[image: CnfigsBeanInList]


	
							Source タブに移動し、ツールがコンテキストファイルに追加した bean 要素を表示します。以下に例を示します。
						
[image: CnfigsBeanSourceV]


	
							Configurations タブをクリックしてグローバル要素のリストに戻り、グローバル Bean を選択して、その標準プロパティーを Properties 次に例を示します。
						
[image: CnfigsBeanProperties]

注記

								グローバル Bean を追加したときに指定したプロパティーを表示または編集するには、Configurations タブで Bean を選択し、Edit をクリックします。
							


	
							必要に応じてグローバル Bean プロパティーを設定します。
						
	
									Depends-on は、このグローバル Bean の前に作成する必要がある Bean を識別するために使用できる文字列です。依存 Bean の ID (名前) を指定します。たとえば、TransformBean を追加し、Depends-on を ChangeCaseBean に設定すると、ChangeCaseBean を作成する必要があり、TransformBean を作成できます。Bean が破棄されると、TransformBean が最初に破棄されます。
								
	
									Factory-method は、グローバル Bean がファクトリークラスである場合にのみ役立ちます。この状況では、Bean が参照されるときに呼び出される静的ファクトリーメソッドを指定または選択します。
								
	
									スコープは singleton または prototype です。デフォルトは singleton で、Bean が呼び出されるたびに Camel が同じ Bean のインスタンスを使用することを示します。Bean が呼び出されるたびに Camel が Bean の新規インスタンスを作成するようにするには、prototype を指定します。
								
	
									init-method: Bean の参照時に呼び出す Bean の init() メソッドを指定または選択できます。
								
	
									Destroy-method を使用すると、Bean によって実行される処理が完了したときに呼び出す Bean の破棄メソッドを指定または選択できます。
								



	
							完了したら、メニューバーで File → Save を選択して変更を保存します。
						



グローバル要素の削除




					以前にルーティングコンテキストに追加されたエンドポイント、データ形式、または Bean を削除する場合でも、手順は同じです。
				
注記

						グローバル要素の削除を元に戻す操作は実行できません。設定に保持したいグローバル要素を誤って削除した場合、保存せずにコンテキストファイルを閉じることで削除を元に戻すことができる場合があります。これが不可能な場合は、誤って削除したグローバル要素を再度追加してください。
					

	
							Configurations タブで、削除するグローバル要素を選択します。
						

							たとえば、「グローバルデータ形式の追加」で追加したデータフォーマット myDataFormat を削除する場合は、以下のようになります。
						
[image: CnfigsVDFSelectDelete]


	
							Delete をクリックします。
						

							グローバル要素 myDataFormat は Configurations タブから消えます。
						

	
							Source タブに切り替えて、ツールがルーティングコンテキストから XML コードを削除したことを確認します。
						
[image: CnfigsDelDFSourceV]


	
							完了したら、メニューバーで File → Save を選択して変更を保存します。
						



グローバル要素の編集




					手順は、ルーティングコンテキストに追加したエンドポイント、データ形式、または Bean のプロパティーを変更する場合でも同じです。
				

					通常、グローバル要素の ID は変更しません。グローバル要素が実行中のルートですでに使用されている場合、ID を変更すると、グローバル要素への参照が壊れることがあります。
				
	
							Configurations タブで、編集するグローバル要素を選択します。
						

							たとえば、「グローバルエンドポイントの追加」で追加したエンドポイント myJMS を編集するには、以下のように選択します。
						
[image: CnfigsVEndptEditSelect]


	
							Edit をクリックします。
						
[image: CnfigsVEndptClickEdit]


							Properties ビューで、必要に応じて要素のプロパティーを変更します。
						

	
							たとえば、Advanced → Consumer タブを開き、Concurrent Consumers の値を 2 に変更します。
						
[image: CnfigsEditEndpntConcurConsume2]


	
							ルートエディターで、Source タブをクリックして、ツールがプロパティー concurrentConsumers=2 をルーティングコンテキストに追加したことを確認します。
						
[image: CnfigsVEndptEditSourceV]


	
							完了したら、メニューバーで File → Save を選択して変更を保存します。
						




ルートエディターの設定



概要




					Fuse 設定を使用して、ルートエディターの動作とユーザーインターフェイスのオプションを指定できます。
				
	
							エンタープライズ統合パターン (EIP) の式に使用するデフォルト言語
						
	
							ルートを作成するときにデザインキャンバス上でパターンが流れる方向 (右または下)
						
	
							デザインキャンバスがキャンバスの背景にグリッドオーバーレイを表示するかどうか
						
	
							デザインキャンバス上のノードにラベルを付ける方法
						



手順




					ルートエディターを設定するには、以下を実行します。
				
	
							Editor 設定ウィンドウを開きます。
						
	
									Linux および Windows マシンでは、Windows → Preferences → Fuse Tooling → Editor を選択します。
								
	
									OS X では、CodeReady Studio → Preferences → Fuse Tooling → Editor を選択します。
								

									[image: PreferencesEditor]

								




	
							エンタープライズ統合パターン (EIP) コンポーネントの式に使用するデフォルトの言語を選択するには、ドロップダウンリストから言語を選択します。デフォルトは Simple です。
						
	
							ルートエディターでルート内のパターンを整列させる方向を指定するには、Down または Right を選択します。デフォルトは Down です。
						
	
							キャンバスの背景でグリッドオーバーレイの表示を有効または無効にするには、Show diagram grid in Routes Editor の横のチェックボックスをオンにします。デフォルトは enabled です。
						
	
							ルートエディターの Design タブでコンポーネント ID をラベルとして使用することを有効または無効にするには、Use ID values for component labels の横のチェックボックスをオンにします。デフォルトは disabled です。
						

							このオプションをチェックし、コンポーネントに使用するラベルを指定すると (手順 6 を参照)、ID 値の代わりに指定したラベルがそのコンポーネントに使用されます。
						

	
							ルートエディターの Design タブで、コンポーネント (File ノードなどのエンドポイントを除く) のラベルとしてパラメーターを使用するには、次の手順に従います。
						
	
									Preferred labels セクションで、Add をクリックします。New Preferred Label ダイアログボックスが開きます。
								

									[image: NewPreferredLabel]

								

	
									Component を選択してから、コンポーネントのラベルとして使用する Parameter を選択します。
								
	
									OK をクリックします。コンポーネントとパラメーターのペアは、エディターの設定ウィンドウに一覧表示されます。
								

									[image: PreferredLabelsList]

								

									オプションで、コンポーネントラベルを 編集 および 削除 できます。
								
注記

										Use ID values for component labels オプションをオンにすると、Preferred labels セクションにリストされているコンポーネントを除くすべてのコンポーネントに適用されます。
									





	
							Apply and Close をクリックして変更を Editor 設定に適用し、Preferences ウィンドウを閉じます。
						


注記

						Editor 設定ダイアログボックスに戻って Restore Defaults をクリックすると、いつでもルートエディターの元のデフォルトに戻すことができます。
					




第3章 Rest DSL コンポーネントの表示と編集




				Apache Camel は、REST サービスを定義するために複数のアプローチをサポートします。特に、Apache Camel は REST DSL (Domain Specific Language) を提供します。これは、REST コンポーネントを抽象化でき、OpenAPI 2.0 specification とも統合できるシンプルながらも強力な API です。OpenAPI (以前の Swagger) は、ベンダーに依存しない、移植可能な API サービスのオープン記述形式です。
			

				Camel Rest DSL の使用に関する詳細は、Apache Camel 開発ガイド の「REST サービスの定義」の章を参照してください。
			

				Fuse Tooling を使用すると、Camel コンテキストファイルにある Rest DSL コンポーネントを表示および編集できます。
			

				https://access.redhat.com/articles/4296981 で説明されているように、REST API を OpenAPI クライアントに公開するように Fuse Integration プロジェクトを設定することもできます。
			
Rest DSL コンポーネントのグラフィック表現の表示




					Camel コンテキストファイルの REST DSL コンポーネントをグラフィカルモードで表示するには、以下を実行します。
				
	
							ルートエディターで Camel コンテキストファイルを開きます。
						
	
							REST タブをクリックして、Rest DSL コンポーネントを表示します。
						
[image: RESTtab]


							REST Configuration セクションには、次の設定オプションが表示されます。
						
	
									Component — REST トランスポートに使用する Camel コンポーネント。
								
	
									Context Path — REST サービスの主要なコンテキストパス。このオプションは、サーブレットのように、Web アプリケーションがコンテキストパスを使用してデプロイされるコンポーネントに使用できます。
								
	
									Port — REST サービスを公開するポート番号。
								
	
									Binding Mode — JSON または XML 形式のメッセージのバインディングモード。可能な値は、off (デフォルト)、auto、json、xml、または json_xml です。
								
	
									Host  —  REST サービスの公開に使用するホスト名。
								



	
							REST 要素をクリックして、REST Operations セクションで関連する操作 (例: GET、POST、PUT、および DELETE) を表示します。
						
	
							REST 要素または REST 操作をクリックして、Properties ビューにそのプロパティーを表示します。
						
[image: RESTproperties]





グラフィカルビューでの REST DSL コンポーネントの編集




					REST タブで、プロジェクトの Camel コンテキストファイルの REST 要素を 追加、編集、または削除できます。
				
	
							新しい REST 要素を追加するには、以下を実行します。
						
	
									REST elements セクションで、+ ボタンをクリックします。REST 要素が REST elements のリストに追加されます。
								
	
									Properties ビューで、REST 要素のプロパティーを編集します。
								
[image: RESTAddElement2]





	
							REST オペレーションを REST 要素に追加するには、以下を実行します。
						
	
									REST elements のリストで、REST 要素を選択します。
								
	
									REST operations セクションで、+ ボタンをクリックします。

								

									Add REST Operation ダイアログボックスが開きます。
								
[image: RESTAddOperation]


	
									ID、URI、および Operation Type を指定します。必要に応じて、Referenced Route ID を選択します。
								
	
									Finish をクリックします。新しいオペレーションは、選択した REST 要素の REST オペレーションリストに表示されます。
								



	
							REST 要素またはオペレーションを編集するには、REST タブでそれらを選択し、Properties タブでそのプロパティー値を編集します。
						
	
							選択した REST 要素またはオペレーションを削除するには、x ボタンをクリックします。
						



Rest DSL ソースコードの表示と編集




					Source タブで、Rest DSL コンポーネントを表示および編集することもできます。
				
	
							ルートエディターで Camel コンテキストファイルを開きます。
						
	
							ルートエディターの Source タブをクリックして、コードを編集します。
						
[image: RESTsourcetab]


	
							必要に応じて、REST タブをクリックして、グラフィカルビューで変更を確認します。
						
	
							変更を保存するには、File → Save を選択します。
						




第4章 SOAP アプリケーションを RESTful Web サービスに移行




				WSDL-to-Camel Rest ウィザードを使用して、既存の JAX-WS SOAP Web サービス実装から、既存の WSDL を使用する RESTful Web サービス実装に移行できます。このウィザードは Fuse Tooling の一部として利用でき、Github wsdl2rest project で利用可能な wsdl2rest ユーティリティーに基づいています。
			

				次の仕様/設定をサポートします。
			
	
						Document/literal (doc/lit)
					
	
						Document/literal Wrapped (doc/lit wrap)
					
	
						RPC/literal (rpclit)
					


ウィザードのワークフロー




					ウィザードは、有効な URL (file:// URL 形式) またはリモート URL (http もしくは https を使用) である WSDL パスおよび選択した Fuse プロジェクトを使用します。ウィザードでは、生成された Java コード、生成された Camel 設定ファイル、生成された Camel エンドポイントのターゲットアドレス、および Bean 実装クラスのパスを指定します。
				

					ウィザードは、プロジェクトに基づいて宛先 Java および Camel パスを生成します。生成された Java コードは src/main/java に、Camel ファイルは Spring や Blueprint の適切な場所 (例: src/main/resources/META-INF/spring) にあります。
				

					生成されたクラスを変更して、特定のポイントに設定できます。
				

前提条件




					作業を開始する前に、次の前提条件を満たしている必要があります。
				
	
							既存の Fuse Integration プロジェクト。File→ New→ Fuse Integration Project ウィザードを使用して、新しいプロジェクトを作成できる。
						
	
							URL を介して WSDL ファイルにアクセスできる。これは、ローカル (file:// url) またはリモート (http もしくは https) にすることができます。
						



サンプル SOAP アプリケーションを RESTful Web サービスに移行




					ウィザードを実行するには、次の手順に従います。
				
	
							CodeReady Studio の Project Explorer ビューで Fuse プロジェクトを選択します。
						
	
							Fuse プロジェクトを右クリックし、 New → Camel Rest DSL from WSDL を選択します。
						

							Select Incoming WSDL and Project for Generated Output ページが開きます。Destination Project フィールドには、プロジェクトエクスプローラーで選択した Fuse プロジェクトが自動的に事前入力されます。このプロジェクトは、ウィザードが生成するアーティファクトの宛先です。
						
[image: wsdl to rest p1]


	
							WSDL File には、処理する元の SOAP サービスを指定します。
						
	
							Next をクリックします。Specify Advanced Options for WSDL-to-REST Processing ページが表示されます。
						
[image: wsdl to rest p2]

	
									Destination Java Folder には、CXF で生成された Java クラスの場所を指定します。
								
	
									Destination Camel Folder には、生成された Camel Rest DSL 設定ファイルの場所を指定します。
								
注記

										生成された Camel ファイルのパスと名前は、Camel プロジェクトのタイプによって異なります。
									
	
												Spring プロジェクトの場合:src/main/resources/META-INF/rest-camel-context.xml
											
	
												Spring Boot プロジェクトの場合:src/main/resources/spring/rest-springboot-context.xml
											
	
												Blueprint プロジェクトの場合:src/main/resources/OSGI-INF/rest-blueprint-context.xml
											




	
									オプションで、Target Service Address に、WSDL バインディングで指定された SOAP アドレスを指定します。このオプションを変更して、WSDL によって参照される SOAP サービスの実際のアドレスと一致させることができます。
								
	
									オプションで、Target REST Service Address に、REST サービスにアクセスするための URL を指定します。この URL は Rest DSL の <restConfiguration> および <rest> タグに分解され、SOAP サービスにマッピングされた REST オペレーションの完全な URL を指定します。
								



	
							Finish をクリックして、出力として 2 つのファイルを作成します。
						
	
									Rest DSL を使用する Camel 設定。
								
	
									SOAP サービスをラップする CXF の Java クラス。
								







第5章 新しい Apache Camel JUnit テストケースの作成



概要




				ルートをテストする一般的な方法は、JUnit を使用することです。デザインタイムツールには、ルートの JUnit テストケースの作成を簡素化するウィザードが含まれています。ウィザードは、指定したエンドポイントを使用して、テストの開始点コードと設定を生成します。
			
注記

					boilerplate JUnit テストケースを作成したら、それを変更して、作成または変更したルートに固有の期待値とアサーションを追加する必要があります。これにより、テストはルートに対して有効になります。
				


前提条件




				新しい JUnit テストケースを作成する前に、予備的なタスクを実行する必要があります。
			
	
						既存の JUnit テストケースを置き換える場合は、新しいテストケースを作成する前にそれを削除する必要があります。「既存の JUnit テストケースの削除」を参照してください。
					
	
						テストケースのないプロジェクトに新しい JUnit テストケースを作成する場合には、まずビルドパスに含まれるテストケースの project_root/src/test/java フォルダーを作成する必要があります。「src/test/java フォルダーの作成およびビルドパスへの追加」を参照してください。
					



既存の JUnit テストケースの削除



	
						Project Explorer ビューでプロジェクトのルートノードを展開し、<root_project>/src/test/java フォルダーを表示します。
					
	
						/src/test/java フォルダーで JUnit テストケースファイルを見つけます。
					

						プロジェクトがベースとする DSL に応じて、JUnit テストケースファイルには BlueprintXmlTest.java または CamelContextXmlTest.java という名前が付けられます。
					

	
						JUnit テストケースの .java ファイルを右クリックしてコンテキストメニューを開き、Delete を選択します。
					

						JUnit テストケースの .java ファイルは、Project Explorer ビューから消えます。
					

						これで 新しい JUnit テストケースの作成 が可能になります。
					




src/test/java フォルダーの作成およびビルドパスへの追加



	
						Project Explorer ビューで、プロジェクトのルートを右クリックしてコンテキストメニューを開きます。
					
	
						New → Folder を選択して Create a new folder resource ウィザードを開きます。
					
	
						ウィザードのプロジェクトツリーペインで、プロジェクトのルートノードを展開し、src フォルダーを選択します。
					

						<project_root>/src が Enter or select the parent folder フィールドに表示されるのを確認してください。
					

	
						Folder name に /test/java を入力します。このフォルダーには、作成した新しい JUnit テストケースが格納されます。
					
	
						Finish をクリックします。
					

						Project Explorer ビューでは、新しい src/test/java フォルダーが src/main/resources フォルダーの下に表示されます。このフォルダーがクラスパス上にあることを確認するには、コンテキストメニューを開き、Build Path を選択します。Remove from Build Path がメニューオプションである場合は、src/test/java フォルダーがクラスパスにあります。
					

						これで 新しい JUnit テストケースの作成 が可能になります。
					




JUnit テストケースの作成




				ルートの新しい JUnit テストケースを作成するには、以下を実行します。
			
	
						Project Explorer ビューで、プロジェクトのルーティングコンテキスト .xml ファイルを選択します。
					
	
						右クリックしてコンテキストメニューを開き、New → Camel Test Case を選択して、図5.1「新しい Camel JUnit テストケースウィザード」 で示すとおり New Camel JUnit Test Case ウィザードを開きます。
					
図5.1 新しい Camel JUnit テストケースウィザード
[image: New Camel JUnit Test Case ウィザードのエントリーページ]



						または、メニューバーから File → New → Other > Fuse > Camel Test Case を選択して、ウィザードを開くこともできます。
					

	
						Source folder で、テストケースのソースコードのデフォルトの場所を受け入れるか、別の場所を入力します。
					

						[image: Browse button]
						 をクリックして場所を検索できます。
					

	
						Package で、生成されたテストコードのデフォルトのパッケージ名を受け入れるか、別のパッケージ名を入力します。
					

						[image: Browse button]
						 をクリックしてパッケージを検索できます。
					

	
						Camel XML file under test で、テストするルートを含むルーティングコンテキストファイルのデフォルトのパス名を受け入れるか、別のパス名を入力します。
					

						[image: Browse button]
						 をクリックしてコンテキストファイルを検索できます。
					

	
						Name に、生成されたテストクラスのデフォルトの名前を受け入れるか、別の名前を入力します。
					
	
						生成されたコードに含めるメソッドスタブを選択します。
					
	
						生成されたコードにデフォルトの生成されたコメントを含める場合は、Generate comments ボックスをオンにします。
					
	
						[image: Next button]
						 をクリックし、Test Endpoints ページを開きます。例えば、図5.2「新しい Camel JUnit のテストケースページ」は、選択されたルートの入力ファイルと出力ファイルのエンドポイントを示しています。
					
図5.2 新しい Camel JUnit のテストケースページ
[image: テストエンドポイントページの例]



	
						Available endpoints で、テストするエンドポイントを選択します。選択したエンドポイントの横にあるチェックボックスをクリックして、選択を解除します。
					
	
						[image: Finish button]
						 をクリックします。
					
注記

							プロンプトが表示されたら、ビルドパスに JUnit を追加します。
						





				テストのアーティファクトはプロジェクトに追加され、Project Explorer ビューで src/test/java の下に表示されます。テストケースを実装するクラスが Java エディターで開きます。
			


第6章 Red Hat FuseTooling 内でのルートの実行




				ツールを使用してルートを実行するには、次の 2 つの方法があります。
			
	
						「ローカル Camel コンテキストとしてルートを実行」
					
	
						「Maven を使用したルートの実行」
					


ローカル Camel コンテキストとしてルートを実行



概要




					Apache Camel ルートを実行する最も簡単な方法は、Local Camel Context として実行する方法です。この方法では、Project Explorer ビューのコンテキストメニューから直接ルートを起動できます。コンテキストメニューからルートを実行すると、ツールによってランタイムプロファイルが自動的に作成されます。ルートを実行するためのカスタムランタイムプロファイルを作成することもできます。
				

					ルートは、コマンドラインから直接呼び出されたかのように実行され、Apache Camel の埋め込み Spring コンテナーを使用します。ランタイムプロファイルを編集して、いくつかのランタイムパラメーターを設定できます。
				

手順




					ローカル Camel コンテキストとしてルートを実行するには、以下の手順に従います。
				
	
							Project Explorer ビューで、ルーティングコンテキストファイルを選択します。
						
	
							それを右クリックしてコンテキストメニューを開き、Run As → Local Camel Context を選択します。
						
注記

								Local Camel Context (without tests) を選択すると、ツールは検証テストを実行せずにプロジェクトを実行するように指示されます。こちらの方が速い場合があります。
							





結果




					Console ビューには、ルートの実行から生成された出力が表示されます。
				

関連トピック



	
							「ローカル Camel コンテキストランタイムプロファイルの編集」
						




Maven を使用したルートの実行



概要




					ルートを含むプロジェクトが Maven プロジェクトの場合、m2e プラグインを使用してルートを実行できます。このオプションを使用すると、ルートが実行される前に Maven の目標を実行できます。
				

手順




					Maven を使用してルートを実行するには、以下を行います。
				
	
							Project Explorer ビューで、プロジェクトのルートを選択します。
						
	
							それを右クリックしてコンテキストメニューを開き、Run As → Maven build を選択します。
						
	
									Maven を使用してプロジェクトを初めて実行すると、Edit Configuration and launch エディターが開き、Maven ランタイムプロファイルを作成できます。
								

									ランタイムプロファイルを作成するには、Maven タブで次の手順を実行します。
								
	
											Apache Camel プロジェクトのルートディレクトリーが Base directory: フィールドに表示されていることを確認します。
										

											たとえば、Linux では、プロジェクトのルートは ~/workspace/simple-router のようになります。
										

	
											Goals: フィールドに camel:run を入力します。
										
重要

												Java DSL を使用してプロジェクトを作成した場合は、Goals: フィールドに exec:java を入力します。
											


	
											Apply、Run の順にクリックします。
										



	
									実行の間で変更しない限り、後続の Maven 実行ではこのプロファイルが使用されます。
								






結果




					Console ビューには、Maven 実行からの出力が表示されます。
				

関連トピック



	
							「Maven ランタイムプロファイルの編集」
						




ランタイムプロファイルの操作




					Red Hat Fuse Tooling は、各プロジェクトのランタイム環境に関する情報を ランタイムプロファイル に保存します。ランタイムプロファイルは、呼び出す Maven の目標、使用する Java ランタイム環境、設定する必要のあるシステム変数などの情報を追跡します。プロジェクトには、複数のランタイムプロファイルを含めることができます。
				
ローカル Camel コンテキストランタイムプロファイルの編集



概要




						Local Camel Context ランタイムプロファイルは、ルートを実行するために Apache Camel を呼び出す方法を設定します。Local Camel Context ランタイムプロファイルは、ルートが定義されているコンテキストファイルの名前、呼び出す main の名前、JVM に渡すコマンドラインオプション、使用する JRE、使用するクラスパス、設定する必要のある環境変数、その他の情報などを保存します。
					

						Local Camel Context ランタイムプロファイルのランタイム設定エディターには、次のタブが含まれています。
					
	
								Camel Context File — 新しい設定の名前とルートを含むルーティングコンテキストファイルのフルパスを指定します。
							
	
								JMX — JMX URI と、それにアクセスするために使用するユーザー名とパスワード (オプション) を含む、JMX 接続の詳細を指定します。
							
	
								Main — プロジェクトのベースディレクトリーの完全修飾名、ベースディレクトリーを見つけるためのいくつかのオプション、ルートを実行する前に実行する必要のある目標、使用する Maven ランタイムのバージョンを指定します。
							
	
								JRE — JVM の起動時に使用する JRE およびコマンドライン引数を指定します。
							
	
								Refresh — 実行が終了した後に Maven がプロジェクトのリソースファイルを更新する方法を指定します。
							
	
								Environment — 設定する必要のある環境変数を指定します。
							
	
								Common — プロファイルの保存方法と出力の表示方法を指定します。
							



						Apache Camel ルートが Local Camel Context として初めて実行されるとき、Red Hat Fuse Tooling はルーティングコンテキストファイル用に、編集を必要としないデフォルトのランタイムプロファイルを作成します。
					

Local Camel Context のランタイム設定エディターへのアクセス



	
								Project Explorer ビューで、カスタムランタイムプロファイルを編集または作成する Camel コンテキストファイルを選択します。
							
	
								それを右クリックしてコンテキストメニューを開き、Run As → Run Configurations を選択して Run Configurations ダイアログボックスを開きます。
							
	
								コンテキスト選択 ペインで、Local Camel Context を選択してから、コンテキスト選択 ペインの左上にある 
								[image: New profile icon]
								 をクリックします。
							
	
								Name フィールドに、ランタイムプロファイルの新しい名前を入力します。
							


図6.1 Loca Camel Context のランタイム設定エディター
[image: ローカルの camel コンテキストランタイム設定エディター]



camel コンテキストファイルの設定




						Camel Context File タブには 1 つのフィールド Select Camel Context file… があります。ルート定義を含むルーティングコンテキストファイルへのフルパスを入力します。
					

						Browse ボタンは、Open Resource ダイアログボックスにアクセスします。これにより、ターゲットルーティングコンテキストファイルを簡単に見つけることができます。このダイアログボックスは、Apache Camel ルートを含むファイルを検索するように事前設定されています。
					

コマンドラインオプションの変更




						デフォルトでは、JVM には以下のコマンドラインオプションのみ渡されます。
					
-fa context-file

						カスタムメインクラスを使用している場合は、別のオプションを渡す必要がある場合があります。そうするには、Main タブで Add ボタンをクリックして、パラメーターの名前と値を入力します。Add Parameter ダイアログボックスの Variables…​ ​ ボタンをクリックして、選択可能な変数のリストを表示できます。
					

						JVM 固有の引数を追加または変更するには、JRE タブの VM arguments フィールドを編集します。
					

出力の送信先の変更




						デフォルトでは、ルートの実行から生成された出力は Console ビューに送信されます。ただし、これをファイルにリダイレクトすることもできます。
					

						出力をファイルにリダイレクトするには、以下を実行します。
					
	
								Common タブを選択します。
							
	
								Standard Input and Output ペインで、Output File: フィールドの横にあるチェックボックスをクリックし、出力送信先のファイルへのパスを入力します。
							

								Workspace ボタン、File System ボタン、および Variables ボタンを使用すると、出力ファイルへのパスを簡単に構築できます。
							




関連トピック



	
								「ローカル Camel コンテキストとしてルートを実行」
							




Maven ランタイムプロファイルの編集



概要




						Maven ランタイムプロファイルは、Maven が Apache Camel を呼び出す方法を設定します。Maven ランタイムプロファイルには、実行する Maven 目標、使用する Maven プロファイル、使用する Maven のバージョン、使用する JRE、使用するクラスパス、設定する必要のある環境変数、およびその他のいくつかの情報が格納されています。
					
重要

							Maven を使用して Apache Camel ルートを初めて実行するときは、そのデフォルトランタイムプロファイルを作成する必要があります。
						


						Fuse ランタイムプロファイルのランタイム設定エディターには、次のタブが含まれています。
					
	
								Main — 新しい設定の名前、プロジェクトのベースディレクトリーの完全修飾名、ベースディレクトリーを見つけるためのいくつかのオプション、ルートを実行する前に実行する必要のある目標、使用する Maven ランタイムのバージョンを指定します。
							
	
								JRE — JVM の起動時に使用する JRE およびコマンドライン引数を指定します。
							
	
								Refresh — 実行が終了した後に Maven がプロジェクトのリソースファイルを更新する方法を指定します。
							
	
								Source — プロジェクトに必要な追加のソースの場所を指定します。
							
	
								Environment — 設定する必要のある環境変数を指定します。
							
	
								Common — プロファイルの保存方法と出力の表示方法を指定します。
							



Maven ランタイム設定エディターへのアクセス



	
								Project Explorer ビューで、カスタムランタイムプロファイルを編集または作成するプロジェクトのルートを選択します。
							
	
								それを右クリックしてコンテキストメニューを開き、Run As → Run Configurations を選択して Run Configurations ダイアログボックスを開きます。
							
	
								コンテキスト選択 ペインで、Maven Build を選択してから、コンテキスト選択 ペインの左上にある 
								[image: New profile icon]
								 をクリックします。
							


図6.2 Maven のランタイム設定エディター
[image: Maven ランタイム設定エディター]



Maven ゴールの変更




						ルートを実行するときに最も一般的に使用されるゴールは、camel:run です。これは、独自の JVM で実行されている Spring コンテナーにルートをロードします。
					

						Apache Camel プラグインは、Maven が使用するのと同じ JVM に Spring コンテナーをロードする camel:embedded ゴールもサポートしています。これの利点は、ルートのブートストラップが速くなることです。
					

						Java DSL に基づくプロジェクトは、exec:java ゴールを使用します。
					

						POM に他のゴールが含まれる場合、Main タブの Maven Runtime フィールドの横にある Configure… ボタンをクリックして、使用する Maven ゴールを変更できます。Installations ダイアログボックスで、Global settings for <selected_runtime> installation フィールドを編集します。
					

Maven バージョンの変更




						デフォルトでは、Red Hat Fuse Tooling for Eclipse は Eclipse に組み込まれている m2e を使用します。別の Maven バージョンを使用する場合、または開発マシンに新しいバージョンをインストールする場合は、Main タブの Maven Runtime ドロップダウンメニューから選択できます。
					

出力送信先の変更




						デフォルトでは、ルート実行からの出力は Console ビューに送信されます。ただし、これをファイルにリダイレクトすることもできます。
					

						出力をファイルにリダイレクトするには、以下を実行します。
					
	
								Common タブを選択します。
							
	
								Output File: フィールドの横にあるチェックボックスをクリックして、出力を送信するファイルへのパスを入力します。
							

								Workspace ボタン、File System ボタン、および Variables ボタンを使用すると、出力ファイルへのパスを簡単に構築できます。
							




関連トピック



	
								「Maven を使用したルートの実行」
							






第7章 Fuse on OpenShift の使用




				Fuse on OpenShift (Fuse Integration Services 7.0 以降の名称) は、Fuse アプリケーションを OpenShift Container Platform にデプロイすることができます。
			
重要

					Fuse Integration プロジェクト (Fuse on OpenShift プロジェクト) の場合、Fuse Tooling では Red Hat Container Development Kit (CDK) v3.x をインストールする必要があります。手順については、Getting Started Guide を参照してください。このガイドで指定されている前提条件に加えて、Red Hat アカウントを持っていない場合は、それを確立する必要があります。Red Hat Container Development Kit で提供される仮想 OpenShift インスタンスを開始するには、Red Hat ユーザー名とパスワードが必要です。
				

					Red Hat Customer Portal に登録することで、簡単にアカウントを取得できます。ホワイトバナーの右上隅にある 
					[image: Account]
					 をクリックし、ご自身の Red Hat アカウントにログイン ページの 
					[image: RH acctRegBut]
					 をクリックします。
				


				Fuse Tooling を使用すると、s2i バイナリーワークフローを使用して Fuse Integration プロジェクトを開発および展開できます。このワークフローでは、ツールがプロジェクトをローカルでビルドし、それをイメージストリームにアセンブルしてから、そのイメージストリームを OpenShift にプッシュし、そこで Docker コンテナーのビルドに使用します。Docker コンテナーがビルドされると、OpenShift はそれを Pod にデプロイします。
			
重要

					Fuse Tooling は、S2I バイナリーワークフローでのみ機能し、SpringBoot フレームワークに基づくプロジェクトでのみ機能します。
				

注記

					Fuse Tooling はツールを使用して作成された Fuse Integration プロジェクトをリモート OpenShift サーバーにデプロイできますが、この章では、Red Hat Container Development Kit (CDK) v3.x を使用してローカルにインストールされた仮想 OpenShift インスタンスに Fuse Integration プロジェクトを作成およびデプロイする方法について説明します。
				


				次のセクションでは、最初の Fuse Integration プロジェクトを作成してデプロイする方法について説明します。
			
	
						「Red Hat Container Development Kit サーバーの追加」
					
	
						「Container Development Environment (CDE) および仮想 OpenShift サーバーの起動」
					
	
						「新しい OpenShift プロジェクトの作成」
					
	
						「新規 Fuse Integration プロジェクトの作成」
					
	
						「Fuse Integration プロジェクトの OpenShift へのデプロイ」
					


注記

					Fuse Integration プロジェクトをローカル Camel コンテキストとして実行し、「ローカル Camel コンテキストとしてルートを実行」 を参照してから、JMX Navigator ビューに接続できます。このビューでは、ルーティングコンテキストを関しおよびテストできます。Fuse Integration プロジェクトで Camel デバッガーを実行し (パートII「ルーティングコンテキストのデバッグ」)、ルーティングコンテキストの論理エラーを公開して修正することもできます。
				

Red Hat Container Development Kit サーバーの追加




					Red Hat Container Development Kit を Servers ビューに追加するには、以下を実行します。
				
	
							必要に応じて、Window → Perspective → Open Perspective → Fuse Integration の順に選択して Fuse Integration パースペクティブに切り替えます。
						
注記

								この手順で説明されているビューが開かない場合は、Window → Show View → Other を選択し、開くビューの名前を選択します。
							


	
							Servers ビューで No servers are available. Click this link to create a new server… のリンクをクリックし、Define a New Server ウィザードを開きます。このリンクは、Servers ビューにサーバーエントリーが含まれない場合にのみ表示されます。
						

							それ以外の場合は、Servers ビューを右クリックしてコンテキストメニューを開き、New → Server を選択して Define a New Server ウィザードを開きます。
						
[image: DefNewSrvCDK]


	
							Red Hat JBoss Middleware → Red Hat Container Development Kit 3.2+ を選択します。
						

							次のデフォルト値を受け入れます。
						
	
									Server's hostname: localhost
								
	
									Server name: Container Development Environment
								



	
							Next をクリックして Red Hat Container Development Environment ページを開きます。
						
	
							MiniShift Binary の横にある Browse をクリックして、Red Hat Container Development Kit 3.x をインストールした場所に移動し、Open をクリックします。
						
	
							Username の横にある Add をクリックし、Add a Credential ページを開きます。
						
	
							クレデンシャルを次のように設定します。
						
	
									Username  —  Red Hat アカウントへのログインに使用する名前を入力します。
								
	
									Always prompt for password  — そのままにします (無効)。
								
	
									Password  —  Red Hat アカウントへのログインに使用するパスワードを入力します。
								



	
							OK をクリックして、Red Hat Container Development Environment ページに戻ります。このページにデータが入力されています。以下に例を示します。
						
[image: CDEdefUserFolder3]


	
							Finish をクリックします。Container Development Environment 3.2+ [Stopped, Synchronized] が Servers ビューに表示されます。Container Development Environment 3.2+ は、CDK 3.x サーバーを追加する場合のデフォルトサーバー名です。
						



Container Development Environment (CDE) および仮想 OpenShift サーバーの起動




					Container Development Environment (CDE) を起動すると、仮想 OpenShift サーバーも起動します。CDE を停止すると、仮想 OpenShift サーバーも停止します。
				
	
							Servers ビューで Container Development Environment 3 [stopped, Synchronized] を選択し、Servers メニューバーの 
							[image: run exec]
							 をクリックします。
						

							Console ビューが開き、起動プロセスのステータスが表示されます。
						
[image: CDEstartTerminal]

注記

								CDE は、最初の起動時に、信頼できない SSL 証明書を受け入れるかどうかを尋ねます。Yes をクリックします。
							


							起動プロセスが終了すると、Servers ビューに次のように表示されます。
						
[image: CDEsrvStartedSyncd]


	
							OpenShift Explorer ビューに切り替えます。
						

							仮想 OpenShift サーバーインスタンス developer も実行されています。
						
[image: OSEopenshift devAutostart]


							https://192.168.99.100:8443 は、OpenShift 開発者 Web コンソールの URL の例です。インストールにより、インスタンスの URL が表示されます。詳細については 「OpenShift Web コンソールへのアクセス」 を参照してください。
						




新しい OpenShift プロジェクトの作成




					Fuse Integration プロジェクトを OpenShift にデプロイすると、ここで作成した OpenShift プロジェクトに公開されます。
				
	
							OpenShift Explorer ビューで、developer エントリーを右クリックして、コンテキストメニューを開きます。
						
	
							New → Project を選択して、New OpenShift Project ウィザードを開きます。
						
	
							新規プロジェクトのプロパティーを以下のように設定します。
						
	
									Project Name フィールドに、仮想 OpenShift サーバーにおけるプロジェクトの namespace の名前を入力します。
								

									小文字、数字、ダッシュのみ有効です。
								

	
									Display Name フィールドに、仮想 OpenShift Web コンソールの Overview ページに表示する名前を入力します。
								
	
									Description フィールドはそのままにしておきます。
								

									以下に例を示します。
								
[image: 新規プロジェクト]





	
							Finish をクリックします。
						

							新しい OpenShift プロジェクト (この例では New FIS Test newtest) は、OpenShift Explorer タブの、この例では developer https://192.168.99.100:8443 の下に表示されます。
						
[image: OSEnewFISprojCreated]

注記

								MyProject myproject は、OpenShift に含まれている初期サンプルプロジェクトです。
							


							OpenShift Explorer ビューで New FIS Test newtest を選択すると、Properties ビューにプロジェクトの詳細が表示されます。以下に例を示します。
						
[image: OSEnewFISprojProps]

注記

								プロジェクトを OpenShift にデプロイすると、Properties ビューは OpenShift Web コンソールが行うのと同じプロジェクトに関する情報を収集して表示します。
							





新規 Fuse Integration プロジェクトの作成




					新規 Fuse Integration プロジェクトを作成する前に、ステージングリポジトリーを有効にする必要があります。一部の Maven アーティファクトはデフォルトの Maven リポジトリーにないため、この設定が必要です。ステージングリポジトリーを有効にするには、Window → Preferences → Fuse Tooling → Staging Repositories の順に選択します。
				

					Fuse Integration プロジェクトを作成するには、Spring Boot on OpenShift テンプレートを使用します。
				
	
							Project Explorer ビューで右クリックしてコンテキストメニューを開き、New → Fuse Integration Project を選択してウィザードの Choose a project name ページを開きます。
						
[image: 新しい Fuse Integration プロジェクト]


	
							Project Name フィールドに、使用しているワークスペースに固有の名前を入力します (例: myFISproject)。
						

							他のオプションでデフォルト値を使用します。
						

	
							Next をクリックして、Select a Target Runtime ページを開きます。
						
[image: 新規プロジェクトの Camel バージョン]


							Target Runtime (No Runtime selected) および Camel Version はデフォルト値をそのまま使用します。
						

	
							Next をクリックして Advanced Project Setup ページを開きます。
						
[image: 高度なプロジェクト設定]


	
							Simple log using Spring Boot - Spring DSL テンプレートを選択します。
						
[image: 高度なプロジェクトテンプレート]


	
							Finish をクリックします。
						
注記

								初めての Fuse Integration プロジェクトでダウンロードされる依存関係の数が多いため、プロジェクトのビルドには時間がかかる場合があります。
							

								Fuse Integration パースペクティブがまだ開いていない場合、Developer Studio により、ここで開くかどうかを示すようにプロンプトが表示されます。Yes をクリックします。
							





					ビルドが完了すると、Fuse Integration パースペクティブにプロジェクトが表示されます。以下はその例です。
				
[image: FIS ProjCreatedFIP]


					この時点で、以下を実行できます。
				
	
							OpenShift へのプロジェクトのデプロイ
						
	
							「ローカル Camel コンテキストとしてルートを実行」ルーティングコンテキストがローカルマシンで正常に実行されていることの確認
						

							JMX Navigator ビューで実行中のコンテキスト (「ローカル JMX サーバーでのプロセスの表示」 を参照) に接続すると、ルートコンポーネントを監視し、ルートが想定どおりに実行されるかどうかをテストできます。
						
	
									ルートコンポーネントの JMX 統計の表示 (21章コンポーネントの JMX 統計情報の表示 を参照)
								
	
									実行中のルートの表示 (25章ルーティングエンドポイントの管理)
								
	
									実行中のルートの一時停止/再開 (27章ルーティングコンテキストの管理)
								
	
									実行中のルートでのトレースの開始/停止 (23章ルートのトレース)
								



	
							ロジックエラーの検出と修正を目的とした、プロジェクトの camel-context.xml ファイルでの Camel デバッガーの実行 (パートII「ルーティングコンテキストのデバッグ」 を参照)
						



Fuse Integration プロジェクトの OpenShift へのデプロイ



	
							Project Explorer ビューで、プロジェクトのルート (この例では myFISproject) を右クリックして、コンテキストメニューを開きます。
						
	
							Run As → Run Configurations の順に選択し、Run Configurations ウィザードを開きます。
						
	
							サイドバーメニューで、Maven Build → Deploy <projectname> on OpenShift (この例では Deploy myFISproject on OpenShift) を選択し、プロジェクトのデフォルトラン設定を開きます。
						
[image: FIS RunCnfgMain]


							Main タブのデフォルト設定をそのまま使用します。
						

	
							JRE タブを開いて、VM 引数にアクセスします。
						
[image: FIS RunCfgJRE]


	
							VM arguments ペインで、-Dkubernetes.namespace=test 引数の値を変更して、OpenShift プロジェクトの作成時に使用したプロジェクト名 (「新しい OpenShift プロジェクトの作成」の OpenShift のプロジェクト名) に一致させます。
						

							この例では、デフォルト値の test を newtest に変更します。
						
[image: FIS RunCfgVMargsChg]


							OpenShift の設定によっては、それをサポートするために他の VM 引数を変更する必要がある場合があります。
						
	
									-Dkubernetes.master=https://192.168.99.1:8443
								

									複数の OpenShift インスタンスを実行する場合、またはリモートインスタンスを使用する場合は、デプロイメントの対象となる OpenShift インスタンスの URL を指定する必要があります。上記の URL はその例です。
								

	
									-Dkubernetes.trust.certificates=true
								
	
											CDK を使用する場合、この引数は必須です。true に設定したままにしてください。
										
	
											有効な SSL 証明書を持つ OpenShift インスタンスを使用している場合は、この引数の値を false に変更します。
										






	
							Apply をクリックしてから、Run をクリックします。
						

							ダウンロードする依存関係の数が多いため、初回の展開には時間がかかる場合があります。コンピューターの速度とインターネット接続が要因になっています。通常、初回の展開が完了するまでに 25〜35 分かかります。
						

							Console ビューでは、デプロイプロセスの進行状況を追跡できます。以下の出力のエントリー Pushing image 172.30.1 … * は、プロジェクトが正常にビルドされ、アプリケーションイメージが OpenShift にプッシュされて Docker コンテナーのビルドに使用されることを示します。
						
[image: FIS ConLogSuccess1]


							デプロイメントが正常に完了すると、Console ビューに BUILD SUCCESS が表示されます。
						
[image: FIS ConLogSuccess2]


	
							OpenShift Explorer ビューに切り替えて、New FIS Test newtest を選択します。
						
[image: OSE NewFISTestDeploy1]


							Properties ビューの Details ページには、プロジェクトのプロパティー値がすべて表示されます。
						
[image: OSEnewFISprojProps]


							他のタブ (Builds、Build Configs、Deployments …​) を開き、プロジェクトの他のプロパティーを表示します。Properties ビューには、OpenShift Web コンソールと同じ情報が表示されます。
						

	
							OpenShift Explorer ビューで camel-ose-springboot-xml を選択し、Properties ビューでその詳細を表示します。
						
[image: NFT camxmlPropsDetails]


							他のタブをスクロールして、デプロイメント設定の他のプロパティーを表示します。
						

	
							OpenShift Explorer ビューで camel-ose-springboot-xml-1-mdmtd Pod Running を選択し、Properties ビューで実行中のインスタンスの詳細を表示します。
						
[image: NFT ImageStreamPropsDetails]


	
							OpenShift Explorer ビューで camel-ose-springboot-xml-1-mdmtd Pod Running を右クリックし、続いてPod Logs…​ を選択します。
						
注記

								プロンプトが表示されたら、インストールされた oc 実行可能ファイルへのパスを入力します。Pod ログを取得する必要があります。
							


							Console ビューが自動的に開き、実行中の Pod からのログが表示されます。
						
[image: OSE podLogsDisplayed]


							Console ビューのメニューバーの 
							[image: Close]
							 をクリックしてセッションを終了し、コンソールの出力をクリアします。
						




OpenShift Web コンソールへのアクセス



注記

						この情報は、Red Hat Container Development Kit のインストールにのみ適用されます。
					


					OpenShift Web コンソールにアクセスするには、ブラウザーを開き、インスタンスとマシンに固有の OpenShift サーバーの URL を入力します。たとえば、ブラウザーのアドレスフィールドに https://192.168.99.100:8443 を入力します。
				

					デフォルトのクレデンシャルを使用して、開発者または管理者として Web コンソールにログインできます。
				
	
							デフォルトの開発者ロール
						

							開発者ユーザーは、自分のプロジェクトと、OpenShift v3 の機能を示す提供された OpenShift サンプルプロジェクトのみを表示できます。開発者ユーザーは、OpenShift にデプロイされている、自分が所有する任意のプロジェクトを作成、編集、および削除できます。
						
	
									Username: developer
								
	
									Password: developer
								



	
							デフォルトの管理者ロール
						

							管理者ユーザーは、OpenShift (CDK) 上のすべてのプロジェクトを表示およびアクセスできます。管理者ユーザーは、OpenShift にデプロイされた任意のプロジェクトを作成、編集、および削除できます。
						
	
									Username: admin
								
	
									Password: admin
								






					OpenShift Web コンソールの使用ついて、詳しくは スタートガイド を参照してください。
				


第8章 Red Hat Fuse SAP Tool Suite の使用




				Red Hat Fuse SAP Tool Suite を使用すると、Camel ルートをリモートの SAP アプリケーション・サーバーと統合できます。リモート機能呼び出し (RFC) および中間文書 (IDoc) の送受信をサポートするために、さまざまな SAP コンポーネントが提供されています。SAP Tool Suite は、SAP の JCo および IDoc クライアントライブラリーに依存しています。これらのライブラリーをインストールして使用するには、SAP Service Marketplace アカウントが必要です。
			
Red Hat Fuse SAP Tool Suite のインストール



概要




					Red Hat Fuse SAP Tool Suite には、Edit SAP Connection Configuration ダイアログボックスがあり、SAP アプリケーションサーバーと宛先接続を作成および管理するのに役立ちます。このスイートは、SAP によって個別にライセンスされているサードパーティーの JCo および IDoc クライアントライブラリーを必要とするため、デフォルトではインストールされていません。
				

SAP ツールのプラットフォーム制限




					SAP ツールスイートはサードパーティーの JCo および IDoc ライブラリーに依存しているため、これらのライブラリーがサポートするプラットフォームにのみインストールできます。SAP ツールのプラットフォーム制限の詳細については、Red Hat Fuse Supported Configurations を参照してください。
				

前提条件



	
							Fuse SAP Tool Suite をインストールする前に、JCo および IDoc ライブラリーを http://service.sap.com/connectors からダウンロードする必要があります。
						
	
							オペレーティングシステムに適切な JCo および IDoc ライブラリーを決定するには、Red Hat Fuse Supported Configurations ページを参照してください。
						
	
							JCo および IDoc ライブラリーをダウンロードするには、SAP Service Marketplace アカウントが必要です。
						
	
							このインストール手順では、ダウンロードしたファイルをアーカイブ形式のままにしておくことができます。内容を抽出する必要はありません。
						



手順




					Fuse SAP Tool Suite を Red Hat CodeReady Studio にインストールするには、次の手順を実行します。
				
	
							Red Hat CodeReady Studio で、File → Import を選択して、Import ウィザードを開きます。
						
	
							Import ウィザードの Select 画面で Fuse → Install Fuse SAP Tool Suite を選択し、Next をクリックします。
						
	
							Install the Red Hat Fuse SAP Tool Suite 画面が開き、SAP Service Marketplace から JCo ライブラリーおよび IDoc ライブラリーをダウンロードする手順が表示されます。Next をクリックします。
						
	
							Select JCo および IDoc Archive to Import 画面が開きます。JCo Archive File フィールドの横にある Browse ボタンを使用して、SAP Service Marketplace からダウンロードした JCo アーカイブを選択します。JCo アーカイブを選択すると、Archive Version と Archive OS Platform フィールドが自動的に入力されるため、インストールしているライブラリーに正しいバージョンと OS プラットフォームがあるかどうかを確認できます。
						

							IDoc Archive File フィールドの横にある Browse ボタンを使用して、SAP Service Marketplace からダウンロードした IDoc アーカイブを選択します。
						

							両方のアーカイブファイルを選択したら、Finish をクリックします。
						

	
							新しい Install ウィザードが (Eclipse プラグインをインストールするために) 自動的に開きます。このウィザードは、次の情報をインストールするプラグインに表示します。
						
	
									Fuse SAP Tool Suite
								
	
									SAP JCo および IDoc ライブラリー
								

									これらのプラグインの両方が選択されていることを確認してください。Next をクリックします。
								
注記

										SAP JCo and IDoc Libraries プラグインは、選択した JCo および IDoc ライブラリーから動的に構築されます。
									





	
							Install Details 画面では、インストールされるプラグインを確認できます。Next をクリックします。
						
	
							Review Licenses ダイアログボックスが開きます。I accept ラジオボタンオプションを選択し、Finish をクリックします。
						
	
							Security Warning ダイアログボックス (署名なしコンテンツの警告) が表示された場合は、OK をクリックして警告を無視し、インストールを続行します。
						
	
							Restart Eclipse ダイアログボックスが開きます。OK をクリックして Eclipse を再起動します。
						




SAP 宛先接続の作成とテスト



概要




					Fuse SAP Tool スイートでは、Edit SAP Connection Configuration ダイアログボックスを使用して、SAP アプリケーション宛先接続を作成および管理できます。このセクションでは、SAP 宛先接続を作成およびテストする方法について説明します。
				

手順




					SAP 宛先接続を作成してテストするには、次の手順を実行します。
				
	
							ルートエディターのグローバル Configurations タブに移動し、Add をクリックします。
						

							Create new global element ビューが表示されます。
						

	
							SAP で、作成する接続のタイプを選択します。SAP Connection を選択し、OK をクリックします。
						

							Edit SAP Connection Configuration ダイアログボックスが表示されます。これにより、宛先およびサーバー接続設定を作成、編集、削除できます。
						

	
							新しい Destination Data Store を作成するには、Add Destination タブをクリックします。
						

							Create Destination ダイアログボックスが表示されます。
						

	
							Destination Name フィールドに宛先の名前を入力し、Ok をクリックします。
						
	
							Properties ダイアログボックスで以下を実行します。
						
	
									Basic タブをクリックして、SAP 宛先への接続に必要な基本プロパティーを設定します。このタブで、次のプロパティーフィールドに入力して接続を設定します。
								
	
											SAP Application Server
										
	
											SAP System Number
										
	
											SAP Client
										
	
											Logon User
										
	
											Logon Password
										
	
											Logon Language
										



	
									Connection タブをクリックして、SAP 宛先への接続に必要な値を追加します。次のプロパティーフィールドに入力して、接続を設定します。
								
	
											SAP System Number
										
	
											SAP Router String
										
	
											SAP Application Server
										
	
											SAP Message Server
										
	
											SAP Message Server Port
										
	
											Gateway Host
										
	
											Gateway Port
										
	
											SAP System ID
										
	
											SAP Application Server Group
										



	
									Authenticate タブをクリックして、SAP 宛先の検証に必要な値を追加します。次のプロパティーフィールドに入力して、接続を設定します。
								
	
											SAP Authentication type
										
	
											SAP Client
										
	
											Logon User
										
	
											Logon User Alias
										
	
											Logon Password
										
	
											SAP SSO Logon Ticket
										
	
											SAP X509 Login Ticket
										
	
											Logon Language
										



	
									Special タブをクリックします。このタブで、次のプロパティーフィールドに入力して接続を設定します。
								
	
											Select CPIC Trace
										
	
											Initial Codepage
										



	
									Pool タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。
								
	
											Connection Pool Peak Limit
										
	
											Connection Pool Capacity
										
	
											Connection Pool Expiration Time
										
	
											Connection Pool Expire Check Period
										
	
											Connection Pool Max Get Client Time
										



	
									SNC タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。
								
	
											SNC Partner Name
										
	
											SNC Level of Security
										
	
											SNC Name
										
	
											SNC Library Path
										



	
									Repository タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。
								
	
											Repository Destination
										
	
											Repository Logon User
										
	
											Repository Logon Password
										
注記

												これらの設定について詳しい情報が必要な場合は、SAP のドキュメントを参照してください。
											








	
							これで、宛先接続をテストする準備が整いました。Edit SAP Connection Configuration ダイアログボックスで宛先名を右クリックし、Test を選択します。
						

							Test Destination Connection ダイアログボックスが開きます。
						

	
							ダイアログボックスでは、現在の宛先設定を使用して SAP Destination Data Store に接続します。テストが成功すると、ステータス領域に次のメッセージが表示されます。
						
Connection test for destination 'YourDestination' succeeded.

							それ以外の場合は、ステータス領域にエラーレポートが表示されます。
						

	
							Close をクリックして、Test Destination Connection ダイアログボックスを閉じます。
						
	
							Finish をクリックします。新しく作成された SAP Destination Connection が SAP の下に表示されます。
						




SAP サーバー接続の作成とテスト



概要




					Fuse SAP Tool スイートでは、Edit SAP Connection Configuration ダイアログボックスを使用して、SAP アプリケーションサーバー接続を作成および管理できます。このセクションでは、SAP サーバー接続を作成およびテストする方法について説明します。
				

手順




					SAP サーバー接続を作成してテストするには、次の手順を実行します。
				
	
							ルートエディターのグローバル Configurations タブに移動し、Add をクリックします。
						

							Create new global element ビューが表示されます。
						

	
							SAP で、作成する接続のタイプを選択します。SAP Connection を選択し、OK をクリックします。
						

							Edit SAP Connection Configuration ダイアログボックスが表示されます。これにより、宛先およびサーバー接続設定を作成、編集、削除できます。
						

	
							新しい Server Data Store を作成するには、Add Server タブをクリックします。
						

							Create Server ダイアログボックスが表示されます。
						

	
							Server Name フィールドにサーバーの名前を入力し、Ok をクリックします。
						
	
							Properties ダイアログボックスで以下を実行します。
						
	
									Mandatory タブをクリックして、SAP サーバーへの接続に必要な基本プロパティーを設定します。このタブで、次のプロパティーフィールドに入力して接続を設定します。
								
	
											Gateway Host
										
	
											Gateway Port
										
	
											Program ID
										
	
											Repository Destination
										
	
											Connection Count
										



	
									Optional タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。
								
	
											SAP Router String
										
	
											Worker Thread Count
										
	
											Minimum Worker Thread Count
										
	
											Maximum Startup Delay
										
	
											Repository Map
										



	
									SNC タブをクリックし、次のプロパティーフィールドに入力して接続を設定します。
								
	
											SNC Level of Security
										
	
											SNC Name
										
	
											SNC Library Path
										
注記

												設定の詳細については、SAP のドキュメントを参照してください。
											








	
							これで、サーバー接続をテストする準備が整いました。Edit SAP Connection Configuration ダイアログボックスでサーバー名を右クリックし、Test を選択します。
						

							Test Server Connection ダイアログボックスが開きます。
						

	
							ダイアログボックスでは、現在のサーバー設定を使用して SAP Server Data Store に接続します。テストが成功すると、ステータス領域に次のメッセージが表示されます。
						
Server state: STARTED
Server state: ALIVE

							テストが失敗した場合、サーバーのステータスは DEAD として報告されます。
						

	
							Stop をクリックして、テストサーバーをシャットダウンします。
						
	
							Close をクリックして、Test Server Connection ダイアログボックスを閉じます。
						
	
							Finish をクリックします。新しく作成された SAP Server Connection が SAP の下に表示されます。
						




宛先接続およびサーバー接続の削除



概要




					このセクションでは、Edit SAP Connection Configuration ダイアログボックスで SAP 宛先接続およびサーバー接続を削除する方法について説明します。
				

手順




					宛先接続とサーバー接続を削除する場合は、次の手順を実行します。
				
	
							ルートエディターのグローバル Configurations タブに移動し、Add をクリックします。
						

							Create new global element ビューが表示されます。
						

	
							SAP で SAP Connection を選択し、Ok をクリックします。
						

							Edit SAP Connection Configuration ダイアログボックスが表示されます。これにより、宛先およびサーバー接続設定を作成、編集、削除できます。
						

	
							Edit SAP Connection Configuration ダイアログボックスで、削除する Destination and Server Data Stores を選択します。
						
	
							Delete をクリックします。選択した接続が削除されます。
						

							最後に、Finish をクリックします。すべての変更が保存されます。
						





新規 SAP エンドポイントの作成



概要




					ルートエディターのコンポーネントパレットを使用して、Edit SAP Connection Configuration ダイアログで SAP コンポーネントをルートに追加できます。
				
注記

						SAP Connection ビューを使用している場合は、必ず必要な SAP 接続設定データを Blueprint XML または Spring XML コードに貼り付けてください。
					


前提条件




					Edit SAP Connection Configuration ダイアログを使用して、いくつかの SAP 宛先接続またはサーバー接続 (あるいはその両方) が作成済みである必要があります。
				
注記

						SAP Connection ビューを使用している場合は、この設定を適切なタイプ (Blueprint XML または Spring XML) のファイルにエクスポートします。
					


手順




					新しい SAP エンドポイントを作成するには、次の手順を実行します。
				
	
							使用する Fuse プロジェクトと Camel XML ファイル (Blueprint XML または Spring XML 形式のいずれか) が既に存在することを前提としています。
						
	
							ルートエディターで Camel XML ファイルを開きます。Red Hat Fuse SAP Tool Suite をすでにインストールしている場合は、ルートエディターの Components パレットの下に SAP コンポーネントが表示されるはずです。次の SAP コンポーネントは、ツールスイートによって提供されます。
						
	
									SAP IDoc Destination
								
	
									SAP IDoc List Destination
								
	
									SAP IDoc List Server
								
	
									SAP qRFC Destination
								
	
									SAP Queued IDoc Destination
								
	
									SAP Queued IDoc List Destination
								
	
									SAP sRFC Destination
								
	
									SAP sRFC Server
								
	
									SAP tRFC Destination
								
	
									SAP tRFC Server
								

									ルートエディターの Design タブで、これらのコンポーネントのいずれかをキャンバスにドラッグし、現在の camelContext に新しい SAP エンドポイントを作成します。
								
注記

										SAP Netweaver コンポーネントは、Red Hat Fuse SAP Tool Suite に属していません。Apache Camel プロジェクトでホストされています。
									





	
							キャンバスの下部にある Source タブをクリックして、ルートエディターの Source タブに移動します。ルートの XML ソースが表示されます。
						
	
							SAP エンドポイント URI を指定する場合、宛先名またはサーバー接続名のいずれかを URI 形式で埋め込む必要があります。たとえば、sap-srfc-destination コンポーネントの URI 形式は以下のとおりです。
						
sap-srfc-destination:destinationName:rfcName

							特定の宛先を参照するには、関連する entry 要素の key 属性の値をこの URI の destinationName として使用します。
						






第9章 データ変換のスタートガイド




				システムとデータのインテグレーションに伴う課題の 1 つは、コンポーネントシステムがさまざまなデータ形式で動作することが多いことです。つまり、受信システムが認識できる形式 (または言語) にメッセージを変換しなければ、システムから別のシステムにメッセージを送信できません。データ変換とは、この変換を表す用語です。
			

				この章では、事前定義された Camel ルートにデータ変換を含める方法を説明します。Camel ルートは、XML データを生成するソースエンドポイントから JSON データを消費するターゲットエンドポイントにメッセージを送信します。ソースの XML データ形式をターゲットの JSON データ形式にマップするデータ変換コンポーネントを追加して定義します。
			
データ変換サンプルプロジェクトの作成



	
							新規 Fuse Integration プロジェクトを作成します (File → New → Fuse Integration Project を選択します)。
						

							ウィザードで次の情報を入力します。
						
	
									プロジェクト名: starter
								
	
									デプロイメントプラットフォーム: Standalone
								
	
									ランタイム環境: Karaf/Fuse on Karaf
								
	
									Camel バージョン: デフォルトを使用
								
	
									テンプレート: Empty - Blueprint DSL
								



	
							準備済みデータサンプルを https://github.com/FuseByExample/fuse-tooling-tutorials/archive/user-guide-11.1.zip からダウンロードします。
						
	
							data フォルダーとそこに含まれる 3 つのファイルを、user-guide-11.1.zip アーカイブから Fuse Integration プロジェクトの src ディレクトリー (starter/src/data) に展開します。
						
	
							Project Explorer ビューで、スタータープロジェクトを展開します。
						
	
							Camel Contexts → src/main/resources/OSGI-INF/blueprint/blueprint.xml をダブルクリックして、ルートエディターの Design タブでルートを開きます。
						
	
							Source タブをクリックして基礎となる XML を表示します。
						
	
							<route id="_route1"/> を以下のコードに置き換えます。
						
<route id="_route1">
  <from id="_from1" uri="file:src/data?fileName=abc-order.xml&amp;noop=true"/>
  <setHeader headerName="approvalID" id="_setHeader1">
    <simple>AUTO_OK</simple>
  </setHeader>
  <to id="_to1" uri="file:target/messages?fileName=xyz-order.json"/>
</route>

	
							Design タブをクリックして、ルートのグラフィカル表示に戻ります。
						
[image: 説明]





Camel ルートへのデータ変換ノードの追加



	
							Palette で、Transformation ドロワーを展開します。
						
	
							Data Transformation パターンをクリックし、キャンバスで SetHeader _setHeader1 と To_to1 ノード間の矢印をクリックします。
						

							New Transformation ウィザードが開き、Dozer File Path フィールドが自動入力されます。
						
[image: 説明]


	
							残りのフィールドに入力します。
						
	
									Transformation ID フィールド: xml2json を入力します。
								
	
									Source Type は、ドロップダウンメニューから XML を選択します。
								
	
									Target Type は、ドロップダウンメニューから JSON を選択します。
								



	
							Next をクリックします。
						

							Source Type (XML) 定義ページが開き、XML Schema (デフォルト) または XML Instance Document の例を指定して、ソースデータのタイプ定義を指定します。
						
[image: 説明]


	
							XML Schema は有効のままにします。
						
	
							Source file での場合は、ソースデータの種類定義に使用する XML スキーマファイルまたは XML インスタンスファイルの場所を参照して、選択します (ここでは abc-order.xsd)。
						

							XML Structure Preview ペインには、XML 構造のプレビューが表示されます。
						

	
							Element root フィールドに ABCOrder を入力します。
						

							ツールはこのテキストを使用して、マップするソースデータ項目を表示するペインにラベルを付けます。
						

							Source Type (XML) 定義ページは以下のようになります。
						
[image: 説明]


	
							Next をクリックして Target Type (JSON) 定義ページを開きます。ここで、ターゲットデータのタイプ定義を指定します。
						
[image: 説明]


	
							JSON Instance Document をクリックします。
						

							Target File フィールドに、xyz-order.json インスタンスドキュメントへのパスを入力します。または、このドキュメントを参照します。JSON Structure Preview ペインには、JSON データ構造のプレビューが表示されます。
						
[image: 説明]


	
							Finish をクリックします。
						



					変換エディターが開きます。ここで、XML ソースのデータ項目を JSON ターゲットのデータ項目にマップできます。
				
[image: 説明]


					変換エディターは、次の 3 つのパネルで設定されています。
				
	
							Source —ソ ースの利用可能なデータ項目が一覧表示されます
						
	
							Mappings — ソースとターゲットのデータ項目間のマッピングが表示されます
						
	
							Target — ターゲットの利用可能なデータ項目が一覧表示されます
						



					さらに、エディターの 3 つのパネルのすぐ下にあるエディターの詳細ペイン (最初のマッピングが作成されると表示) には、現在選択されているマッピング済みのソースデータ項目とターゲットデータ項目の両方の階層先がグラフィカル表示されます。以下に例を示します。
				
[image: Details pane with source property customerNum mapped to target property role="italic">custId]


					詳細ペインを使用して、選択したソースおよびターゲットのデータ項目のマッピングをカスタマイズできます。
				
	
							Set property — 既存のマッピングを変更するか、単純なデータ項目をコレクション内の 1 つにマップします (「単純なデータ項目をコレクションのデータ項目にマッピング」 を参照)。
						
	
							Set variable — データ項目の定数値を指定します (「定数変数のデータ項目へのマッピング」 を参照)。
						
	
							Set expression — データ項目を指定された式の動的評価にマップします (「式のデータ項目へのマッピング」 を参照)。
						
	
							Add transformation — ビルトイン関数を使用して、マップされたデータ項目の値を変更します (「マップされたデータ項目へのビルトイン関数の追加」 を参照)。
						
	
							Add custom transformation — 作成した Java メソッドまたは以前に作成したメソッドを使用して、マップされたデータ項目の値を変更します (「マップされたデータ項目へのカスタム変換の追加」 を参照)。
						



ソースデータ項目をターゲットデータ項目にマッピング



	
							Mappings パネルの左右にある Source パネルおよび Target パネルのすべての項目を展開します。
						
[image: 説明]


	
							Source パネルからデータ項目をドラッグし、Target パネルの対応するデータ項目にドロップします。
						

							たとえば、Source パネルから customerNum データ項目をドラッグし、Target パネルの custId データ項目にドロップします。
						
[image: 説明]


							マッピングは Mappings パネルに表示され、Source と Target の両方のデータ項目の詳細が下の詳細ペインに表示されます。
						

	
							すべての基本的なマッピングが完了するまで、ソースデータ項目を対応するターゲットデータ項目にドラッグアンドドロップします。
						

							starter の例では、マッピングする残りのデータ項目は以下のようになります。
						
	ソース	ターゲット
	 
											orderNum
										

										 	 
											orderId
										

										 
	 
											status
										

										 	 
											priority
										

										 
	 
											id
										

										 	 
											itemId
										

										 
	 
											price
										

										 	 
											cost
										

										 
	 
											quantity
										

										 	 
											amount
										

										 


注記

								コレクション (リストまたはセットを含むデータ項目) を非コレクションデータ項目にマップしたりその逆にマップしたりすることは可能ですが、コレクションを他のコレクションにマップすることはできません。
							


	
							Source パネルと Target パネルの両方で 
							[image: Hide mapped fields icon]
							 をクリックし、すべてのデータ項目がマッピングされているかどうかを素早く判別します。
						
[image: 説明]


							マッピングされていないデータ項目のみが Source および Target パネルに表示されます。
						

							starter の例では、マッピングされていない残りの Target 属性は approvalCode および origin です。
						

	
							blueprint.xml タブをクリックして、ルートのグラフィカル表示に戻ります。
						
[image: DTmapComplete]


	
							File → Save をクリックします。
						



					変換テストを作成した後、変換ファイルに対して JUnit テストを実行できます。詳細は、「変換テストファイルの作成と JUnit テストの実行」 を参照してください。この時点でこれを行うと、Console ビューに次の出力が表示されます。
				

					ソース XML データの場合:
				
<?xml version="1.0" encoding="UTF-8"?>
<ABCOrder xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance" xmlns:java="http://java.sun.com">
    <header>
        <status>GOLD</status>
        <customer-num>ACME-123</customer-num>
        <order-num>ORDER1</order-num>
    </header>
    <order-items>
        <item id="PICKLE">
            <price>2.25</price>
            <quantity>1000</quantity>
        </item>
        <item id="BANANA">
            <price>1.25</price>
            <quantity>400</quantity>
        </item>
    </order-items>
</ABCOrder>

					ターゲット JSON データの場合:
				
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","lineItems":[{"itemId":"PICKLE",
"amount":1000,"cost":2.25},{"itemId":"BANANA","amount":400,"cost":1.25

変換テストファイルの作成と JUnit テストの実行



	
							Project Explorer ビューで starter プロジェクトを右クリックし、New → Other → Fuse Tooling → Fuse Transformation Test の順に選択します。
						
	
							Next を選択して New Transformation Test ウィザードを開きます。
						
	
							New Transformation Test ウィザードで、以下の値を設定します。
						
	フィールド	値
	 
											Package
										

										 	 
											example
										

										 
	 
											Camel File Path
										

										 	 
											OSGI-INF/blueprint/blueprint.xml
										

										 
	 
											Transformation ID
										

										 	 
											xml2json
										

										 



	
							Finish をクリックします。
						
	
							Project Explorer ビューで starter/src/test/java/example に移動し、TransformationTest.java ファイルを開きます。
						
	
							以下のコードを transform メソッドに追加します。
						
startEndpoint.sendBodyAndHeader(readFile("src/data/abc-order.xml"), "approvalID", "AUTO_OK");

	
							File → Save をクリックします。
						

							これで、チュートリアルの任意の時点で、変換ファイルに対して JUnit テストを実行できます。
						

	
							Project Explorer ビューで、starter プロジェクトを展開して、/src/test/java/example/TransformationTest.java ファイルを公開します。
						
	
							それを右クリックしてコンテキストメニューを開き、Run as JUnit Test を選択します。
						

							JUnit Test ペインが開き、テストのステータスが表示されます。ワークスペースが乱雑になるのを防ぐには、Console ビューの近くにある下部パネルでペインをドラッグアンドドロップします。
						
[image: 説明]


	
							Console ビューを開き、ログ出力を表示します。
						



定数変数のデータ項目へのマッピング




					ソース/ターゲットデータ項目に対応するターゲット/ソースデータ項目がない場合は、定数変数を既存のデータ項目にマップできます。
				

					starter の例では、ターゲットデータ項目 origin には対応するソースデータ項目がありません。origin 属性を定数変数にマッピングするには、以下を実行します。
				
	
							Source パネルで Variables ビューをクリックします。
						
[image: 説明]


	
							Variables ビューで 
							[image: Add a new variable icon]
							 をクリックし、Enter a new variable name ダイアログを開きます。
						
[image: 説明]


	
							作成する変数の名前を入力します。
						

							starter の例では、ORIGIN と入力します。
						

	
							OK をクリックします。
						

							新規作成された変数 ORIGIN は、Variables ビューの Name 列および Value 列のデフォルト値 ORIGIN に表示されます。
						

	
							デフォルト値をクリックして編集し、値を Web に変更します。
						
	
							Enter キーを押します。
						
	
							新しい変数 ORIGIN を Target パネルの origin データ項目にドラッグしてドロップします。
						
[image: 説明]


							変数 $(ORIGIN) の新しいマッピングが Mappings パネルと、詳細ペインに表示されます。
						

	
							TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファイルの作成と JUnit テストの実行」 を参照してください。
						

							Console ビューには、JSON 形式の出力データが表示されます。
						
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}




式のデータ項目へのマッピング




					この機能により、ターゲットデータ項目を Camel 言語式の動的評価にマップできます。
				

					対応するソースデータアイテムがないターゲット approvalCode データアイテムを使用します。
				
	
							[image: Add a new mapping icon]
							 をクリックし、空の変換マッピングを Mappings パネルに追加します。
						
[image: 説明]


	
							Target パネルから、approvalCode データ項目を Mappings パネルで新しく作成されたマッピングのターゲットフィールドにドラッグアンドドロップします。
						
[image: 説明]


							詳細ペインのターゲットボックスにも、approvalCode データ項目が表示されます。
						

	
							詳細ペインで、ABCOrder ソースボックスの 
							[image: drop-down menu access]
							 をクリックして、ドロップダウンメニューを開きます。
						
[image: 説明]


							メニューオプションは、選択したデータ項目のデータタイプによって異なります。利用可能なオプションは太字になっています。
						

	
							Set expression を選択して、Expression ダイアログボックスを開きます。
						
[image: 説明]


	
							Language で、利用可能な言語の一覧から使用する式言語を選択します。利用可能なオプションは、データ項目のデータタイプによって異なります。
						

							starter の例では、Header を選択します。
						

	
							詳細ペインで、使用する式のソースを選択します。
						

							オプションは Value および Script です。
						

							starter の例では、Value をクリックしてから ApprovalID を入力します。
						

	
							OK をクリックします。
						
[image: 説明]


							Mappings パネルと詳細ペインの両方に、ターゲットデータ項目 approvalCode の新しいマッピングが表示されます。
						

	
							TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファイルの作成と JUnit テストの実行」 を参照してください。
						

							Console ビューには、JSON 形式の出力データが表示されます。
						
{"custId":"ACME-123","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}




マップされたデータ項目へのカスタム変換の追加




					ターゲットシステムの要件を満たしていなければ、ソースデータアイテムのフォーマットを変更する必要がある場合もあります。
				

					たとえば、すべての顧客 ID を括弧で囲むというターゲットシステムの要件を満たすには、以下を実行します。
				
	
							Mappings パネルで customerNum マッピングを選択し、詳細ペインに反映させます。
						
[image: 説明]


	
							詳細ペインで、ABCOrder ソースボックスの 
							[image: drop-down menu access]
							 をクリックして、ドロップダウンメニューを開きます。
						
[image: 説明]


	
							Add custom transformation を選択して、Add Custom Transformation ページを開きます。
						
[image: 説明]


	
							Class フィールドの横にある 
							[image: create new function button]
							 をクリックして、Create a New Java Class ウィザードを開きます。
						
[image: 説明]


	
							以下のフィールドを変更します。
						
	
									Package: example を入力します。
								
	
									Name: MyCustomMapper を入力します。
								
	
									Method Name: map を brackets に変更します。
								

									その他のフィールドはすべてそのままにします。
								




	
							Finish をクリックします。
						

							Add Custom Transformation ページが開き、Class および Method フィールドが自動的に入力されます。
						
[image: 説明]


	
							OK をクリックして Java エディターで MyCustomMapper.java ファイルを開きます。
						
[image: 説明]


	
							brackets メソッドを編集して、最後の行 return null; を以下のように変更します。
						
return "[" + input + "]";

	
							transformation.xml タブをクリックし、変換エディターに戻ります。
						
[image: 説明]


							詳細ペインは、brackets メソッドが customerNum のデータ項目に関連付けられていることを示しています。
						

							この brackets メソッドは、ターゲットシステムに送信される前にソース入力で実行されます。
						

	
							TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファイルの作成と JUnit テストの実行」 を参照してください。
						

							Console ビューには、JSON 形式の出力データが表示されます。
						
{"custId":"[ACME-123]","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"itemId":"PICKLE","amount":1000,"cost":2.25},
{"itemId":"BANANA","amount":400,"cost":1.25}]}




単純なデータ項目をコレクションのデータ項目にマッピング




					このチュートリアルでは、Source のすべての id を Target の itemId にマッピングする既存のマッピングを変更します。新しいマッピングは、Source の customerNum データ項目を、Target の lineItems コレクションの 2 番目の項目である itemId にマッピングします。
				

					この変更により、ソースの id は Target の itemId にマッピングされません。
				
	
							Mappings パネルでマッピング id - > itemId を選択し、詳細ペインにマッピングを表示します。
						
[image: 説明]


	
							Source ボックスで 
							[image: drop-down menu access]
							 をクリックし、ドロップダウンメニューを開き、Set property を選択します。
						
[image: 説明]


	
							Select a property ページで header ノードを展開し、customerNum を選択します。OK をクリックして変更を保存します。
						
[image: プロパティーの選択]


	
							詳細ペインには、XyzOrder に lineItems フィールドがあることが表示されるようになりました。lineItems の横にあるトグルボタンをクリックして、その値を 1 に増やします。
						
注記

								インデックスはゼロがベースであるため、1 の値はコレクション内の 2 番目のインスタンスである itemId を選択します。
							

[image: 説明]


							詳細ペインには、lineItems コレクションの 2 番目の項目である itemId にマッピングされた customerNum が表示されます。
						

	
							TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファイルの作成と JUnit テストの実行」 を参照してください。
						

							Console ビューには、JSON 形式の出力データが表示されます。
						
{"custId":"[ACME-123]","priority":"GOLD","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"amount":1000,"cost":2.25},
{"itemId":"ACME-123","amount":400,"cost":1.25}]}




マップされたデータ項目へのビルトイン関数の追加




					ビルトインの文字列関連関数を使用して、マップされたデータ項目に変換を適用できます。
				
	
							Transformations パネルで status から priority へのマッピングを選択し、詳細ペインに反映させます。
						
[image: 説明]


	
							Source ボックスで 
							[image: drop-down menu access]
							 をクリックし、ドロップダウンメニューを開き、Add transformation を選択します。
						
[image: 説明]


	
							Transformations ペインで append を選択し、Arguments ペイン で suffix の値に -level を入力します。
						

							この append 関数は、status 文字列をターゲットの priority データ項目にマッピングする前に、指定された接尾辞を文字列の最後に追加します。
						
[image: 説明]


	
							OK をクリックします。
						
[image: 説明]


							デフォルトでは、詳細ペインには、append 関数を status データ項目に追加した結果がユーザーフレンドリーな形式で表示されます。このフォーマットを変更するには、Source ボックスの右端の 
							[image: drop-down menu access]
							 をクリックし、Show standard format を選択します。
						
[image: 説明]


	
							TransformationTest.java ファイルで JUnit テストを実行します。詳細は、「変換テストファイルの作成と JUnit テストの実行」 を参照してください。
						

							Console ビューには、JSON 形式の出力データが表示されます。
						
{"custId":"[ACME-123]","priority":"GOLD-level","orderId":"ORDER1","origin":"Web",
"approvalCode":"AUTO_OK","lineItems":[{"amount":1000,"cost":2.25},{"itemId":"ACME-123",
"amount":400,"cost":1.25}]}




データ変換を使用して Fuse Integration プロジェクトを Red Hat Fuse サーバーに公開




					データ変換プロジェクトを Fuse サーバーに公開する前に (29章Fuse Integration プロジェクトのサーバーへの公開を参照)、Fuse ランタイムに以下の機能をインストールする必要があります。
				
	
							camel-dozer
						
	
							camel-jackson
						
	
							camel-jaxb
						



					Fuse ランタイムに必要な機能をインストールするには、以下を行います。
				
	
							まだの場合は Fuse Integration パースペクティブに切り替えます。
						
	
							必要な場合は、Fuse サーバーを Servers リストに追加します (「サーバーの追加」 を参照)。
						
	
							Fuse Server (「サーバーの起動」 を参照) を起動し、JBoss Fuse シェルが Terminal ビューに表示されるまで待ちます。
						
	
							必要な camel- 関数ごとに、JBossFuse:admin@root> のプロンプトで以下を入力します。
						

							features:install camel-<featureName>
						

							ここで、featureName は、dozer、jackson、または jaxb のいずれかです。
						

	
							各機能が正常にインストールされていることを確認するには、JBossFuse:admin@root> のプロンプトで以下のコマンドを入力します。
						

							features:list --ordered --installed
						

							出力一覧に先ほどインストールした camel 機能が表示されるはずです。
						
[image: DTCamFeatsInstalled]






第10章 Fuse Online インテグレーション用エクステンションの開発




				Fuse Online は、アプリケーションを統合するための Web インターフェイスを提供する Red Hat Fuse 機能です。ビジネスエンジニアは、コードを作成せずに、Fuse Online を使用してアプリケーションに接続し、任意で異なるアプリケーションへのコネクション間のデータで操作できます。インテグレーターが必要とする機能を Fuse Online が提供しない場合、開発者は必要な動作を定義するエクステンションを作成できます。
			

				Fuse Tooling を使用して、Fuse Online で使用する機能を提供するエクステンションを開発できます。エクステンションは、以下を定義します。
			
	
						インテグレーションでコネクション間のデータを操作する 1 つ以上のカスタム ステップ
					

						または
					

	
						1 つのカスタム コネクター
					



				Fuse Online では、コネクター はデータの取得元または送信先となる特定のアプリケーションを表します。各コネクターは、その特定のアプリケーションへの接続を作成するためのテンプレートです。たとえば、Salesforce コネクターは Salesforce への接続を作成するためのテンプレートです。Fuse Online で Fuse Online ユーザーが必要とするコネクターが提供されていない場合、カスタムコネクターを定義するエクステンションを開発できます。
			

				Fuse Online では、インテグレーションのコネクション間で発生するデータ操作を ステップ と呼びます。Fuse Online は、データのフィルターリングやマッピングなどの操作のステップを提供します。Fuse Online のビルトインステップでは提供されない方法で接続間のデータを操作するために、1 つ以上のカスタムステップを定義する Fuse Online エクステンションを開発できます。
			
注記

					任意の IDE でエクステンションを開発することもできます。Fuse Tooling と別の IDE のどちらを使用するかは、完全に個人が選択できます。IDE でのエクステンションの開発に関する情報は、Fuse Online でのアプリケーションの統合 を参照してください。
				

タスクの概要




					以下は、Fuse Online エクステンションを開発するためのタスクの概要です。
				
	
							Red Hat CodeReady Studio で、Fuse Online エクステンションプロジェクトを作成し、エクステンションタイプとして Custom Connector または Custom Step を選択します。
						
	
							エクステンションのタイプに応じて、エクステンションのコードを記述します。
						
	
									Custom Connector: ベース Camel コンポーネント、コネクターアイコン、グローバルコネクタープロパティー、およびコネクターアクションを定義します。
								
	
									Custom Step: ルートの追加、アクションの定義、および依存関係の指定を行います。
								



	
							.jar ファイルをビルドします。
						
	
							.jar ファイルを Fuse Online ユーザーに提供します。
						



					Fuse Online ユーザーは .jar ファイルを Fuse Online にアップロードし、カスタムコネクターまたはカスタムステップを使用できるようにします。Fuse Online とインテグレーションの作成方法は、Fuse Online でのアプリケーションの統合 を参照してください。
				

前提条件




					開始する前に、以下の情報および知識が必要です。
				
	
							Fuse Online カスタムコネクターまたはステップに必要な機能の説明 (Fuse Online ユーザーから)。
						
	
							エクステンションの Fuse Online バージョン番号。
						
	
							カスタムコネクターの場合、PNG または SVG 形式のアイコンイメージファイル。Fuse Online は、このアイコンをインテグレーションのフローを表示するときに使用します。アイコンを指定しない場合、エクステンションが含まれる .jar がアップロードされると Fuse Online が 1 つ作成します。
						
	
							以下に精通している必要があります。
						
	
									Fuse Online
								
	
									Spring Boot XML または Java
								
	
									Apache Camel ルート (ルートベースのステップエクステンションを作成する場合)
								
	
									JSON
								
	
									Maven
								






カスタムコネクターの作成




					Fuse Online では、カスタムコネクターは 1 つ以上の接続設定パラメーター、1 つ以上の接続アクション、およびアクションの任意の設定パラメーターで設定されます。
				

					カスタムコネクターを開発するためのタスクの概要を以下に示します。
				
	
							Red Hat CodeReady Studio で、Fuse Online エクステンションプロジェクトを作成し、エクステンションタイプとして Custom Connector を選択します。
						
	
							エクステンションのコードを記述します。ベース Camel コンポーネント、コネクターアイコン、グローバルコネクタープロパティー、およびコネクターアクションを定義します。
						


カスタムコネクターの Fuse Online Extension プロジェクトの作成




						Fuse Tooling Fuse Online エクステンションプロジェクトは、カスタムコネクターの開始点を提供します。
					

						Fuse Tooling Fuse Online エクステンションプロジェクトを作成するには、以下の手順に従います。
					
	
								Red Hat CodeReady Studio で New → Project → Red Hat Fuse → Fuse Online Extension Project を選択します。
							

								New Fuse Online Extension Project ウィザードが開きます。
							
[image: FuseOnlineExtWiz page1]


	
								プロジェクトの名前と場所を入力してから Next をクリックします。
							
[image: FuseOnlineExtWiz page2]


	
								Fuse Online のバージョンを選択します。
							
	
								以下のエクステンションの詳細を指定します。
							
	
										ID  — Fuse Online 環境で定義される一意の値。この値は、Fuse Online ユーザーがエクステンションの .jar ファイルをインポートする際に Fuse Online に表示されます。
									
	
										Name  — エクステンションの名前。この値は、Fuse Online にエクステンション名として表示されます。Fuse Online の Customizations → Extensions タブで、ユーザーは Fuse Online にアップロードされたエクステンションの名前と説明を一覧表示できます。
									
	
										Description  —  オプションの、エクステンションコンテンツの説明。
									
	
										Version  —  エクステンションのバージョン。たとえば、これが最初のバージョンの場合、1.0 を入力します。バージョンを更新する場合は、1.1 または 2.0 を入力します。
									



	
								作成する Fuse Online エクステンションの種類として Custom Connector を選択します。
							
[image: FuseOnlineExtWiz connector]


	
								Finish をクリックします。
							



						新しいプロジェクトが Red Hat CodeReady Studio の Project Explorer ビューに表示されます。これには、カスタムコネクターエクステンションの以下のファイルが含まれます。
					
	
								src/main/resources/META-INF/syndesis フォルダー:
							
	
										記述子ファイル: syndesis-extension-definition.json
									

										このファイルを編集します。* 最上位のグローバルプロパティー、コネクターアクション、アクションプロパティーを追加します。* エクステンション Id、名前、バージョン、または説明の値を変更します。
									

	
										デフォルトのアイコンイメージファイル: icon.png
									

										オプションで、このファイルを独自のアイコンイメージ (PNG または SVG) ファイルに置き換えることができます。
									




	
								Maven Project Object Model ファイル: pom.xml
							

								このファイルには、Maven がプロジェクトをビルドするために使用されるプロジェクトおよび設定詳細に関する情報 (デフォルトのエクステンション依存関係を含む) が含まれます。このファイルを編集してカスタム依存関係を追加します。Red Hat が出荷する依存関係のスコープが提供されます。以下はその例です。
							
<dependency>
    <groupId>io.syndesis.extension</groupId>
    <artifactId>extension-api</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.apache.camel</groupId>
    <artifactId>camel-core</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.springframework.boot</groupId>
    <artifactId>spring-boot-starter</artifactId>
    <scope>provided</scope>
</dependency>




カスタムコネクターのコードの記述




						Fuse Online エクステンションプロジェクトを作成した後、Fuse Online ユーザーによって提供される必要な機能の説明を基にして、カスタムコネクター要素を定義するコードを記述します。表10.1「カスタムコネクター要素」 の表は、Fuse Tooling で作成したカスタムコネクター要素が Fuse Online 要素にどのように対応するか示しています。
					
表10.1 カスタムコネクター要素
	Fuse Tooling 要素	Fuse Online 要素	説明
	 
										グローバル (最上位) プロパティー
									

									 	 
										接続設定パラメーター
									

									 	 
										Fuse Online ユーザーがこのコネクターから接続を作成すると、ユーザーは接続設定の一部としてこのプロパティーの値を指定します。
									

									 
	 
										Action
									

									 	 
										接続アクション
									

									 	 
										Fuse Online では、Fuse Online ユーザーはこのコネクターから作成された接続に対して、アクションの 1 つを選択します。
									

									 
	 
										アクションで定義されたプロパティー
									

									 	 
										アクション設定パラメーター
									

									 	 
										Fuse Online ユーザーが接続で実行するアクションを設定する場合、Fuse Online ユーザーはこのプロパティーの値をアクション設定の一部として指定します。
									

									 




						Fuse Online のカスタムコネクターを実装するコードを記述するには、以下を実行します。
					
	
								エディタービューで syndesis-extension-definition.json ファイルを開き、グローバルプロパティー、カスタムコネクターが実行できるアクション、および各アクションのプロパティーを定義するコードを記述します。
							

								各 グローバルプロパティー は Fuse Online の接続設定パラメーターに対応します。各アクションプロパティーは Fuse Online コネクションアクション設定パラメーターに対応します。Fuse Online では、ユーザーがカスタムコネクターを選択すると、Fuse Online が各接続設定パラメーターの値を要求します。カスタムコネクターは、OAuth プロトコルを使用するアプリケーションのカスタムコネクターであることがあります。この場合、OAuth クライアント ID のグローバルプロパティーと OAuth クライアントシークレットの別のグローバルプロパティーを指定するようにしてください。Fuse Online ユーザーは、このコネクターから作成された接続が機能するように、これらのパラメーターの値を指定する必要があります。
							

								各 コネクターアクション はベース Camel コンポーネントスキームを宣言します。
							

								New Fuse Online Extension Project ウィザードによって提供される例では、telegram Camel コンポーネントスキームを使用します。
							
{
  "schemaVersion" : "v1",
  "name" : "Example Fuse Online Extension",
  "extensionId" : "fuse.online.extension.example",
  "version" : "1.0.0",
  "actions" : [ {
    "id" : "io.syndesis:telegram-chat-from-action",
    "name" : "Chat Messages",
    "description" : "Receive all messages sent to the chat bot",
    "descriptor" : {
      "componentScheme" : "telegram",
      "inputDataShape" : {
        "kind" : "none"
      },
      "outputDataShape" : {
        "kind" : "java",
        "type" : "org.apache.camel.component.telegram.model.IncomingMessage"
      },
      "configuredProperties" : {
        "type" : "bots"
      }
    },
    "actionType" : "connector",
    "pattern" : "From"
  }, {
    "id" : "io.syndesis:telegram-chat-to-action",
    "name" : "Send a chat Messages",
    "description" : "Send messages to the chat (through the bot).",
    "descriptor" : {
      "componentScheme" : "telegram",
      "inputDataShape" : {
        "kind" : "java",
        "type" : "java.lang.String"
      },
      "outputDataShape" : {
        "kind" : "none"
      },
      "propertyDefinitionSteps" : [ {
        "description" : "Chat id",
        "name" : "chatId",
        "properties" : {
          "chatId" : {
            "kind" : "parameter",
            "displayName" : "Chat Id",
            "type" : "string",
            "javaType" : "String",
            "description" : "The telegram's Chat Id, if not set will use CamelTelegramChatId from the incoming exchange."
          }
        }
      } ],
      "configuredProperties" : {
        "type" : "bots"
      }
    },
    "actionType" : "connector",
    "pattern" : "To"
  } ],
  "properties" : {
    "authorizationToken" : {
      "kind" : "property",
      "displayName" : "Authorization Token",
      "group" : "security",
      "label" : "security",
      "required" : true,
      "type" : "string",
      "javaType" : "java.lang.String",
      "secret" : true,
      "description" : "Telegram Bot Authorization Token"
    }
  }
}

	
								カスタムコネクターに追加の依存関係が必要な場合は、その依存関係をプロジェクトの pom.xml ファイルに追加します。依存関係のデフォルトのスコープは runtime です。Red Hat が出荷する依存関係を追加する場合は、指定されたとおりスコープを定義します。以下はその例です。
							
<dependencies>
    <dependency>
          <groupId>org.apache.camel</groupId>
          <artifactId>camel-telegram</artifactId>
          <scope>provided</scope>
    </dependency>
      </dependencies>




						カスタムコネクターのコードの作成が終了したら、「Fuse Online エクステンション JAR ファイルのビルド」の説明に従って .jar ファイルをビルドします。
					


カスタムステップの作成




					Fuse Online エクステンションプロジェクトを作成した後、Fuse Online ユーザーによって提供される必要な機能の説明を基にして、カスタムステップを定義するコードを記述します。1 つのエクステンション内では、複数のカスタムステップを定義できます。また、各カスタムステップを Camel ルートまたは Java Bean で定義できます。
				
カスタムステップの Fuse Online Extension プロジェクトの作成




						Fuse Tooling Fuse Online エクステンションプロジェクトを作成するには、以下の手順に従います。
					
	
								Red Hat CodeReady Studio で New → Project → Red Hat Fuse → Fuse Online Extension Project を選択します。
							

								New Fuse Online Extension Project ウィザードが開きます。
							
[image: FuseOnlineExtWiz page1]


	
								プロジェクトの名前と場所を入力してから Next をクリックします。
							
[image: FuseOnlineExtWiz page2]


	
								Fuse Online のバージョンを選択します。
							
	
								以下のエクステンションの詳細を指定します。
							
	
										ID  — Fuse Online 環境で定義される一意の値。この値は、Fuse Online ユーザーがエクステンションの .jar ファイルをインポートする際に Fuse Online に表示されます。
									
	
										Name  — エクステンションの名前。この値は、Fuse Online にエクステンション名として表示されます。Fuse Online の Customizations → Extensions タブで、ユーザーは Fuse Online にアップロードされたエクステンションの名前と説明を一覧表示できます。
									
	
										Description  —  オプションの、エクステンションコンテンツの説明。
									
	
										Version  —  エクステンションのバージョン。たとえば、これが最初のバージョンの場合、1.0 を入力します。バージョンを更新する場合は、1.1 または 2.0 を入力します。
									



	
								作成する Fuse Online エクステンションの種類として Custom Step を選択します。
							
	
								カスタムステップのテンプレートを選択します。
							
[image: FuseOnlineExtWiz step]

	
										Camel route  —  サンプル Camel ルートを提供します。
									
	
										Java bean  —  サンプル Java Bean を指定します。
									
注記

											選択するテンプレートは、プロジェクトの開始点を提供します。Camel ルートと、同じエクステンション内の Java Bean をベースとする 1 つ以上の他のカスタムステップを作成する場合は、いずれかのテンプレートから開始し、他のタイプのカスタムステップに必要なファイルおよび依存関係を追加します。
										





	
								Finish をクリックします。
							



						新しいプロジェクトが Red Hat CodeReady Studio の Project Explorer ビューに表示されます。これには、カスタムステップ用に選択したテンプレートに応じて、以下のファイルが含まれます。
					
	
								src/main/resources/META-INF/syndesis フォルダー:
							
	
										記述子ファイル: syndesis-extension-definition.json
									

										このファイルを編集します: * 1 つ以上のアクションを追加します。'.json' ファイルのアクションは Fuse Online のカスタムステップになります。アクション要素では、'.json' ファイルのプロパティーは Fuse Online のステップ設定パラメーターになります。* エクステンション Id、名前、バージョン、または説明の値を変更します。
									

	
										Camel ルートテンプレートの場合、Camel コンテキストファイル extensions/log-body-action.xml
									

										このファイルには、ログコンポーネントを含むサンプルルートが含まれています。このファイルで Camel ルートをカスタマイズします。
									

	
										Java Bean テンプレートの場合、Java ファイル extensions/extension.java
									

										このファイルには、POJO ベースのロギングエクステンションのサンプルが含まれています。
									




	
								Maven Project Object Model ファイル: pom.xml
							

								このファイルには、Maven がプロジェクトをビルドするために使用されるプロジェクトおよび設定詳細に関する情報 (デフォルトのエクステンション依存関係を含む) が含まれます。このファイルを編集してカスタム依存関係を追加します。Red Hat が出荷する依存関係のスコープが提供されます。以下はその例です。
							
<dependency>
    <groupId>io.syndesis.extension</groupId>
    <artifactId>extension-api</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.apache.camel</groupId>
    <artifactId>camel-core</artifactId>
    <scope>provided</scope>
</dependency>
<dependency>
    <groupId>org.springframework.boot</groupId>
    <artifactId>spring-boot-starter</artifactId>
    <scope>provided</scope>
</dependency>




カスタムステップのコードの記述




						Fuse Online エクステンションプロジェクトを作成した後、Fuse Online ユーザーによって提供される必要な機能の説明を基にして、カスタムステップを定義するコードを記述します。
					

						表10.2「カスタムステップ要素」 は、Fuse Tooling で作成したカスタムステップ要素が Fuse Online 要素にどのように対応するか示しています。
					
表10.2 カスタムステップ要素
	Fuse Tooling 要素	Fuse Online 要素	説明
	 
										Action
									

									 	 
										カスタムステップ
									

									 	 
										Fuse Online では、ユーザーがステップエクステンションをインポートした後、Choose a step ページにカスタムステップが表示されます。
									

									 
	 
										アクションで定義されたプロパティー
									

									 	 
										カスタムステップ設定パラメーター
									

									 	 
										Fuse Online では、ユーザーがカスタムステップを選択すると、Fuse Online が設定パラメーターの値を要求します。
									

									 




						Fuse Online のカスタムステップを実装するコードを記述するには、以下を実行します。
					
	
								Camel ルートベースのステップの場合、extension.xml ファイルで、エクステンションの目的に対応するルートを作成します。各ルートのエントリーポイントは、ステップ 2 で説明されているように、syndesis-extension-definition.json ファイルで定義するエントリーポイントと一致する必要があります。
							

								Java Bean ベースのステップの場合は、java ファイルを編集します。
							

	
								syndesis-extension-definition.json ファイルで、アクションとそのプロパティーを定義するコードを作成します。各エントリーポイントに新しいアクションが必要です。
							

								作成する各アクションは Fuse Online のカスタムステップに対応します。アクションごとに、異なるタイプのコードを使用できます。つまり、あるアクションに Camel ルートを、別のアクションに Java Bean を使用することができます。
							

								各プロパティーは Fuse Online のステップ設定パラメーターに対応します。Fuse Online では、ユーザーがカスタムステップを選択すると、Fuse Online が設定パラメーターの値を要求します。たとえば、カスタムログステップにはログに送信する情報量を示す level パラメーターが含まれる場合があります。
							

								エクステンションをアップロードし、そのカスタムステップをインテグレーションに追加した後に Fuse Online でユーザーが入力するプロパティーを含むエクステンションメタデータが含まれる .json ファイルのテンプレートは次のとおりです。
							
{
  "actions": [
    {
      "actionType": "extension",
      "id": "${actionId}",
      "name": "Action Name",
      "description": "Action Description",
      "tags": [
           "xml"
      ],
      "descriptor": {
        "kind": "ENDPOINT|BEAN|STEP",
        "entrypoint": "direct:${actionId}",
        "inputDataShape": {
          "kind": "any"
        },
        "outputDataShape": {
          "kind": "any"
        },
        "propertyDefinitionSteps": []
      }
    }
  ],
  "tags": [
    "feature",
    "experimental"
  ]
}
注記

									このリリースではタグは無視されます。これらは今後使用するために予約されています。
								


	
								エクステンションの依存関係を編集するには、エディターで 'pom.xml' ファイルを開きます。依存関係を追加する場合は、そのスコープを定義する必要があります。
							



						カスタムステップのコード作成が終了したら、「Fuse Online エクステンション JAR ファイルのビルド」の説明に従って .jar ファイルをビルドします。
					


Fuse Online エクステンション JAR ファイルのビルド




					エクステンションの .jar ファイルをビルドするには、以下を行います。
				
	
							Project Explorer ビューで、プロジェクトを右クリックします。
						
	
							コンテキストメニューから Run As → Maven clean verify と選択します。
						
	
							Console ビューでは、ビルドの進捗を監視できます。
						
	
							ビルドが完了したら、Project Explorer ビューのターゲットフォルダーを更新します (プロジェクトを選択し、F5 を押します)。
						
	
							Project Explorer ビューでターゲットフォルダーを開き、生成された .jar ファイルを確認します。
						

							.jar ファイルの名前は Maven のデフォルト ${artifactId}-${version}.jar に従います。
						

							例: custom:step-camel-1.0.0.jar
						

							この .jar ファイルは、エクステンション、必要な依存関係、そのメタデータ (Extension Id、Name、Version、Tags、および Description) を定義します。以下に例を示します。
						
{
    "schemaVersion" : "v1",
    "name" : "Example Fuse Online Extension",
    "description" : "Logs a message body with a prefix",
    "extensionId" : "fuse.online.extension.example",
    "version" : "1.0.0",
    "actions" : [ {
        "id" : "Log-body",
        "name" : "Log Body",
        "description" : "A simple xml Body Log with a prefix",
        "descriptor" : {
            "kind" : "ENDPOINT",
            "entrypoint" : "direct:log-xml",
            "resource" : "classpath:META-INF/syndesis/extensions/log-body-action.xml",
            "inputDataShape" : {
                "kind" : "any"
            },
            "outputDataShape" : {
                "kind" : "any"
            },
            "propertyDefinitionSteps" : [ {
                "description" : "Define your Log message",
                "name" : "Log Body",
                "properties" : {
                    "prefix" : {
                        "componentProperty" : false,
                        "deprecated" : false,
                        "description" : "The Log body prefix message",
                        "displayName" : "Log Prefix",
                        "javaType" : "String",
                        "kind" : "parameter",
                        "required" : false,
                        "secret" : false,
                        "type" : "string"
                    }
                }
            } ]
        },
        "tags" : [ "xml" ],
        "actionType" : "step"
    } ],
    "dependencies" : [ {
        "type" : "MAVEN",
        "id" : "io.syndesis.extension:extension-api:jar:1.3.0.fuse-000014"
    } ],
    "extensionType" : "Steps"
}




JAR ファイルを Fuse Online ユーザーに提供




					以下を Fuse Online ユーザーに提供します。
				
	
							.jar ファイル
						
	
							エクステンションを説明するドキュメント。ステップエクステンションでは、ステップエクステンションの各アクションが入力として必要とする、または出力として提供する (データマッピング用) データ形状に関する情報を含めます。
						



					Fuse Online では、ユーザーは Fuse Online でのアプリケーションの統合 の説明どおりに .jar ファイルをアップロードします。
				


第11章 新規 Camel XML ファイルの作成



概要




				Apache Camel は、camelContext 要素が含まれる XML ファイルにルートを保存します。新しい Fuse Integration プロジェクトを作成する場合、ツールはデフォルトでプロジェクトの一部として Apache Camel コンテキスト (XML) ファイルを提供します。
			

				必要な事前設定済み namespace およびテンプレート camelContext 要素が含まれる新しい Camel XML ファイルを追加することもできます。
			

手順




				新しい Apache Camel コンテキストファイルをプロジェクトに追加するには、以下を実行します。
			
	
						図11.1「Camel XML ファイルウィザード」 に示されるように、メインメニューから File → New → Camel XML File を選択し、Camel XML File ウィザードを開きます。
					
図11.1 Camel XML ファイルウィザード
[image: Camel XML ファイルウィザード]



	
						RouteContainer で、新規ファイルの場所を入力するか、デフォルトを使用します。
					

						[image: Browse…​ button]
						 をクリックして、適切な場所を検索できます。
					
重要

							Spring フレームワークと OSGi Blueprint フレームワークでは、すべての Apache Camel ファイルをプロジェクトの META-INF または OSGI-INF フォルダーの特定の場所に配置する必要があります。
						
	
									Spring - projectName/src/main/resources/META-INF/spring/
								
	
									OSGi Blueprint - projectName/src/main/resources/OSGI-INF/blueprint/
								




	
						File Name に、新しいコンテキストファイルの名前を入力するか、デフォルト (camelContext.xml) を受け入れます。
					

						ファイル名にはスペースや特殊文字を含めることはできません。また、JVM 内で一意でなければなりません。
					

	
						Framework では、デフォルトを使用するか、ルートが使用するフレームワークを選択します。
					
	
								Spring  —  Spring コンテナーや OSGi 以外のコンテナーでデプロイされるか、スタンドアロンアプリケーションとしてデプロイされるルート用の [default]
							
	
								OSGi Blueprint  —  OSGi コンテナーにデプロイされるルート用
							
	
								Routes: 読み込み既存の camelContext に追加できるルート用
							



	
						Finish をクリックします。
					

						新しいコンテキストファイルがプロジェクトに追加され、ルートエディターで開かれます。
					





第12章 Camel バージョンの変更




				Fuse ツールプロジェクトで作業する場合、使用する Camel のバージョンを変更することをお勧めします。そうすると、たとえば、より新しいバージョンの Camel でサポートされる機能を使用する場合や、コミュニティーバージョンを使用する場合に役に立ちます。
			

				プロジェクトが使用する Camel バージョンを変更するには、以下を実行します。
			
	
						Project Explorer で、Camel バージョンを変更するプロジェクトを右クリックし、Configure → Change Camel Version を選択します。
					
	
						Change Camel Version ウィンドウで、Camel Version フィールドの右側にある下矢印をクリックし、利用可能な Camel バージョンを表示します。
					

						コミュニティーバージョンの Apache Camel を使用するには、そのバージョン番号 (例: 2.19.2) を入力します。
					

	
						必要なバージョンを選択または入力し、Finish をクリックします。
					



				Fuse Tooling は、選択したバージョンが利用可能で、Fuse Tooling によってサポートされるかどうかを確認します。確認されると、Fuse Tooling は Camel バージョンを変更し、プロジェクトの更新された pom.xml ファイルを保存します。選択した Camel バージョンが利用できない、またはサポートされていない場合、エラーメッセージが表示されます。
			

				pom.xml ファイルの <camel.version> 要素で、プロジェクトの Camel バージョンを確認できます。
			

第13章 既存 Maven プロジェクトのインポート



概要




				たとえば、アプリケーション開発のテンプレートや開始点として使用するために、既存プロジェクトのインポートが必要な場合があります。
			

				たとえば、New Fuse Integration Project ウィザードは、以下の Github リポジトリーを参照します。
			
	
						https://github.com/apache/camel/tree/master/examples
					
	
						https://github.com/fabric8-quickstarts
					
	
						https://github.com/wildfly-extras/wildfly-camel-examples
					
	
						https://github.com/jboss-fuse/quickstarts
					



				プロジェクトサンプルをダウンロードしたら、これを CodeReady Studio にインポートします。
			

手順




				既存の Maven プロジェクトをインポートするには、以下を実行します。
			
	
						File → Import → Maven → Existing Maven Projects の順に選択し、Next をクリックします。
					
	
						ルートディレクトリーには、ダウンロードしたサンプルプロジェクトが含まれているフォルダーを選択します。
					
	
						プロジェクト一覧で、インポートするプロジェクトを確認してから Finish をクリックします。
					




パート II. ルーティングコンテキストのデバッグ





				Camel デバッガーには、ローカルおよびリモートで実行されているルーティングコンテキストのデバッグに使用する機能が多数含まれています。
			
	
						ルートエディターでノードに条件付きおよび無条件のブレークポイントを設定
					
	
						デバッガーの自動起動および Debug パースペクティブへの切り替え
					
	
						実行中のルーティングコンテキストとの対話
					
	
								ブレークポイント間の切り替えでメッセージインスタンスの変数の値を迅速に比較
							
	
								対象の変数の値を確認して変更
							
	
								デバッグセッション全体で追跡するために監視一覧に対象の変数を追加
							
	
								ブレークポイントを無効にして再度有効化
							
	
								ルーティングコンテキストランタイムでのメッセージフローをグラフィカルに追跡
							
	
								コンソールログを確認して、Camel およびデバッガーアクションを追跡
							





注記

					Camel デバッガーを実行する前に、ルートエディターのキャンバスに表示される対象ノードにブレークポイントを設定する必要があります。その後、プロジェクトのルーティングコンテキストの .xml ファイルで Camel デバッガーを実行し、そのコンテキスト内のロジックエラーを見つけ、修正できます。Camel デバッガーを呼び出すと、デバッグモードでルーティングコンテキストが実行され、Debug Perspective が開きます。
				



第14章 ブレークポイントの設定



概要




				ブレークポイントを設定するには、ルートエディターの Design タブでプロジェクトのルーティングコンテキストの .xml ファイルを開く必要があります。
			

				Camel デバッガーは、2 種類のブレークポイントをサポートします。
			
	
						無条件ブレークポイント — デバッグセッション中にブレークポイントが検出されるたびにトリガーされます。
					
	
						条件付きブレークポイント — デバッグセッション中にブレークポイントの指定条件が満たされた場合にのみトリガーされます。
					


注記

					コンシューマーエンドポイントまたは when もしくは otherwise ノードにブレークポイントを設定することはできません。
				


無条件ブレークポイントの設定




				ルーティングコンテキストが Design タブのキャンバスに表示されます。
			
	
						デバッグセッション中に状態を検査するノードを選択します。
					
	
						[image: red dot]
						 アイコンをクリックして、無条件ブレークポイントを設定します。
					
	
						無条件ブレークポイントを設定する各ノードで、この手順を繰り返します。
					



条件付きブレークポイントの設定




				ルーティングコンテキストが Design タブのキャンバスに表示されます。
			
	
						デバッグセッション中に状態を検査するノードを選択します。
					
	
						[image: yellow dot]
						 アイコンをクリックして、条件付きブレークポイントを設定し、Edit the condition and language of your breakpoint… ダイアログを開きます。
					
[image: CondBPCnfg のデバッグ]


	
						Language ドロップダウンメニューをクリックし、ブレークポイントをトリガーする条件を作成するために使用する式の言語を選択します。
					

						Fuse Tooling は、24 の式言語をサポートしています。これらの言語には、条件式を作成するための変数が含まれている場合も、含まれていない場合もあります。
					

	
						Variables をクリックし、選択した言語でサポートされる変数の一覧を表示します。
					

						リストが表示された場合は、1 つ以上の変数を順番に選択して、ブレークポイントをトリガーするための条件を作成します。Condition テキストボックスに選択した変数が表示されます。
					

						[image: expressLangNoVars]
						 が表示された場合には、Condition テキストボックスに式を直接入力します。
					

	
						条件付きブレークポイントを設定する各ノードで、[condBpFirst] から[condBpLast] の手順を繰り返します。
					



ブレークポイントの無効化




				ブレークポイントを一時的に無効にしてそのままにし、後で再度有効にできます。 
				[image: resume co]
				 ボタンは、デバッグセッション中に無効にしたブレークポイントをスキップします。
			

				ブレークポイントを無効にするには、キャンバスのノードを選択し、 
				[image: gray dot]
				 アイコンをクリックします。ブレークポイントは灰色になり、無効化されたことを示します。
			

				無効にしたブレークポイントを有効にするには、キャンバスのノードを選択し、 
				[image: green dot]
				 アイコンをクリックします。無効にしたブレークポイントが条件付きか無条件かに応じて黄色または赤色に変化し、再度有効化されたことを示します。
			
注記

					セッションのデバッグ中にブレークポイントを無効にしてから再度有効にすることもできます。詳細は、19章実行中のコンテキストでのブレークポイントの無効化 を参照してください。
				


ブレークポイントの削除




				個々のブレークポイントまたはすべてのブレークポイントを削除できます。
			
	
						個別のブレークポイントを削除するには、ルートコンテナーでブレークポイントを削除するノードを選択し、その 
						[image: delete bp]
						 アイコンをクリックします。
					
	
						特定のルートにあるすべてのブレークポイントを削除するには、対象のルートのコンテナーを右クリックし、 [image: gray dot]
						 Delete all breakpoints を選択します。
					
	
						すべてのルートですべてのブレークポイントを削除するには、キャンバスを右クリックして  [image: gray dot]
						 Delete all breakpoints を選択します。
					



関連トピック



	
						15章Camel デバッガーの実行
					




第15章 Camel デバッガーの実行




				Camel デバッガーを、ローカルで実行中のルーティングコンテキストで実行できます。
			
注記
	
							リモートデバッグはサポートされなくなりました。リモートデバッグの場合は、Jolokia を設定し、Jolokia 経由で特定の JMX 接続を作成する必要があります。
						
	
							プロジェクトに Java コードが含まれている場合は、標準の Eclipse Java デバッグツールを使用してデバッグできます。
						




				Camel デバッガーを起動する前に、ルーティングコンテキストファイルでブレークポイントを設定する必要があります。
			
手順



	
						Project Explorer ビューで、デバッグするルーティングコンテキストファイルを選択します。
					
	
						選択したファイルを右クリックしてコンテキストメニューを開き、Debug As → Local Camel Context の順に選択します。
					

						Fuse Tooling は Camel ルートをビルドし、Apache Camel を起動し、ルーティングコンテキストを起動し、JMX を有効にし、ルーティングコンテキストでルートを起動し、ブレークポイントをノードに追加し、Camel デバッガーを有効にします。
					

						Camel デバッガーは、最初のブレークポイントヒット (メッセージの受信) でルーティングコンテキストの実行を一時停止し、Debug パースペクティブを開くかどうかを尋ねます。
					
[image: DBCnfrmSwitchToDBView]


	
						Yes をクリックして Debug パースペクティブを開きます。
					

						Debug パースペクティブが開き、実行中のルーティングコンテキストで最初に発生した最初のブレークポイントでルーティングコンテキストが一時停止されます。
					
重要

							ブレークポイントは、デバッガーが自動的に再開した後に最大 5 分間保持され、次のブレークポイントまたはルーティングコンテキストの最後に移動します。
						

[image: openDBPerspective]

注記

							コンソールの出力を表示する場合、パースペクティブをオンにしたときに開いていなければ Console ビューを開きます。
						

注記

							デフォルトでは、Debug パースペクティブには Outline ビューが表示されます。このビューは、実行中のルーティングコンテキストで個別のルートを切り替える手段を提供します。ルーティングコンテキストに単一のルートが含まれている場合は、Outline ビューを閉じると、他のビューを展開するためのスペースが解放され、デバッガー出力へのアクセスと調査が容易になります。
						





ルーティングコンテキストを介したメッセージエクスチェンジの進捗監視




				[image: stepover co]
				 (ステップオーバー) をクリックし、ルーティングコンテキストで実行される次のノードにジャンプします。 
				[image: resume co]
				 (再開) をクリックし、ルーティングコンテキストの次のアクティブなブレークポイントで実行を継続します。
			
[image: debug StateChange]


関連トピック



	
						16章Camel デバッガーの停止
					




第16章 Camel デバッガーの停止



概要




				Camel デバッガーを停止するには、デバッグセッションが終了したら、メニューバーの 
				[image: Terminate button]
				 を 1 回クリックします。それ例外の場合は、 
				[image: Terminate button]
				 を 2 回クリックします。1 回目で現在実行しているノードスレッドを終了し、2 回目で Camel Context スレッドを終了します (どちらも Debug ビューに表示されます)。
			

				+
			
注記

					Camel デバッガーを終了するとコンソールも終了しますが、出力はクリアされません。出力をクリアするには、コンソール ビューのメニューバーの 
					[image: clear co]
					 (コンソールのクリア) をクリックします。
				


Camel デバッガーを閉じる




				プロジェクトのデバッグが終了したら、Debug パースペクティブを閉じて、ワークベンチのスペースを増やすことができます。
			

				これを行うには、CodeReady Studio ツールバーの右側にある 
				[image: Debug perspective icon]
				 を右クリックし、Close を選択します。
			

関連トピック



	
						15章Camel デバッガーの実行
					




第17章 変数値の変更



概要




				Camel デバッガーがブレークポイントに到達すると、Variables ビューにはルーティングコンテキストのその時点で利用可能なすべての変数の値が表示されます。一部の変数は編集可能で、値を変更できます。これにより、アプリケーションがプログラム状態の変更をどのように処理するか確認できます。
			
注記

					すべての変数が編集可能というわけではありません。編集可能な変数のコンテキストメニューには、Change Value… オプションが表示されます。
				


手順




				変数の値を変更するには、以下を実行します。
			
	
						必要に応じてデバッガーを起動します。15章Camel デバッガーの実行を参照してください。
					
	
						Variables ビューで、変更する値の変数を選択し、その Value フィールドをクリックします。
					
[image: editBPvars1]


						変数の value フィールドが薄い青の網掛け表示になり、編集モードであることを示します。
					
注記

							または、変数を右クリックしてコンテキストメニューを開き、Change Value…​ ​を選択して値を編集します。
						


	
						新しい値を入力してから、Enter をクリックします。
					

						Console ビューには、変数の値の変更に関する INFO レベルのログエントリーが表示されます (たとえば、Breakpoint at node to1 is updating message header on exchangeId: ID-dhcp-97-16-bos-redhat-com-52574-1417298894070-0-2 with header: Destination and value: UNITED KINGDOM)。
					

	
						ブレークポイントをステップピングし、メッセージが想定どおりに処理されているかどうかを確認します。各ステップで Debug ビュー、Variables ビュー、および Console の出力を確認します。
					



関連トピック



	
						19章実行中のコンテキストでのブレークポイントの無効化
					
	
						18章ウォッチリストへの変数の追加
					




第18章 ウォッチリストへの変数の追加



概要




				変数をウォッチリストに追加すると、特定の変数にフォーカスして、ルーティングコンテキストを通過する際に、値が想定どおりに変化するかどうかを確認できます。
			

手順




				ウォッチリストに変数を追加するには、以下を実行します。
			
	
						必要に応じてデバッガーを起動します。15章Camel デバッガーの実行を参照してください。
					
	
						Variables ビューで、追跡する変数を右クリックして、コンテキストメニューを開きます。
					
[image: UGaddVarWatchList]


	
						Watch を選択します。
					

						新しいビューである Expressions が、Breakpoints ビューの横に開きます。Expressions ビューには、監視される変数の名前と現在の値が表示されます。以下はその例です。
					
[image: UGwatchList]


	
						[watch1] および [watch2] を繰り返し、ウォッチリストに変数を追加します。
					
注記

							追加する変数は、削除されるまでウォッチリストに残ります。変数の監視を停止するには、リストで変数を右クリックしてコンテキストメニューを開き、Remove をクリックします。
						


	
						Expressions ビューが開いたら、ルーティングコンテキストでステップを実行し、ウォッチリストの各変数がルートの各ステップに到達した際にどのように変化するか追跡します。
					



関連トピック



	
						17章変数値の変更
					




第19章 実行中のコンテキストでのブレークポイントの無効化



概要




				Breakpoints ビューで、実行中のルーティングコンテキストのブレークポイントを無効にして再度有効にできます。
			

				ブレークポイントが無効になっている場合、 
				[image: resume co]
				 ボタンにより、デバッガーはデバッグセッション時にそのブレークポイントをスキップします。
			

ブレークポイントビューでのブレークポイントの無効化と有効化




				ブレークポイントがすべて有効な状態で、Breakpoints ビューが開きます。
			
[image: BPviewEnabled]


				ブレークポイントを無効にするには、そのチェックボックスの選択を解除します。
			
[image: BPviewDisabled]


				無効にする各ブレークポイントについて、Console ビューに INFO レベルのログエントリーが表示され、無効になったことが示されます (例: Removing breakpoint log2)。同様に、再度有効にする各ブレークポイントについて、Console ビューに INFO レベルのログエントリーが表示され、有効になったことが示されます (例: Adding breakpoint log2)。
			
注記

					無効にしたブレークポイントを再度有効にするには、チェックボックスをクリックします。Console ビューに INFO レベルのログエントリーが表示され、ブレークポイントが選択したノードに追加されたことが示されます。
				



パート III. アプリケーションの監視とテスト





				JMX Navigator ビューは、Fuse アプリケーションを監視およびテストする方法を多数提供します。
			
注記

					Fuse の管理 に記載のとおり、Fuse Console で Fuse アプリケーションを監視することもできます。
				



第20章 JMX ナビゲーター




				図20.1「JMX ナビゲータービュー」 に示される JMX Navigator ビューには、アプリケーションで実行されているすべてのプロセスが表示され、監視機能とテスト機能のインタラクションが促進されます。Fuse Integration パースペクティブの他の領域は、JMX Navigator ビューで選択したノードに関連する情報を表示します。JMX Navigator ビューでは、そのコンテキストメニューで、ルートトレースを有効にして JMS 宛先を追加するために必要なコマンドが提供されます。
			
図20.1 JMX ナビゲータービュー
[image: JMX ナビゲータービュー]



				デフォルトでは、JMX Navigator ビューはローカルマシンで実行されているすべての JMX サーバーを検出し、以下のカテゴリーに一覧表示します。
			
	
						ローカルプロセス
					
	
						サーバー接続
					
	
						ユーザー定義の接続
					


注記

					サーバーの JMX URL を使用すると、他の JMX サーバーを追加できます。詳細は、「JMX サーバーの追加」 を参照してください。
				

JMX でのプロセスの表示



概要




					JMX Navigator ビューには、一連のツリー内の既知のプロセスがすべて一覧表示されます。各ツリーのルートは JMX サーバーです。
				

					一覧の最初のツリーは、ローカルマシンで実行しているすべての JMX サーバーが含まれる特別な Local Processes ツリーです。JMX サーバーの 1 つに接続し、含まれるプロセスを確認する必要があります。
				

ローカル JMX サーバーでのプロセスの表示




					ローカル JMX サーバーのプロセスに関する情報を表示するには、以下を行います。
				
	
							JMX Navigator ビューで Local Processes を展開します。
						
	
							Local Processes で、最上位エントリーのいずれかをダブルクリックして接続します。
						
	
							エントリーの横に表示される 
							[image: expansion arrow]
							 アイコンをクリックし、JVM で実行されているコンポーネントの一覧を表示します。
						



代替 JMX サーバーでのプロセスの表示




					代替 JMX サーバーのプロセスに関する情報を表示するには、以下を実行します。
				
	
							JMX Navigator ビューに JMX サーバーを 「JMX サーバーの追加」 します。
						
	
							JMX Navigator ビューで、エントリーの横にある 
							[image: expansion arrow]
							 アイコンを使用してサーバーのエントリーを展開します。JVM で実行されている JMX サーバーのコンポーネント一覧が表示されます。
						




JMX サーバーの追加



概要




					JMX Navigator ビューで、ツリーの Local Processes ブランチのにローカル JMX サーバーの一覧が表示されます。他のマシンにデプロイされたコンポーネントを表示する場合は、特定の JMX サーバーに接続する必要がある場合があります。
				

					JMX サーバーを追加するには、追加するサーバーの JMX URL を知っている必要があります。
				

手順




					JMX サーバーを JMX Navigator ビューに追加するには、以下を行います。
				
	
							JMX Navigator ビューで、New Connection [image: new server wiz]
							 をクリックします。
						
	
							Create a new JMX connection ウィザードで Default JMX Connection を選択します。
						
	
							Next をクリックします。
						
	
							Advanced タブを選択します。
						
	
							Name フィールドに、JMX サーバーの名前を入力します。
						

							名前には任意の文字列を指定できます。これは、JMX Navigator ツリーのエントリーにラベルを付けるために使用されます。
						

	
							JMX URL フィールドに、サーバーの JMX URL を入力します。
						
	
							JMX サーバーに認証が必要な場合は、Username フィールドおよび Password フィールドにユーザー名とパスワードを入力します。
						
	
							Finish をクリックします。
						

							新しい JMX サーバーが、User-Defined Connections ツリーにブランチとして表示されます。
						






第21章 コンポーネントの JMX 統計情報の表示



概要




				このツールは、Fuse コンポーネントによって報告されるすべての JMX 統計情報を収集し、Properties ビューに表示します。この統計情報により、インテグレーションアプリケーションで何が起こっているかについて重要な洞察を得ることができます。
			

				JMX 統計情報は、Properties、Processor、Profile の 3 つのカテゴリーに分類されます。
			

手順




				Fuse コンポーネントの統計情報を表示するには、以下を行います。
			
	
						JMX Navigator ビューで、コンポーネントのノードを見つけます。
					

						下位コンポーネントを見つけるには、ツリー上でノードを展開する必要がある場合があります。
					

	
						統計情報を確認する Fuse コンポーネントのノードを選択します。
					
	
						Properties ビューを開きます。
					
	
						Properties ページには、選択したコンポーネントの JMX プロパティーが表示されます。
					
[image: JMXchoiceNodeProps]


	
						Processors をクリックし、選択したコンポーネントのエクスチェンジメトリクスを確認します。
					
[image: JMXchoiceNodeProcs]


	
						Profile をクリックして、選択したノードとそのサブノードのメッセージメトリクスを確認します。
					
[image: JMXchoiceNodeProfile]






第22章 メッセージの参照



概要




				分散環境でアプリケーションをデバッグする際の重要なツールは、アプリケーションの JMS 宛先およびルートエンドポイントに格納されているすべてのメッセージを確認します。ツールは以下を参照できます。
			
	
						JMS 宛先
					
	
						JMS ルーティングエンドポイント
					
	
						Apache Camel ルーティングエンドポイント
					
	
						SEDA ルーティングエンドポイント
					
	
						ルーティングエンドポイントの参照
					
	
						Mock ルーティングエンドポイント
					
	
						仮想マシンルーティングエンドポイント
					
	
						DataSet ルーティングエンドポイント
					



手順




				メッセージを参照するには、以下を行います。
			
	
						JMX Navigator ビューで、参照する JMS 宛先またはエンドポイントを選択します。
					

						メッセージの一覧は Messages View に表示されます。
					

	
						Messages View で、検査する個別のメッセージを選択します。
					
[image: browseMsgView]


						メッセージの詳細とコンテンツが Properties ビューに表示されます。
					
[image: browseMsgPropertiesV]





関連トピック



	
						「ルーティングコンテキストを介したメッセージのトレース」
					




第23章 ルートのトレース




				ルートをデバッグするには、以下の 2 つの問題のいずれかを解決する必要がある場合があります。
			
	
						メッセージが適切に変換されない。
					
	
						メッセージが宛先エンドポイントに到達しない。
					



				ルートを介して 1 つ以上のテストメッセージをトレースすることは、このような問題の原因を見つける最も簡単な方法です。
			

				ツールのルートトレース機能を使用すると、メッセージがルートを通過するパスを監視し、メッセージがプロセッサーからプロセッサーに渡されるときにどのように変換されるかを確認できます。
			

				Diagram View はルートをグラフィカル表示します。これにより、メッセージが通過するパスを表示できます。ルート内の各プロセッサーでは、ルートの起動後に処理されたすべてのメッセージの平均処理時間 (ミリ秒単位) と、ルートの起動後に処理されたメッセージ数も表示されます。
			

				Messages View には、JMX Navigator ツリーで選択した JMS 宛先またはルートエンドポイントによって処理されたメッセージが表示されます。Messages View で個別のメッセージトレースを選択すると、Properties ビューにメッセージの詳細な情報とコンテンツが表示され、Diagram View で関連ノードが強調表示されます。
			

				ルートを使用したメッセージのトレースには、以下のステップが含まれます。
			
	
						「ルートトレース用テストメッセージの作成」
					
	
						「ルートトレースの有効化」
					
	
						「ルーティングコンテキストを介したメッセージのトレース」
					
	
						「ルートトレースの無効化」
					


ルートトレース用テストメッセージの作成



概要




					ルートトレースは、あらゆる種類のメッセージ構造で機能します。Fuse Message ウィザードは空の .xml メッセージを作成し、任意のメッセージ構造を設定することができます。
				
注記

						テストメッセージを保存するフォルダーが存在しない場合は、メッセージを作成する前に作成する必要があります。
					


テストメッセージを格納する新規フォルダーの作成




					新規フォルダーを作成するには、以下を実行します。
				
	
							Project Explorer ビューで、プロジェクトルートを右クリックしてコンテキストメニューを開きます。
						
	
							New → Folder を選択して New Folder ウィザードを開きます。
						

							プロジェクトルートが Enter or select the parent folder に表示されます。
						

	
							プロジェクト階層のグラフィカル表示でノードを展開し、親フォルダーとして使用するノードを選択します。
						
	
							Folder name フィールドに新規フォルダーの名前を入力します。
						
	
							Finish をクリックします。
						

							新規フォルダーが Project Explorer ビューの選択した親フォルダーの下に表示されます。
						
注記

								新規フォルダーが表示されない場合は、親 foler を右クリックし、Refresh を選択します。
							





テストメッセージの作成




					テストメッセージを作成するには、以下を実行します。
				
	
							Project Explorer ビューで、プロジェクトを右クリックしてコンテキストメニューを開きます。
						
	
							New → Fuse Message を選択して New File ウィザードを開きます。
						
	
							プロジェクト階層のグラフィカル表示でノードを展開し、新しいテストメッセージを保存するフォルダーを選択します。
						
	
							File name フィールドにメッセージの名前を入力するか、デフォルト (message.xml) を受け入れます。
						
	
							Finish をクリックします。
						

							XML エディターで新しいメッセージが表示されます。
						

	
							メッセージの内容 (ボディーとヘッダーテキストの両方) を入力します。
						
注記

								入力したヘッダーテキストによっては、No grammar constraints (DTD or XML Schema) referenced in the document という警告が表示される場合があります。この警告は無視しても問題ありません。
							





関連トピック



	
							「ルーティングコンテキストを介したメッセージのトレース」
						




ルートトレースの有効化



概要




					ルーティングコンテキストでメッセージをトレースする前に、ルーティングコンテキストのルートトレースを有効にする必要があります。
				

手順




					ルーティングコンテキストでトレースを有効にするには、以下を実行します。
				
	
							JMX Navigator ビューで、トレースを開始する実行中のルーティングコンテキストを選択します。
						
注記

								コンテキストで任意のルートを選択し、コンテキスト全体でトレースを開始できます。
							


	
							選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Start Tracing を選択してトレースを開始します。
						

							コンテキストメニューで Stop Tracing Context が有効になっている場合、トレースはすでにアクティブです。
						




関連トピック



	
							「ルーティングコンテキストを介したメッセージのトレース」
						
	
							「ルートトレースの無効化」
						




ルーティングコンテキストを介したメッセージのトレース



概要




					ルーティングコンテキストで何が起こるかを確認する最善の方法は、停止ごとにメッセージに対して何が起こるかを監視することです。このツールは、実行中のルーティングコンテキストにメッセージをドロップし、メッセージが通過するパスを追跡するメカニズムを提供します。
				

手順




					ルーティングコンテキストを介してメッセージをトレースするには、以下を実行します。
				
	
							「ルートトレース用テストメッセージの作成」 の説明に従って、テストメッセージを 1 つ以上作成します。
						
	
							Project Explorer ビューで、プロジェクトの Camel コンテキストファイルを右クリックしてコンテキストメニューを開き、Run As → Local Camel Context (Tests なし) を選択します。
						
注記

								プロジェクトの包括的な JUnit テストを作成していない場合は、これを Local Camel Context として実行しないでください。
							


	
							「ルートトレースの有効化」 の説明に従って、実行中のルーティングコンテキストのトレースを有効にします。
						
	
							Project Explorer ビューから、テストメッセージの 1 つを JMX Navigator ビューのルーティングコンテキスト開始点にドラッグします。
						
	
							JMX Navigator ビューで、トレース対象のルーティングコンテキストを選択します。
						

							ツールは、Messages View に、トレースされたコンテキストの各段階でメッセージを表すメッセージインスタンスを設定します。
						

							Diagram View には、選択したルーティングコンテキストがグラフィカル表示されます。
						

	
							Messages View で、メッセージインスタンスの 1 つを選択します。
						

							Properties ビューには、メッセージインスタンスの詳細と内容が表示されます。
						

							Diagram View では、選択したメッセージインスタンスに対応するルートステップが強調表示されます。ルートステップが処理ステップである場合、ツールは既存のパスにタイミングと処理のメトリクスをタグ付けします。
						

	
							必要に応じて、この手順を繰り返します。
						



関連トピック



	
							「ルートトレース用テストメッセージの作成」
						
	
							「ルートトレースの有効化」
						
	
							「ルートトレースの無効化」
						




ルートトレースの無効化



概要




					ルーティングコンテキストでルートのデバッグが完了したら、トレースを無効にする必要があります。
				
重要

						トレースを無効にすると、トレースが停止し、ルーティングコンテキスト内のすべてのルートのトレースデータがフラッシュされます。つまり、過去のトレースセッションは確認できなくなります。
					


手順




					ルーティングコンテキストのトレースを停止するには、以下を実行します。
				
	
							JMX Navigator ビューで、トレースを無効にする実行中のルーティングコンテキストを選択します。
						
注記

								コンテキストで任意のルートを選択し、コンテキストのトレースを停止できます。
							


	
							選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Stop Tracing Context を選択します。
						

							Start Tracing がコンテキストメニューに表示される場合、そのルーティングコンテキストに対するトレースは有効になっていません。
						




関連トピック



	
							「ルートトレースの有効化」
						
	
							「ルーティングコンテキストを介したメッセージのトレース」
						





第24章 JMS 宛先の管理




				JMX Navigator ビューを使用すると、Red Hat Fuse の実行中のインスタンスで JMS 宛先を追加または削除できます。
			
重要

					これらの変更は、ブローカーの再起動後は維持されません。
				

JMS 宛先の追加



概要




					新しいシナリオをテストする場合は、新しい JMS 宛先をブローカーの 1 つに追加すると便利です。
				

手順




					JMS 宛先をブローカーに追加するには、以下を実行します。
				
	
							JMX Navigator ビューの宛先を追加するブローカーノードで、Queues の子または Topics の子を選択します。
						
	
							選択したノードを右クリックしてコンテキストメニューを開き、Create Queue または Create Topic のいずれかを選択します。
						
	
							Create Queue または Create Topic のダイアログボックスで、新しい宛先の名前を入力します。
						
	
							OK をクリックします。
						
	
							Queues または Topics の子を右クリックし、Refresh を選択します。
						

							Queues または Topics 子のの下にある JMX Navigator ビューに新しい宛先が表示されます。
						




関連トピック



	
							「JMS 宛先の削除」
						




JMS 宛先の削除



概要




					フェイルオーバーのシナリオ、または障害処理に関連するその他のシナリオをテストする場合は、JMS 宛先を簡単に削除できると便利です。
				

手順




					JMS 宛先を削除するには、以下を実行します。
				
	
							JMX Navigator ビューの Queues または Topics の子で、削除する JMS 宛先を選択します。
						
	
							選択した宛先を右クリックしてコンテキストメニューを開き、Delete Queue/Topic を選択します。
						



関連トピック



	
							「JMS 宛先の追加」
						





第25章 ルーティングエンドポイントの管理




				JMX Navigator ビューを使用すると、ルーティングエンドポイントを追加または削除できます。
			
重要

					これらの変更は、ルーティングコンテキストの再起動後は維持されません。
				

ルーティングエンドポイントの追加



概要




					新しいシナリオをテストする場合には、新しいエンドポイントをルーティングコンテキストに追加することをお勧めします。
				

手順




					エンドポイントをルーティングコンテキストに追加するには、以下を実行します。
				
	
							JMX Navigator ビューのルーティングコンテキストノードで、エンドポイントを追加する Endpoints の子を選択します。
						
	
							選択したノードを右クリックしてコンテキストメニューを開き、Create Endpoint を選択します。
						
	
							Create Endpoint ダイアログで、新しいエンドポイントを定義する URL を入力します (例: file://target/messages/validOrders)。
						
	
							OK をクリックします。
						
	
							ルーティングコンテキストノードを右クリックし、Refresh を選択します。
						

							新しい宛先は、Endpoints ノードの JMX Navigator ビューで、エンドポイントのタイプに対応するフォルダーに表示されます (例: file)。
						




関連トピック



	
							「ルーティングエンドポイントの削除」
						




ルーティングエンドポイントの削除



概要




					フェイルオーバーのシナリオ、または障害処理に関連するその他のシナリオをテストする場合は、ルーティングコンテキストからエンドポイントを削除できると便利です。
				

手順




					ルーティングエンドポイントを削除するには、以下を実行します。
				
	
							JMX Navigator ビューで、削除するエンドポイントを選択します。
						
	
							選択したエンドポイントを右クリックしてコンテキストメニューを開き、Delete Endpoint を選択します。
						

							ツールがエンドポイントを削除します。
						

	
							削除したエンドポイントをビューから削除するには、Endpoints ノードを右クリックし、Refresh を選択します。
						

							エンドポイントは JMX Navigator ビューから消えます。
						
注記

								プロジェクトを再実行することなくエンドポイントのノードを Project Explorer ビューから削除するには、ノードを右クリックして Delete を選択し、明示的に削除する必要があります。ビューから削除するには、プロジェクト表示を更新します。
							





関連トピック



	
							「ルーティングエンドポイントの追加」
						





第26章 実行中のルートの編集



概要




				プロジェクトのルーティングコンテキストを変更せずに、実行中のルートへの変更を試すことができます。
			

				これを行うには、以下を行います。
			
	
						JMX Navigator ビューで、実行中のルーティングコンテキストの Edit Routes オプションを有効にします。
					

						これにより、ルートエディターでその in-memory モデル (Remote CamelContext:<camelContextId>) が開きます。
					

	
						ルートエディターで、ルーティングコンテキストの in-memory モデルを変更します。同時に、Camel デバッガーとそのすべての機能を使用するために、関連するノードにブレークポイントを設定できます。
					

						in-memory インメモリーモデルを編集して、ノードの追加、削除、または再配置、既存ノードのプロパティーの追加または削除、既存ノードに設定されているプロパティー値の変更を行えます。実行中のコンテキストを更新して Debug パースペクティブに結果を表示するには、in-memory モデルに加えた変更を保存する必要があります。
					

	
						JMX Navigator ビューで、実行中のルーティングコンテキストにメッセージをドロップするか、タイマー、ActiveMQ、ファイル、またはその他の継続的な入力ノードからメッセージが到着するのを待ちます。
					
	
						Debug パースペクティブでは、結果を評価し、Camel デバッガーを使用してルーティングコンテキストの詳細を把握します。
					



実行中のルートの変更および結果の評価



	
						JMX Navigator ビューで、編集するルートが含まれるルーティングコンテキストを選択します。
					
	
						選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Edit Routes を選択します。
					

						ルートエディターがルーティングコンテキストの in-memory モデル (Remote CamelContext:<contextId>) を開き、コンテキスト内のすべてのルートを表示します。以下はその例です。
					
[image: CanvasPalette]

注記

							<contextId> は、プロジェクトのルーティングコンテキストの xml ファイルの camelContext 要素の ID です。Fuse → Content Based Router のビルトインテンプレートをベースとするこの例では、ID は cbr-example-context です。
						


	
						2章ルートエディターを使用したルーティングコンテキストの編集 の説明に従ってルートを編集し、File → Save を選択して in-memory モデルに加えた変更を保存し、実行中のルーティングコンテキストを更新します。
					
	
						14章ブレークポイントの設定 の説明に従って、関連するノードにブレークポイントを設定します。
					
	
						JMX Navigator ビューで、実行中のルーティングコンテキストの入力ノードにメッセージをドロップします。
					

						プロジェクトにテストメッセージが含まれていない場合は、「ルートトレース用テストメッセージの作成」 の説明に従って作成できます。
					

	
						Yes をクリックし、Debug パースペクティブに切り替えます。
					
	
						Camel デバッガーで、通常どおり (15章Camel デバッガーの実行 を参照) ブレークポイントを介してメッセージをステップし、変更によって生成される結果を確認します。
					

						Camel デバッガーは、Edit Routes モードでも通常のデバッグモードと同じように動作するため、メッセージがルーティングコンテキストを通過している間、Camel デバッガーの任意の機能を使用できます。
					
注記

							メッセージがルーティングコンテキストの最後に到達すると、デバッガーが停止します。デバッグを続行するには、Fuse Integration パースペクティブに戻し、JMX Navigator ビューの入力ノードに別のメッセージをドロップします。そうするたびに、ツールは Debug パースペクティブへの切り替えを確認するように要求します。
						

注記

							ルート編集セッション中に、実行中のルーティングコンテキストへの接続が失われる可能性があります。この場合は、JMX Navigator ビューに次のように表示されます: Local Processes → maven[xxxx][Disconnected]。セッションを続行するには、実行中のルーティングコンテキストに再接続し、JMX Navigator ビューでこれを選択してから Edit Routes を再度選択する必要があります。
						





ルート編集セッションの終了



	
						Debug パースペクティブの Debug ビューで、Remote Camel Debug - camelContext--<contextId>--xxxxxxxxxxxxxxxxxx.xml [Remote Camel Context] スレッドを選択し、メニューバーの 
						[image: Terminate button]
						 をクリックしてデバッグセッションを終了します。
					
	
						コンソール ビューのメニューバーで 
						[image: Terminate button]
						 をクリックし、ルーティングコンテキストを終了します。
					
	
						コンソール出力をクリアする場合は、Console ビューのメニューバーの 
						[image: clear co]
						 をクリックします。
					
	
						Fuse Integration パースペクティブに切り替え、ルートエディターで Remote CamelContext:<contextId> タブの 
						[image: close]
						 をクリックし、ルーティングコンテキストファイルのメモリー内モデルを閉じます。
					



関連トピック



	
						2章ルートエディターを使用したルーティングコンテキストの編集
					
	
						パートII「ルーティングコンテキストのデバッグ」
					




第27章 ルーティングコンテキストの管理




				JMX Navigator ビューを使用すると、実行中のルーティングコンテキストを一時停止および再開できます。
			
ルーティングコンテキストの一時停止操作



概要




					このツールを使用すると、JMX Navigator ビューでルーティングコンテキストの操作を一時停止できます。コンテキスト操作を一時停止すると、コンテキストのすべてのルートが正常にシャットダウンされますが、操作を再開できるようにメモリーにロードされた状態を維持します。
				

手順




					ルーティングコンテキストの操作を一時停止するには、以下を実行します。
				
	
							JMX Navigator ビューで、プロジェクトの Camel Contexts ノードを展開し、一時停止する操作のルーティングコンテキストを選択します。
						
	
							選択したルーティングコンテキストを右クリックしてコンテキストメニューを開き、Suspend Camel Context を選択します。
						
注記

								コンテキストメニューに Resume Camel Context が表示される場合、コンテキストの操作はすでに一時停止されています。
							





関連トピック



	
							「ルーティングコンテキストの再開操作」
						




ルーティングコンテキストの再開操作



概要




					ツールを使用すると、JMX Navigator ビューで一時停止されたルーティングコンテキストの操作を再開できます。コンテキストの操作を再開すると、コンテキスト内のすべてのルートが再開され、メッセージを処理できるようになります。
				

手順




					ルーティングコンテキストの操作を再開するには、以下を実行します。
				
	
							JMX Navigator ビューで、プロジェクトの Camel Contexts ノードを展開し、操作を再開するルーティングコンテキストを選択します。
						
	
							選択したコンテキストを右クリックしてコンテキストメニューを開き、Resume Camel Context を選択します。
						
注記

								コンテキストメニューに Suspend Camel Context が表示される場合、コンテキストとそのルートは実行されています。
							





関連トピック



	
							「ルーティングコンテキストの一時停止操作」
						





パート IV. コンテナーへのアプリケーションの公開





				Fuse Integration プロジェクトをサーバーコンテナーに公開するには、最初にサーバーとそのランタイム定義をツールの Server リストに追加する必要があります。その後、プロジェクトをサーバーランタイムに割り当て、その公開オプションを設定できます。
			


第28章 サーバーの管理




				Servers ビューを使用すると、Red Hat CodeReady Studio 環境でサーバーを実行および管理できます。
			
注記

					Camel プロジェクトを Red Hat Fuse に公開するための詳細な手順については、29章Fuse Integration プロジェクトのサーバーへの公開 を参照してください。
				

サーバーの追加



概要




					ツールを使用してサーバーを管理するには、サーバーを Servers リストに追加する必要があります。追加すると、サーバーは Servers ビューに表示されます。ここから、サーバーに接続して Fuse Integration プロジェクトを公開できます。
				
注記

						Red Hat Fuse サーバーを追加する場合は、その installDir/etc/users.properties ファイルを編集し、user=password,role の形式でユーザー情報を追加して、ツールがサーバーへの SSH 接続を確立できるようにすることが推奨されます。
					


手順




					新しいサーバーを Servers ビューに追加する方法は 3 つあります。
				
	
							Servers ビューで No servers are available. Click this link to create a new server…​をクリックします。
						
注記

								このリンクは、サーバーが定義されていない場合にのみ Servers ビューに表示されます。プロジェクトを最初に作成したときにサーバーを定義して追加した場合は、Servers ビューにそのサーバーが表示されます。
							


	
							Servers ビューで右クリックしてコンテキストメニューを開き、New → Server の順に選択します。
						
	
							メニューバーで File → New → Other → Server → Server の順に選択します。
						



					Define a New Server ダイアログボックスで、新しいサーバーを追加します。
				
	
							Red Hat JBoss Middleware ノードを展開して、使用可能なサーバーオプション一覧を公開します。
						
[image: サーバーの一覧]


	
							追加するサーバーをクリックします。
						
	
							Server's host name フィールドで、デフォルト (localhost) を受け入れます。
						
注記

								localhost のアドレスは 0.0.0.0 です。
							


	
							Server name フィールドで、デフォルトを使用するか、ランタイムサーバーの別の名前を入力します。
						
	
							Server runtime environment で、デフォルトを使用するか、Add をクリックしてサーバーのランタイム定義ページを開きます。
						
[image: サーバーの追加]

注記

								サーバーがマシンにインストールされていない場合は、Download and install runtime をクリックしサイトのダウンロード手順に従って、ここでサーバーをインストールできます。サイトによっては、ダウンロードプロセスを続行する前に、有効なクレデンシャルの提供が必要なこともあります。
							


	
							インストール Name のデフォルトを使用します。
						
	
							Home Directory フィールドに、サーバーランタイムがインストールされているパスを入力するか、Browse をクリックして検索し、選択します。
						
	
							Execution Environment の横にあるドロップダウンメニューからランタイム JRE を選択します。
						

							一覧に目的のバージョンが表示されない場合は、Environments をクリックして、表示される一覧からバージョンを選択します。選択した JRE バージョンがマシンにインストールされている必要があります。
						
注記

								必要な Java バージョンについては、Red Hat Fuse Supported Configurations を参照してください。
							


	
							Alternate JRE オプションはそのままにしておきます。
						
	
							Next をクリックしてサーバーのランタイム定義を保存し、その Configuration details ページを開きます。
						
[image: UGJBFserverConfigDetails]


	
							SSH Port のデフォルト (8101) を受け入れます。
						

							ランタイムは SSH ポートを使用して、サーバーの Karaf シェルに接続します。このデフォルトがご自分のセットアップに対して正しくない場合は、サーバーの installDir/etc/org.apache.karaf.shell.cfg ファイルを確認して正しいポート番号を検出できます。
						

	
							User Name フィールドに、サーバーへのログインに使用する名前を入力します。
						

							Red Hat Fuse では、これは Red Hat Fuse の installDir/etc/users.properties ファイルに保存されているユーザー名です。
						
注記

								/etc/users.properties ファイルのデフォルトのユーザーがアクティベートされている場合 (アンコメント)、[servCnfigDetails] に記載のとおり、ツールは User Name および Password フィールドにデフォルトユーザーの名前およびパスワードを自動入力します。
							


							ユーザーが設定されていない場合は、user=password,role のフォーマットを使用してそのファイルにユーザーを追加するか (例: joe=secret,Administrator)、karaf jaas コマンドセットを使用して設定できます。
						
	
									jaas:realms: レルムを一覧表示します。
								
	
									jaas:manage --index 1: 最初の (サーバー) レルムを編集します。
								
	
									jaas:useradd <username> <password>: ユーザーと関連するパスワードを追加します。
								
	
									jaas:roleadd <username> Administrator: 新規ユーザーのロールを指定します。
								
	
									jaas:update: 新しいユーザー情報を使用してレルムを更新します。
								



							サーバーに対して jaas レルムがすでに選択されている場合は、コマンド JBossFuse:karaf@root>jaas:users を実行してユーザー名を検出できます。
						

	
							Password フィールドには、サーバーにログインする際に User name で必要なパスワードを入力します。
						
	
							Finish をクリックしてサーバー設定の詳細を保存します。
						

							サーバーランタイムが Servers ビューに表示されます。
						

							サーバーノードを展開すると、サーバーの JMX ノードが公開されます。
						
[image: UGnewServrInstalledExpand]






サーバーの起動



概要




					設定済みサーバーを起動すると、ツールはサーバーのリモート管理コンソールを Terminal ビューで開きます。これにより、アプリケーションのテスト中にコンテナーを簡単に管理できます。
				

手順




					サーバーを起動するには、以下を実行します。
				
	
							Servers ビューで、起動するサーバーを選択します。
						
	
							[image: run button]
							 をクリックします。
						
	
									Console ビューが開き、コンテナーの起動中は待機するように求めるメッセージが表示されます。以下はその例です。
								
[image: UGservrStartConsoleV]

注記

										リモートコンソールを開くためのユーザー名とパスワードを適切に設定しなかった場合は、ダイアログボックスが開き、適切な認証情報の入力が求められます。「サーバーの追加」を参照してください。
									


	
									コンテナーが起動すると、Terminal ビューが開き、コンテナーの管理コンソールが表示されます。
								
	
									稼働中のサーバーが Servers ビューに表示されます。
								
[image: UGservrStartServrsView]


	
									稼働中のサーバーは、Server Connections の JMX Navigator ビューにも表示されます。
								
[image: UGservStartJMXNavView]

注記

										サーバーがツールと同じマシン上で稼働している場合、そのサーバーは Local Processes の下にもエントリーがあります。
									









稼働中のサーバーへの接続



概要




					設定済みのサーバーを起動すると、Servers ビューと、Server Connections ノードの JMX Navigator ビューに表示されます。サーバーを表示するには、Server Connections ノードを展開する必要がある場合があります。
				

					稼働中のサーバーで Fuse プロジェクトアプリケーションを公開およびテストするには、まず接続する必要があります。Servers ビューまたは JMX Navigator ビューのいずれかで、稼働中のサーバーに接続できます。
				
注記

						Servers ビューと JMX Navigator ビューは、サーバー接続に関して同期されます。つまり、Servers ビューのサーバーに接続すると、JMX Navigator ビューでもサーバーに接続され、その逆も同様に接続されます。
					


Servers ビューで稼働中のサーバーへの接続



	
							Servers ビューで、サーバーランタイムを展開して JMX[Disconnected] ノードを公開します。
						
	
							JMX[Disconnected] ノードをダブルクリックします。
						
[image: UGservrStartServrsView]





JMX Navigator ビューで稼働中のサーバーへの接続



	
							Server Connections ノードの JMX Navigator ビューで、接続するサーバーを選択します。
						
	
							選択したサーバーをダブルクリックします。
						
[image: UGservConnectJMXNav]





接続されたサーバーにインストールされているバンドルの表示



	
							Servers ビューまたは JMX Navigator ビューで、サーバーランタイムツリーを展開して Bundles ノードを公開し、これを選択します。
						
	
							このツールは、Properties ビューに、サーバーにインストールされているバンドルの一覧を表示します。
						
[image: UGservBundles]


							Properties ビューの Search ツールを使用し、わかっている場合は Symbolic Name または Identifier でバンドルを検索できます。記号名または識別子を入力すると一覧が更新され、現在の検索文字列に一致するバンドルのみが表示されます。
						
注記

								または、Terminal ビューで osgi:list コマンドを実行し、Red Hat Fuse サーバーランタイムにインストールされているバンドルに関する生成されたリストを表示することもできます。ツールは、osgi:list コマンドが表示する OSGi バンドルに異なる命名スキームを使用します。
							

								プロジェクトの pom.xml ファイルの <build> セクションで、バンドルのシンボリック名およびそのバンドル名 (OSGi) が maven-bundle-plugin エントリーに一覧表示されます。詳細については 「プロジェクトのサーバーへの公開を確認」 を参照してください。
							






サーバーからの接続解除



概要




					アプリケーションのテストが終了したら、サーバーを停止せずに接続を解除できます。
				
注記

						Servers ビューと JMX Navigator ビューは、サーバー接続に関して同期されます。つまり、Servers ビューのサーバーからの接続を解除すると、JMX Navigator ビューでも接続解除されます。また、その逆も同様です。
					


Servers ビューのサーバーからの接続解除



	
							Servers ビューで、サーバーランタイムを展開して JMX[Connected] ノードを公開します。
						
	
							JMX[Connected] ノードを右クリックしてコンテキストメニューを開き、Disconnect を選択します。
						
[image: 接続解除]





JMX Navigator ビューのサーバーからの接続解除



	
							JMX Navigator ビューの Server Connections で、接続を解除するサーバーを選択します。
						
	
							選択したサーバーを右クリックしてコンテキストメニューを開き、Disconnect を選択します。
						
[image: JMX の接続解除]






サーバーの停止



概要




					Servers ビュー、または Terminal ビューのサーバーのリモートコンソールで、サーバーをシャットダウンできます。
				

Servers ビューの使用




					サーバーを停止するには、以下を実行します。
				
	
							Servers ビューで、停止するサーバーを選択します。
						
	
							[image: stop button]
							 をクリックします。
						



リモートコンソールの使用




					サーバーを停止するには、以下を実行します。
				
	
							サーバーのリモートコンソールをホストしている Terminal ビューを開きます。
						
	
							Ctrl+D を押します。
						




サーバーの削除



概要




					設定済みサーバーの処理が終了した場合、またはサーバーを誤って設定した場合は、サーバーとその設定を削除できます。
				

					まず、Servers ビューまたは JMX Navigator ビューからサーバーを削除します。次に、サーバー設定を削除します。
				

サーバーの削除



	
							Servers ビューで、削除するサーバーを右クリックしてコンテキストメニューを開きます。
						
	
							Delete を選択します。
						
	
							OK をクリックします。
						



サーバーの設定の削除



	
							メニューバーで、CodeReady Studio → Preferences → Server の順に選択します。
						
注記

								Linux および Windows マシンでは、Window → Preferences の順に選択します。
							


	
							Server フォルダーを展開し、Runtime Environments を選択して Server Runtime Environments ページを開きます。
						
	
							一覧で、Servers ビューから以前に削除したサーバーのランタイム環境を選択し、Remove をクリックします。
						
	
							OK をクリックします。
						





第29章 Fuse Integration プロジェクトのサーバーへの公開




				Eclipse 公開メカニズムを使用して、Fuse Integration プロジェクトをサーバーランタイムにデプロイします。これを行うには、サーバーを Fuse Integration パースペクティブの Servers ビューに定義および追加する必要があります。詳しい手順を示すデモについては、以下を参照してください。
			
概要




				サポート対象サーバーを、割り当てられた Fuse プロジェクトを自動的に公開するか、publish コマンドを手動で呼び出した場合にのみ公開するように設定できます。
			

				Servers ビューに追加された各サーバーランタイムには、その設定、接続、および公開の詳細が含まれる独自の Overview ページがあります。
			
[image: UGservRuntimeOverviewTab]


				Publishing を展開して、サーバーランタイムの公開オプションとデフォルト設定を公開する必要がある場合があります。
			
	
						Never publish automatically  — プロジェクトを手動で公開する場合は、このオプションを選択する必要があります。
					
重要

							また、サーバーの Add and Remove ページで、If server started, publish changes immediately オプションを無効にする必要があります (詳細については 「Fuse プロジェクトの手動公開」 を参照)。
						


	
						Automatically publish when resources change  —  [default] Fuse プロジェクトへの変更を保存するときに、その Fuse プロジェクトを自動的に公開または再公開する場合は、このオプションを有効にします。プロジェクトの公開速度は、Publishing interval (デフォルトは 15 秒) によって異なります。
					
	
						Automatically publish after a build event — Fuse プロジェクトの場合、Automatically publish when resources change と同じように機能します。
					



リソース変更時に Fuse プロジェクトを自動公開




				サーバーランタイムのデフォルトの公開オプションは、Automatically publish when resources change です。
			
	
						必要に応じて、Fuse プロジェクトを公開するサーバーランタイムを起動します。詳細は、「サーバーの起動」 を参照してください。
					
	
						Servers ビューで、サーバーランタイムをダブルクリックして Overview ページを開きます。
					
	
						Publishing を展開し、Automatically publish when resources change を選択します。
					
	
						公開サイクルの間隔を増減するには、必要に応じて Publishing interval (in seconds) の横にあるラジオボタンをクリックします。
					
	
						Servers ビューでサーバーランタイムを右クリックし、コンテキストメニューを開き、Add and Remove を選択します。
					
[image: UGservAddRemove1]


						公開に使用できるすべてのリソースが Available 列に表示されます。
					

	
						リソース (この場合は CBRroute Fuse プロジェクト) をサーバーランタイムに割り当てるには、以下を実施します。
					
	
								ダブルクリックします。または
							
	
								これを選択して Add をクリックします。
							

								選択したリソースは Configured 列に移動します。
							
[image: UGservAddRemove2]


								この段階で、割り当てられたリソースが実際に公開される時間は、サーバーランタイムが実行されているかどうか、および Publishing interval の設定によって異なります。ただし、サーバーが停止している場合は、サーバー起動後にプロジェクトを手動で公開する必要があります (詳細については、「Fuse プロジェクトの手動公開」 を参照してください)。
							




	
						If server started, publish changes immediately オプションをクリックして有効にします。
					
[image: UGservAddRemove3]


						このオプションを使用すると、Finish をクリックすることで設定したプロジェクトが即座に公開されます。サーバーランタイムの Overview 要 ページの Automatically publish when resources change オプションを使用すると、ローカルプロジェクトに加えられた変更が保存されるたびに設定済みのプロジェクトが再公開されます。
					

	
						Finish をクリックします。
					

						プロジェクトが Servers ビューのサーバーランタイムノードに表示され、サーバーランタイムのステータスが [Started,Publishing…] と報告されます。
					

						公開が完了すると、サーバーランタイムとプロジェクトのステータスは [Started,Synchronized] と報告されます。
					
[image: UGservPublishSynched]

注記

							サーバーランタイムの場合、synchronized は、サーバーのすべての公開済みリソースが、ローカルの対応する公開済みリソースと同じであることを意味します。公開済みリソースの場合、Synchronized は、ローカルの対応するリソースと同じであることを意味します。
						





Fuse プロジェクトの手動公開



	
						必要に応じて、Fuse プロジェクトを公開するサーバーランタイムを起動します。詳細は、「サーバーの起動」 を参照してください。
					
	
						Servers ビューで、サーバーランタイムをダブルクリックして Overview ページを開きます。
					
	
						Publishing を展開し、Never publish automatically を選択します。
					
	
						File → Save をクリックして、公開オプションの変更を保存します。
					
	
						Fuse プロジェクトがすでにサーバーランタイムに割り当てられている場合は、If server started, publish changes immediately のオプションが無効であることを確認します。
					
	
								Servers ビューで、サーバーランタイムを右クリックしてコンテキストメニューを開きます。
							
	
								Add and Remove… をクリックしてサーバーの Add および Remove ページを開きます。
							
	
								If server started, publish changes immediately オプションが有効になっている場合は無効にします。
							
	
								[finish] に進みます。
							



	
						Fuse プロジェクトがサーバーランタイムに割り当てられていない場合は、ここで割り当てます。
					
	
								「リソース変更時に Fuse プロジェクトを自動公開」 の [startAssignResource] から [stopAssignResource] に従います。
							
	
								If server started, publish changes immediately オプションは有効にしないでください。
							



	
						Finish をクリックします。
					

						プロジェクトが Servers ビューのサーバーランタイムノードに表示され、サーバーランタイムのステータスが [Started] と報告されます。
					
[image: UGservPublishSynched]


	
						Servers ビューで、プロジェクトのノードを右クリックします。この例では、CBRroute Fuse プロジェクトを選択してコンテキストメニューを開きます。
					
[image: UGassgnProjSrvViewCntxtMnu]


	
						Full Publish を選択します。
					

						公開操作中に、サーバーランタイムとプロジェクトのステータスは [Started,Republish] と報告されます。
					

						公開が完了すると、サーバーランタイムとプロジェクトの両方のステータスが [Started,Synchronized] と報告されます。
					
注記

							このツールは Incremental Publish オプションをサポートしません。Incremental Publish をクリックすると、完全公開になります。
						





プロジェクトのサーバーへの公開を確認




				Fuse プロジェクトをサーバーランタイムに公開した後、サーバーに接続し、プロジェクトのバンドルがインストールされていることを確認できます。
			
	
						サーバーランタイムに接続します。詳細は、「Servers ビューで稼働中のサーバーへの接続」 を参照してください。
					
	
						Servers ビューで、サーバーランタイムツリーを展開して Bundles ノードを公開し、これを選択します。
					

						このツールは、Properties ビューに、サーバーにインストールされているバンドルの一覧を表示します。
					
[image: UGsrvVerifyPublishedProj]


	
						プロジェクトのバンドルを検索するには、リストの下部までスクロールするか、Properties ビューの Search ボックスにバンドルの Symbolic Name を入力します。バンドルの Symbolic Name は、作成時にプロジェクトに付与した名前です。
					
注記

							または、Terminal ビューで osgi:list コマンドを実行し、Fuse サーバーランタイムにインストールされているバンドルに関する生成されたリストを表示することもできます。ツールは、osgi:list コマンドが表示する OSGi バンドルに異なる命名スキームを使用します。
						

							プロジェクトの pom.xml ファイルの <build> セクションで、バンドルのシンボリック名およびそのバンドル名 (OSGi) が maven-bundle-plugin エントリーに一覧表示されます。以下に例を示します。
						
[image: ugBundleNamesPomFile]







付録A Fuse Integration パースペクティブ




			Fuse Integration パースペクティブを使用して、インテグレーションアプリケーションの設計、監視、テスト、および公開を行います。
		
[image: Fuse Integration パースペクティブ]


			以下の方法で Fuse Integration パースペクティブを開くことができます。
		
	
					新しい Fuse Integration プロジェクトを作成する場合 (1章新しい Fuse Integration プロジェクトの作成 を参照)、ツールは Fuse Integration パースペクティブに切り替わります。
				
	
					CodeReady Studio ツールバーの右側にある 
					[image: integration perspective]
					 をクリックします。ツールバーで 
					[image: integration perspective]
					 アイコンが利用できない場合は、 
					[image: new persp]
					 をクリックし、利用可能なパースペクティブの一覧から Fuse Integration を選択します。
				
	
					Window → Perspective → Open Perspective → Fuse Integration の順に選択します。
				



			Fuse Integration パースペクティブは、9 つのメインエリアで設定されます。
		
	
					Project Explorer ビュー
				

					ツールが認識するすべてのプロジェクトを表示します。各プロジェクトを設定するすべてのアーティファクトを表示できます。Project Explorer ビューでは、Camel Contexts ノードにプロジェクトのすべてのルーティングコンテキストの .xml ファイルも表示されます。これにより、プロジェクトに含まれるルーティングコンテキストファイルを見つけて開くことができます。Project Explorer ビューの各ルーティングコンテキストの .xml ファイルに、コンテキスト内で定義されたすべてのルートが表示されます。マルチルートコンテキストの場合、キャンバスで特定のルートにフォーカスできます。
				
[image: ProjectExplorerFIP]


	
					ルートエディター
				

					主な設計時ツールを提供し、以下の 3 つのタブで設定されます。
				
	
							Design: ルートを構築する大きなグリッドエリアと、エンタープライズ統合パターン (EIP) および Camel コンポーネントを選択してキャンバスに接続し、ルートを形成するためのパレットが表示されます。
						
[image: CanvasPalette]


							キャンバスは、ルートエディターのワークベンチであり、多くの作業を行う場所です。接続された EIP および Camel コンポーネント (キャンバスに配置されるとノードと呼ばれます) で設定される 1 つ以上のルートがグラフィカル表示されます。
						

							キャンバスでノードを選択すると、Properties ビューに選択したノードに適用されるプロパティーが表示され、それを編集できるようになります。
						

							Palette には、ルートを構築するために必要なすべてのパターンと Camel コンポーネントが含まれており、それらは機能 (Components、Routing、Control Flow、Transformation、Miscellaneous) に基づきグループ化されます。
						

	
							ソース
						

							ルートエディターのキャンバスに構築されたルートの .xml ファイルの内容を表示します。
						

							Design タブと Source タブで、ルーティングコンテキストを編集できます。Source タブは、設定、コメント、または Bean を編集したり、ルーティングコンテキストファイルに追加したりする場合に便利です。コンテンツアシスト機能は、設定ファイルの使用に役立ちます。Source タブで Ctrl+Space を押すと、プロジェクトに挿入できる値の一覧が表示されます。
						
[image: SourceView]


	
							設定
						

							共有設定 (グローバルエンドポイント、データ形式、Bean) を簡単にマルチルートルーティングコンテキストに追加する方法を提供します。詳細は、「グローバルエンドポイント、データ形式、Bean の追加」 を参照してください。
						
[image: CnfigsVAddButton]


	
							REST
						

							Rest DSL コンポーネントのグラフィック表現を提供します。
						
[image: RESTtab]





	
					Properties ビュー
				

					キャンバスで選択したノードのプロパティーが表示されます。
				

	
					JMX Navigator ビュー
				

					JMX サーバーと監視するインフラストラクチャーの一覧が表示されます。これにより、JMX サーバーとそれらが監視しているプロセスを参照できます。また、Red Hat プロセスのインスタンスも特定できます。
				

					JMX Navigator ビューは、Fuse Integration パースペクティブのすべての監視およびテストアクティビティーを促進します。Diagram View、Properties ビュー、および Messages View に表示されるルートを決定します。ルートトレースの有効化、JMS 宛先の追加および削除、ルートの開始および一時停止を行うメニューコマンドも提供します。また、メッセージをルートにドラッグアンドドロップするためのターゲットでもあります。
				

					デフォルトでは、JMX Navigator ビューには、ローカルマシンで実行しているすべての Java プロセスが表示されます。必要に応じて JMX サーバーを追加して、他のマシンのインフラストラクチャーを表示できます。
				

	
					Diagram View
				

					JMX Navigator ビューで選択したノードを表すグラフィカルツリーが表示されます。プロセス、サーバー、エンドポイント、または他のノードを選択すると、Diagram View には、選択したノードがルートとして表示され、その子と孫に分岐します。
				

					ブローカーを選択すると、Diagram View には接続、トピック、およびキューの最大 3 つの子が表示されます。また、設定された接続と宛先が孫として表示されます。
				

					ルートを選択すると、Diagram View にルート内のすべてのノードが表示され、メッセージがルートを通過できるさまざまなパスが表示されます。また、ルートトレースが有効になっている場合、ルートの各処理ステップのタイミングメトリクスも表示されます。
				

	
					Messages View
				

					ルートトレースが有効になっている場合に、選択した JMS 宛先または Apache Camel エンドポイントを通過したメッセージが一覧表示されます。
				

					JMX Navigator ビューで JMS 宛先を選択すると、ビューにはその宛先にあるすべてのメッセージが一覧表示されます。
				

					ルートトレースを有効にすると、Messages View にはトレース開始後にルートのノードを通過したすべてのメッセージが一覧表示されます。Messages View を設定して、対象のデータのみを好みの順序で表示できます。
				

					Messages View のメッセージトレースを選択すると、その詳細 (メッセージの本文とすべてのメッセージヘッダー) が Properties ビューに表示されます。Diagram View では、選択したメッセージトレースに関連付けられたルートのステップが強調表示されます。
				

	
					Servers ビュー
				

					ツールが管理するサーバーの一覧が表示されます。ランタイムステータスが表示され、それらの追加、開始、停止、およびそれらへのプロジェクトの公開を制御できます。
				

	
					Terminal ビュー
				

					接続されているコンテナーのコマンドコンソールが表示されます。Terminal ビューでコマンドを入力してコンテナーを制御できます。
				

	
					Console ビュー
				

					最近実行したアクションのコンソール出力が表示されます。
				




付録B Debug パースペクティブ




			Debug パースペクティブを使用して、実行中の Camel コンテキストを監視し、デバッグします。
		
[image: Camel コンテキストデバッガー]

	
					Debug ビュー
				

					実行中の Camel コンテキストの場合、Debug ビューにデバッグスタックが表示されます。
				

					Camel Context at service:jmx:rmi://jndi/rmi://localhost:1099/jmxrmi/camel エントリーの下に一覧表示される同じメッセージフロー内のブレークポイントを切り替えて、Variables ビュー内の変数の値を確認して比較できます。
				

					メッセージフローは一意のブレッドクラム ID で識別され、後続の各メッセージフローのブレッドクラム ID は 2 ずつ増えます。たとえば、最初のメッセージフローのブレッドクラム ID が ID-janemurpheysmbp-home-54620-1470949590275-0-1 の場合、2 番目のメッセージフローのブレッドクラム ID は ID-janemurpheysmbp-home-54620-1470949590275-0-3 になります。
				

	
					Variables ビュー
				

					ブレークポイントが設定されているルーティングコンテキスト内の各ノードでは、ブレークポイントに到達すると Variables ビューに利用可能な変数の値が表示されます。前のブレークポイント以降に値が変更された各変数は、黄色で強調表示されます。
				

					編集可能な変数の値を変更して、このような変更が想定される結果を生成するか確認して、ルーティングコンテキストの堅牢性をテストすることができます。
				

					ウォッチリストに変数を追加することもできるため、メッセージフローの想定されるポイントでそれらの値が想定どおりに変化するかどうかをすばやく簡単に確認できます。
				

	
					Breakpoints ビュー
				

					ルーティングコンテキストに設定されたブレークポイントの一覧が、有効/無効を含めて表示されます。個々のブレークポイントを有効化または無効化するには、それらのブレークポイントのチェックをオン (有効化) またはオフ (disabling) にします。これにより、問題のある動作をするルーティングコンテキストのノードに一時的にフォーカスすることができます。
				

					[image: resume co]
					 ボタンは無効化されたブレークポイントをスキップし、ルーティングコンテキスト内の次のアクティブなブレークポイントに移動します。一方、 
					[image: stepover co]
					 ボタンは、ブレークポイントに関係なく、ルーティングコンテキスト内の次の実行ノードに移動します。
				

	
					Camel Context.xml ビュー
				

					実行中のルーティングコンテキストファイルをグラフィカルモードで表示します。ブレークポイントが設定されているノードの場合、設定されているブレークポイントのタイプと、ブレークポイントが有効か無効かが表示されます。ブレークポイントに到達すると、キャンバス上の対応するノードが赤で囲まれます。
				

					ノードの設定を確認するには、Properties ビューを開き、camel Context.xml のキャンバスのノードを選択します。
				

	
					Console ビュー
				

					Camel デバッガーがルーティングコンテキストを実行するときに生成されるログ出力を表示します。
				

	
					Properties ビュー
				

					CamelContext.xml のキャンバスで選択したノードに設定されたプロパティーを表示します。
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# Highlight.js

Highlight.js — это подсветчик синтаксиса, написанный на JavaScript. Он работает
и в браузере, и на сервере. Он работает с практически любой HTML разметкой, не
зависит от каких-либо фреймворков и умеет автоматически определять язык.


## Начало работы

Минимум, что нужно сделать для использования highlight.js на веб-странице — это
подключить библиотеку, CSS-стили и вызывать [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

Библиотека найдёт и раскрасит код внутри тегов `<pre><code>`, попытавшись
автоматически определить язык. Когда автоопределение не срабатывает, можно явно
указать язык в атрибуте class:

```html
<pre><code class="html">...</code></pre>
```

Список поддерживаемых классов языков доступен в [справочнике по классам][8].
Класс также можно предваоить префиксами `language-` или `lang-`.

Чтобы отключить подсветку для какого-то блока, используйте класс `nohighlight`:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Инициализация вручную

Чтобы иметь чуть больше контроля за инициализацией подсветки, вы можете
использовать функции [`highlightBlock`][2] и [`configure`][3]. Таким образом
можно управлять тем, *что* подсвечивать и *когда*.

Вот пример инициализация, эквивалентной вызову [`initHighlightingOnLoad`][1], но
с использованием jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

Вы можете использовать любые теги разметки вместо `<pre><code>`. Если
используете контейнер, не сохраняющий переводы строк, вам нужно сказать
highlight.js использовать для них тег `<br>`:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

Другие опции можно найти в документации функции [`configure`][3].


## Установка библиотеки

Highlight.js можно использовать в браузере прямо с CDN хостинга или скачать
индивидуальную сборку, а также установив модуль на сервере. На
[страница загрузки][4] подробно описаны все варианты.

Обратите внимание, что библиотека не предназначена для использования в виде
исходного кода на GitHub, а требует отдельной сборки. Если вам не подходит ни
один из готовых вариантов, читайте [документацию по сборке][5].


## Лицензия

Highlight.js распространяется под лицензией BSD. Подробнее читайте файл
[LICENSE][10].


## Ссылки

Официальный сайт билиотеки расположен по адресу <https://highlightjs.org/>.

Более подробная документация по API и другим темам расположена на
<http://highlightjs.readthedocs.org/>.

Авторы и контрибьютора перечислена в файле [AUTHORS.ru.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.ru.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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## Version 8.4

We've got the new [demo page][]! The obvious new feature is the new look, but
apart from that it's got smarter: by presenting languages in groups it avoids
running 10000 highlighting attempts after first load which was slowing it down
and giving bad overall impression. It is now also being generated from test
code snippets so the authors of new languages don't have to update both tests
and the demo page with the same thing.

Other notable changes:

- The `template_comment` class is gone in favor of the more general `comment`.
- Number parsing unified and improved across languages.
- C++, Java and C# now use unified grammar to highlight titles in
  function/method definitions.
- The browser build is now usable as an AMD module, there's no separate build
  target for that anymore.
- OCaml has got a [comprehensive overhaul][ocaml] by [Mickaël Delahaye][].
- Clojure's data structures and literals are now highlighted outside of lists
  and we can now highlight Clojure's REPL sessions.

New languages:

- *AspectJ* by [Hakan Özler][]
- *STEP Part 21* by [Adam Joseph Cook][]
- *SML* derived by [Edwin Dalorzo][] from OCaml definition
- *Mercury* by [mucaho][]
- *Smali* by [Dennis Titze][]
- *Verilog* by [Jon Evans][]
- *Stata* by [Brian Quistorff][]

[Hakan Özler]: https://github.com/ozlerhakan
[Adam Joseph Cook]: https://github.com/adamjcook
[demo page]: https://highlightjs.org/static/demo/
[Ivan Sagalaev]: https://github.com/isagalaev
[Edwin Dalorzo]: https://github.com/edalorzo
[mucaho]: https://github.com/mucaho
[Dennis Titze]: https://github.com/titze
[Jon Evans]: https://github.com/craftyjon
[Brian Quistorff]: https://github.com/bquistorff
[ocaml]: https://github.com/isagalaev/highlight.js/pull/608#issue-46190207
[Mickaël Delahaye]: https://github.com/polazarus


## Version 8.3

We streamlined our tool chain, it is now based entirely on node.js instead of
being a mix of node.js, Python and Java. The build script options and arguments
remained the same, and we've noted all the changes in the [documentation][b].
Apart from reducing complexity, the new build script is also faster from not
having to start Java machine repeatedly. The credits for the work go to [Jeremy
Hull][].

Some notable fixes:

- PHP and JavaScript mixed in HTML now live happily with each other.
- JavaScript regexes now understand ES6 flags "u" and "y".
- `throw` keyword is no longer detected as a method name in Java.
- Fixed parsing of numbers and symbols in Clojure thanks to [input from Ivan
  Kleshnin][ik].

New languages in this release:

- *Less* by [Max Mikhailov][]
- *Stylus* by [Bryant Williams][]
- *Tcl* by [Radek Liska][]
- *Puppet* by [Jose Molina Colmenero][]
- *Processing* by [Erik Paluka][]
- *Twig* templates by [Luke Holder][]
- *PowerShell* by [David Mohundro][], based on [the work of Nicholas
  Blumhardt][ps]
- *XL* by [Christophe de Dinechin][]
- *LiveScript* by [Taneli Vatanen][] and [Jen Evers-Corvina][]
- *ERB* (Ruby in HTML) by [Lucas Mazza][]
- *Roboconf* by [Vincent Zurczak][]

[b]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[Jeremy Hull]: https://github.com/sourrust
[ik]: https://twitter.com/IvanKleshnin/status/514041599484231680
[Max Mikhailov]: https://github.com/seven-phases-max
[Bryant Williams]: https://github.com/scien
[Radek Liska]: https://github.com/Nindaleth
[Jose Molina Colmenero]: https://github.com/Moliholy
[Erik Paluka]: https://github.com/paluka
[Luke Holder]: https://github.com/lukeholder
[David Mohundro]: https://github.com/drmohundro
[ps]: https://github.com/OctopusDeploy/Library/blob/master/app/shared/presentation/highlighting/powershell.js
[Christophe de Dinechin]: https://github.com/c3d
[Taneli Vatanen]: https://github.com/Daiz-
[Jen Evers-Corvina]: https://github.com/sevvie
[Lucas Mazza]: https://github.com/lucasmazza
[Vincent Zurczak]: https://github.com/vincent-zurczak

## Version 8.2

We've finally got [real tests][test] and [continuous testing on Travis][ci]
thanks to [Jeremy Hull][] and [Chris Eidhof][]. The tests designed to cover
everything: language detection, correct parsing of individual language features
and various special cases. This is a very important change that gives us
confidence in extending language definitions and refactoring library core.

We're going to redesign the old [demo/test suite][demo] into an interactive
demo web app. If you're confident front-end developer or designer and want to
help us with it, drop a comment into [the issue][#542] on GitHub.

[test]: https://github.com/isagalaev/highlight.js/tree/master/test
[demo]: https://highlightjs.org/static/test.html
[#542]: https://github.com/isagalaev/highlight.js/issues/542
[ci]: https://travis-ci.org/isagalaev/highlight.js
[Jeremy Hull]: https://github.com/sourrust
[Chris Eidhof]: https://github.com/chriseidhof

As usually there's a handful of new languages in this release:

- *Groovy* by [Guillaume Laforge][]
- *Dart* by [Maxim Dikun][]
- *Dust* by [Michael Allen][]
- *Scheme* by [JP Verkamp][]
- *G-Code* by [Adam Joseph Cook][]
- *Q* from Kx Systems by [Sergey Vidyuk][]

[Guillaume Laforge]: https://github.com/glaforge
[Maxim Dikun]: https://github.com/dikmax
[Michael Allen]: https://github.com/bfui
[JP Verkamp]: https://github.com/jpverkamp
[Adam Joseph Cook]: https://github.com/adamjcook
[Sergey Vidyuk]: https://github.com/sv

Other improvements:

- [Erik Osheim][] heavily reworked Scala definitions making it richer.
- [Lucas Mazza][] fixed Ruby hashes highlighting
- Lisp variants (Lisp, Clojure and Scheme) are unified in regard to naming
  the first symbol in parentheses: it's "keyword" in general case and also
  "built_in" for built-in functions in Clojure and Scheme.

[Erik Osheim]: https://github.com/non
[Lucas Mazza]: https://github.com/lucasmazza

## Version 8.1

New languages:

- *Gherkin* by [Sam Pikesley][]
- *Elixir* by [Josh Adams][]
- *NSIS* by [Jan T. Sott][]
- *VIM script* by [Jun Yang][]
- *Protocol Buffers* by [Dan Tao][]
- *Nix* by [Domen Kožar][]
- *x86asm* by [innocenat][]
- *Cap’n Proto* and *Thrift* by [Oleg Efimov][]
- *Monkey* by [Arthur Bikmullin][]
- *TypeScript* by [Panu Horsmalahti][]
- *Nimrod* by [Flaviu Tamas][]
- *Gradle* by [Damian Mee][]
- *Haxe* by [Christopher Kaster][]
- *Swift* by [Chris Eidhof][] and [Nate Cook][]

New styles:

- *Kimbie*, light and dark variants by [Jan T. Sott][]
- *Color brewer* by [Fabrício Tavares de Oliveira][]
- *Codepen.io embed* by [Justin Perry][]
- *Hybrid* by [Nic West][]

[Sam Pikesley]: https://github.com/pikesley
[Sindre Sorhus]: https://github.com/sindresorhus
[Josh Adams]: https://github.com/knewter
[Jan T. Sott]: https://github.com/idleberg
[Jun Yang]: https://github.com/harttle
[Dan Tao]: https://github.com/dtao
[Domen Kožar]: https://github.com/iElectric
[innocenat]: https://github.com/innocenat
[Oleg Efimov]: https://github.com/Sannis
[Arthur Bikmullin]: https://github.com/devolonter
[Panu Horsmalahti]: https://github.com/panuhorsmalahti
[Flaviu Tamas]: https://github.com/flaviut
[Damian Mee]: https://github.com/chester1000
[Christopher Kaster]: http://christopher.kaster.ws
[Fabrício Tavares de Oliveira]: https://github.com/fabriciotav
[Justin Perry]: https://github.com/ourmaninamsterdam
[Nic West]: https://github.com/nicwest
[Chris Eidhof]: https://github.com/chriseidhof
[Nate Cook]: https://github.com/natecook1000

Other improvements:

- The README is heavily reworked and brought up to date by [Jeremy Hull][].
- Added [`listLanguages()`][ll] method in the API.
- Improved C/C++/C# detection.
- Added a bunch of new language aliases, documented the existing ones. Thanks to
  [Sindre Sorhus][] for background research.
- Added phrasal English words to boost relevance in comments.
- Many improvements to SQL definition made by [Heiko August][],
  [Nikolay Lisienko][] and [Travis Odom][].
- The shorter `lang-` prefix for language names in HTML classes supported
  alongside `language-`. Thanks to [Jeff Escalante][].
- Ruby's got support for interactive console sessions. Thanks to
  [Pascal Hurni][].
- Added built-in functions for R language. Thanks to [Artem A. Klevtsov][].
- Rust's got definition for lifetime parameters and improved string syntax.
  Thanks to [Roman Shmatov][].
- Various improvements to Objective-C definition by [Matt Diephouse][].
- Fixed highlighting of generics in Java.

[ll]: http://highlightjs.readthedocs.org/en/latest/api.html#listlanguages
[Sindre Sorhus]: https://github.com/sindresorhus
[Heiko August]: https://github.com/auge8472
[Nikolay Lisienko]: https://github.com/neor-ru
[Travis Odom]: https://github.com/Burstaholic
[Jeff Escalante]: https://github.com/jenius
[Pascal Hurni]: https://github.com/phurni
[Jiyin Yiyong]: https://github.com/jiyinyiyong
[Artem A. Klevtsov]: https://github.com/unikum
[Roman Shmatov]: https://github.com/shmatov
[Jeremy Hull]: https://github.com/sourrust
[Matt Diephouse]: https://github.com/mdiep


## Version 8.0

This new major release is quite a big overhaul bringing both new features and
some backwards incompatible changes. However, chances are that the majority of
users won't be affected by the latter: the basic scenario described in the
README is left intact.

Here's what did change in an incompatible way:

- We're now prefixing all classes located in [CSS classes reference][cr] with
  `hljs-`, by default, because some class names would collide with other
  people's stylesheets. If you were using an older version, you might still want
  the previous behavior, but still want to upgrade. To suppress this new
  behavior, you would initialize like so:

  ```html
  <script type="text/javascript">
    hljs.configure({classPrefix: ''});
    hljs.initHighlightingOnLoad();
  </script>
  ```

- `tabReplace` and `useBR` that were used in different places are also unified
  into the global options object and are to be set using `configure(options)`.
  This function is documented in our [API docs][]. Also note that these
  parameters are gone from `highlightBlock` and `fixMarkup` which are now also
  rely on `configure`.

- We removed public-facing (though undocumented) object `hljs.LANGUAGES` which
  was used to register languages with the library in favor of two new methods:
  `registerLanguage` and `getLanguage`. Both are documented in our [API docs][].

- Result returned from `highlight` and `highlightAuto` no longer contains two
  separate attributes contributing to relevance score, `relevance` and
  `keyword_count`. They are now unified in `relevance`.

Another technically compatible change that nonetheless might need attention:

- The structure of the NPM package was refactored, so if you had installed it
  locally, you'll have to update your paths. The usual `require('highlight.js')`
  works as before. This is contributed by [Dmitry Smolin][].

New features:

- Languages now can be recognized by multiple names like "js" for JavaScript or
  "html" for, well, HTML (which earlier insisted on calling it "xml"). These
  aliases can be specified in the class attribute of the code container in your
  HTML as well as in various API calls. For now there are only a few very common
  aliases but we'll expand it in the future. All of them are listed in the
  [class reference][cr].

- Language detection can now be restricted to a subset of languages relevant in
  a given context — a web page or even a single highlighting call. This is
  especially useful for node.js build that includes all the known languages.
  Another example is a StackOverflow-style site where users specify languages
  as tags rather than in the markdown-formatted code snippets. This is
  documented in the [API reference][] (see methods `highlightAuto` and
  `configure`).

- Language definition syntax streamlined with [variants][] and
  [beginKeywords][].

New languages and styles:

- *Oxygene* by [Carlo Kok][]
- *Mathematica* by [Daniel Kvasnička][]
- *Autohotkey* by [Seongwon Lee][]
- *Atelier* family of styles in 10 variants by [Bram de Haan][]
- *Paraíso* styles by [Jan T. Sott][]

Miscellaneous improvements:

- Highlighting `=>` prompts in Clojure.
- [Jeremy Hull][] fixed a lot of styles for consistency.
- Finally, highlighting PHP and HTML [mixed in peculiar ways][php-html].
- Objective C and C# now properly highlight titles in method definition.
- Big overhaul of relevance counting for a number of languages. Please do report
  bugs about mis-detection of non-trivial code snippets!

[API reference]: http://highlightjs.readthedocs.org/en/latest/api.html

[cr]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[api docs]: http://highlightjs.readthedocs.org/en/latest/api.html
[variants]: https://groups.google.com/d/topic/highlightjs/VoGC9-1p5vk/discussion
[beginKeywords]: https://github.com/isagalaev/highlight.js/commit/6c7fdea002eb3949577a85b3f7930137c7c3038d
[php-html]: https://twitter.com/highlightjs/status/408890903017689088

[Carlo Kok]: https://github.com/carlokok
[Bram de Haan]: https://github.com/atelierbram
[Daniel Kvasnička]: https://github.com/dkvasnicka
[Dmitry Smolin]: https://github.com/dimsmol
[Jeremy Hull]: https://github.com/sourrust
[Seongwon Lee]: https://github.com/dlimpid
[Jan T. Sott]: https://github.com/idleberg


## Version 7.5

A catch-up release dealing with some of the accumulated contributions. This one
is probably will be the last before the 8.0 which will be slightly backwards
incompatible regarding some advanced use-cases.

One outstanding change in this version is the addition of 6 languages to the
[hosted script][d]: Markdown, ObjectiveC, CoffeeScript, Apache, Nginx and
Makefile. It now weighs about 6K more but we're going to keep it under 30K.

New languages:

- OCaml by [Mehdi Dogguy][mehdid] and [Nicolas Braud-Santoni][nbraud]
- [LiveCode Server][lcs] by [Ralf Bitter][revig]
- Scilab by [Sylvestre Ledru][sylvestre]
- basic support for Makefile by [Ivan Sagalaev][isagalaev]

Improvements:

- Ruby's got support for characters like `?A`, `?1`, `?\012` etc. and `%r{..}`
  regexps.
- Clojure now allows a function call in the beginning of s-expressions
  `(($filter "myCount") (arr 1 2 3 4 5))`.
- Haskell's got new keywords and now recognizes more things like pragmas,
  preprocessors, modules, containers, FFIs etc. Thanks to [Zena Treep][treep]
  for the implementation and to [Jeremy Hull][sourrust] for guiding it.
- Miscellaneous fixes in PHP, Brainfuck, SCSS, Asciidoc, CMake, Python and F#.

[mehdid]: https://github.com/mehdid
[nbraud]: https://github.com/nbraud
[revig]: https://github.com/revig
[lcs]: http://livecode.com/developers/guides/server/
[sylvestre]: https://github.com/sylvestre
[isagalaev]: https://github.com/isagalaev
[treep]: https://github.com/treep
[sourrust]: https://github.com/sourrust
[d]: http://highlightjs.org/download/


## New core developers

The latest long period of almost complete inactivity in the project coincided
with growing interest to it led to a decision that now seems completely obvious:
we need more core developers.

So without further ado let me welcome to the core team two long-time
contributors: [Jeremy Hull][] and [Oleg
Efimov][].

Hope now we'll be able to work through stuff faster!

P.S. The historical commit is [here][1] for the record.

[Jeremy Hull]: https://github.com/sourrust
[Oleg Efimov]: https://github.com/sannis
[1]: https://github.com/isagalaev/highlight.js/commit/f3056941bda56d2b72276b97bc0dd5f230f2473f


## Version 7.4

This long overdue version is a snapshot of the current source tree with all the
changes that happened during the past year. Sorry for taking so long!

Along with the changes in code highlight.js has finally got its new home at
<http://highlightjs.org/>, moving from its cradle on Software Maniacs which it
outgrew a long time ago. Be sure to report any bugs about the site to
<mailto:info@highlightjs.org>.

On to what's new…

New languages:

- Handlebars templates by [Robin Ward][]
- Oracle Rules Language by [Jason Jacobson][]
- F# by [Joans Follesø][]
- AsciiDoc and Haml by [Dan Allen][]
- Lasso by [Eric Knibbe][]
- SCSS by [Kurt Emch][]
- VB.NET by [Poren Chiang][]
- Mizar by [Kelley van Evert][]

[Robin Ward]: https://github.com/eviltrout
[Jason Jacobson]: https://github.com/jayce7
[Joans Follesø]: https://github.com/follesoe
[Dan Allen]: https://github.com/mojavelinux
[Eric Knibbe]: https://github.com/EricFromCanada
[Kurt Emch]: https://github.com/kemch
[Poren Chiang]: https://github.com/rschiang
[Kelley van Evert]: https://github.com/kelleyvanevert

New style themes:

- Monokai Sublime by [noformnocontent][]
- Railscasts by [Damien White][]
- Obsidian by [Alexander Marenin][]
- Docco by [Simon Madine][]
- Mono Blue by [Ivan Sagalaev][] (uses a single color hue for everything)
- Foundation by [Dan Allen][]

[noformnocontent]: http://nn.mit-license.org/
[Damien White]: https://github.com/visoft
[Alexander Marenin]: https://github.com/ioncreature
[Simon Madine]: https://github.com/thingsinjars
[Ivan Sagalaev]: https://github.com/isagalaev

Other notable changes:

- Corrected many corner cases in CSS.
- Dropped Python 2 version of the build tool.
- Implemented building for the AMD format.
- Updated Rust keywords (thanks to [Dmitry Medvinsky][]).
- Literal regexes can now be used in language definitions.
- CoffeeScript highlighting is now significantly more robust and rich due to
  input from [Cédric Néhémie][].

[Dmitry Medvinsky]: https://github.com/dmedvinsky
[Cédric Néhémie]: https://github.com/abe33


## Version 7.3

- Since this version highlight.js no longer works in IE version 8 and older.
  It's made it possible to reduce the library size and dramatically improve code
  readability and made it easier to maintain. Time to go forward!

- New languages: AppleScript (by [Nathan Grigg][ng] and [Dr. Drang][dd]) and
  Brainfuck (by [Evgeny Stepanischev][bolk]).

- Improvements to existing languages:

    - interpreter prompt in Python (`>>>` and `...`)
    - @-properties and classes in CoffeeScript
    - E4X in JavaScript (by [Oleg Efimov][oe])
    - new keywords in Perl (by [Kirk Kimmel][kk])
    - big Ruby syntax update (by [Vasily Polovnyov][vast])
    - small fixes in Bash

- Also Oleg Efimov did a great job of moving all the docs for language and style
  developers and contributors from the old wiki under the source code in the
  "docs" directory. Now these docs are nicely presented at
  <http://highlightjs.readthedocs.org/>.

[ng]: https://github.com/nathan11g
[dd]: https://github.com/drdrang
[bolk]: https://github.com/bolknote
[oe]: https://github.com/Sannis
[kk]: https://github.com/kimmel
[vast]: https://github.com/vast


## Version 7.2

A regular bug-fix release without any significant new features. Enjoy!


## Version 7.1

A Summer crop:

- [Marc Fornos][mf] made the definition for Clojure along with the matching
  style Rainbow (which, of course, works for other languages too).
- CoffeeScript support continues to improve getting support for regular
  expressions.
- Yoshihide Jimbo ported to highlight.js [five Tomorrow styles][tm] from the
  [project by Chris Kempson][tm0].
- Thanks to [Casey Duncun][cd] the library can now be built in the popular
  [AMD format][amd].
- And last but not least, we've got a fair number of correctness and consistency
  fixes, including a pretty significant refactoring of Ruby.

[mf]: https://github.com/mfornos
[tm]: http://jmblog.github.com/color-themes-for-highlightjs/
[tm0]: https://github.com/ChrisKempson/Tomorrow-Theme
[cd]: https://github.com/caseman
[amd]: http://requirejs.org/docs/whyamd.html


## Version 7.0

The reason for the new major version update is a global change of keyword syntax
which resulted in the library getting smaller once again. For example, the
hosted build is 2K less than at the previous version while supporting two new
languages.

Notable changes:

- The library now works not only in a browser but also with [node.js][]. It is
  installable with `npm install highlight.js`. [API][] docs are available on our
  wiki.

- The new unique feature (apparently) among syntax highlighters is highlighting
  *HTTP* headers and an arbitrary language in the request body. The most useful
  languages here are *XML* and *JSON* both of which highlight.js does support.
  Here's [the detailed post][p] about the feature.

- Two new style themes: a dark "south" *[Pojoaque][]* by Jason Tate and an
  emulation of*XCode* IDE by [Angel Olloqui][ao].

- Three new languages: *D* by [Aleksandar Ružičić][ar], *R* by [Joe Cheng][jc]
  and *GLSL* by [Sergey Tikhomirov][st].

- *Nginx* syntax has become a million times smaller and more universal thanks to
  remaking it in a more generic manner that doesn't require listing all the
  directives in the known universe.

- Function titles are now highlighted in *PHP*.

- *Haskell* and *VHDL* were significantly reworked to be more rich and correct
  by their respective maintainers [Jeremy Hull][sr] and [Igor Kalnitsky][ik].

And last but not least, many bugs have been fixed around correctness and
language detection.

Overall highlight.js currently supports 51 languages and 20 style themes.

[node.js]: http://nodejs.org/
[api]: http://softwaremaniacs.org/wiki/doku.php/highlight.js:api
[p]: http://softwaremaniacs.org/blog/2012/05/10/http-and-json-in-highlight-js/en/
[pojoaque]: http://web-cms-designs.com/ftopict-10-pojoaque-style-for-highlight-js-code-highlighter.html
[ao]: https://github.com/angelolloqui
[ar]: https://github.com/raleksandar
[jc]: https://github.com/jcheng5
[st]: https://github.com/tikhomirov
[sr]: https://github.com/sourrust
[ik]: https://github.com/ikalnitsky


## Version 6.2

A lot of things happened in highlight.js since the last version! We've got nine
new contributors, the discussion group came alive, and the main branch on GitHub
now counts more than 350 followers. Here are most significant results coming
from all this activity:

- 5 (five!) new languages: Rust, ActionScript, CoffeeScript, MatLab and
  experimental support for markdown. Thanks go to [Andrey Vlasovskikh][av],
  [Alexander Myadzel][am], [Dmytrii Nagirniak][dn], [Oleg Efimov][oe], [Denis
  Bardadym][db] and [John Crepezzi][jc].

- 2 new style themes: Monokai by [Luigi Maselli][lm] and stylistic imitation of
  another well-known highlighter Google Code Prettify by [Aahan Krish][ak].

- A vast number of [correctness fixes and code refactorings][log], mostly made
  by [Oleg Efimov][oe] and [Evgeny Stepanischev][es].

[av]: https://github.com/vlasovskikh
[am]: https://github.com/myadzel
[dn]: https://github.com/dnagir
[oe]: https://github.com/Sannis
[db]: https://github.com/btd
[jc]: https://github.com/seejohnrun
[lm]: http://grigio.org/
[ak]: https://github.com/geekpanth3r
[es]: https://github.com/bolknote
[log]: https://github.com/isagalaev/highlight.js/commits/


## Version 6.1 — Solarized

[Jeremy Hull][jh] has implemented my dream feature — a port of [Solarized][]
style theme famous for being based on the intricate color theory to achieve
correct contrast and color perception. It is now available for highlight.js in
both variants — light and dark.

This version also adds a new original style Arta. Its author pumbur maintains a
[heavily modified fork of highlight.js][pb] on GitHub.

[jh]: https://github.com/sourrust
[solarized]: http://ethanschoonover.com/solarized
[pb]: https://github.com/pumbur/highlight.js


## Version 6.0

New major version of the highlighter has been built on a significantly
refactored syntax. Due to this it's even smaller than the previous one while
supporting more languages!

New languages are:

- Haskell by [Jeremy Hull][sourrust]
- Erlang in two varieties — module and REPL — made collectively by [Nikolay
  Zakharov][desh], [Dmitry Kovega][arhibot] and [Sergey Ignatov][ignatov]
- Objective C by [Valerii Hiora][vhbit]
- Vala by [Antono Vasiljev][antono]
- Go by [Stephan Kountso][steplg]

[sourrust]: https://github.com/sourrust
[desh]: http://desh.su/
[arhibot]: https://github.com/arhibot
[ignatov]: https://github.com/ignatov
[vhbit]: https://github.com/vhbit
[antono]: https://github.com/antono
[steplg]: https://github.com/steplg

Also this version is marginally faster and fixes a number of small long-standing
bugs.

Developer overview of the new language syntax is available in a [blog post about
recent beta release][beta].

[beta]: http://softwaremaniacs.org/blog/2011/04/25/highlight-js-60-beta/en/

P.S. New version is not yet available on a Yandex CDN, so for now you have to
download [your own copy][d].

[d]: /soft/highlight/en/download/


## Version 5.14

Fixed bugs in HTML/XML detection and relevance introduced in previous
refactoring.

Also test.html now shows the second best result of language detection by
relevance.


## Version 5.13

Past weekend began with a couple of simple additions for existing languages but
ended up in a big code refactoring bringing along nice improvements for language
developers.

### For users

- Description of C++ has got new keywords from the upcoming [C++ 0x][] standard.
- Description of HTML has got new tags from [HTML 5][].
- CSS-styles have been unified to use consistent padding and also have lost
  pop-outs with names of detected languages.
- [Igor Kalnitsky][ik] has sent two new language descriptions: CMake & VHDL.

This makes total number of languages supported by highlight.js to reach 35.

Bug fixes:

- Custom classes on `<pre>` tags are not being overridden anymore
- More correct highlighting of code blocks inside non-`<pre>` containers:
  highlighter now doesn't insist on replacing them with its own container and
  just replaces the contents.
- Small fixes in browser compatibility and heuristics.

[c++ 0x]: http://ru.wikipedia.org/wiki/C%2B%2B0x
[html 5]: http://en.wikipedia.org/wiki/HTML5
[ik]: http://kalnitsky.org.ua/

### For developers

The most significant change is the ability to include language submodes right
under `contains` instead of defining explicit named submodes in the main array:

    contains: [
      'string',
      'number',
      {begin: '\\n', end: hljs.IMMEDIATE_RE}
    ]

This is useful for auxiliary modes needed only in one place to define parsing.
Note that such modes often don't have `className` and hence won't generate a
separate `<span>` in the resulting markup. This is similar in effect to
`noMarkup: true`. All existing languages have been refactored accordingly.

Test file test.html has at last become a real test. Now it not only puts the
detected language name under the code snippet but also tests if it matches the
expected one. Test summary is displayed right above all language snippets.


## CDN

Fine people at [Yandex][] agreed to host highlight.js on their big fast servers.
[Link up][l]!

[yandex]: http://yandex.com/
[l]: http://softwaremaniacs.org/soft/highlight/en/download/


## Version 5.10 — "Paris".

Though I'm on a vacation in Paris, I decided to release a new version with a
couple of small fixes:

- Tomas Vitvar discovered that TAB replacement doesn't always work when used
  with custom markup in code
- SQL parsing is even more rigid now and doesn't step over SmallTalk in tests


## Version 5.9

A long-awaited version is finally released.

New languages:

- Andrew Fedorov made a definition for Lua
- a long-time highlight.js contributor [Peter Leonov][pl] made a definition for
  Nginx config
- [Vladimir Moskva][vm] made a definition for TeX

[pl]: http://kung-fu-tzu.ru/
[vm]: http://fulc.ru/

Fixes for existing languages:

- [Loren Segal][ls] reworked the Ruby definition and added highlighting for
  [YARD][] inline documentation
- the definition of SQL has become more solid and now it shouldn't be overly
  greedy when it comes to language detection

[ls]: http://gnuu.org/
[yard]: http://yardoc.org/

The highlighter has become more usable as a library allowing to do highlighting
from initialization code of JS frameworks and in ajax methods (see.
readme.eng.txt).

Also this version drops support for the [WordPress][wp] plugin. Everyone is
welcome to [pick up its maintenance][p] if needed.

[wp]: http://wordpress.org/
[p]: http://bazaar.launchpad.net/~isagalaev/+junk/highlight/annotate/342/src/wp_highlight.js.php


## Version 5.8

- Jan Berkel has contributed a definition for Scala. +1 to hotness!
- All CSS-styles are rewritten to work only inside `<pre>` tags to avoid
  conflicts with host site styles.


## Version 5.7.

Fixed escaping of quotes in VBScript strings.


## Version 5.5

This version brings a small change: now .ini-files allow digits, underscores and
square brackets in key names.


## Version 5.4

Fixed small but upsetting bug in the packer which caused incorrect highlighting
of explicitly specified languages. Thanks to Andrew Fedorov for precise
diagnostics!


## Version 5.3

The version to fulfil old promises.

The most significant change is that highlight.js now preserves custom user
markup in code along with its own highlighting markup. This means that now it's
possible to use, say, links in code. Thanks to [Vladimir Dolzhenko][vd] for the
[initial proposal][1] and for making a proof-of-concept patch.

Also in this version:

- [Vasily Polovnyov][vp] has sent a GitHub-like style and has implemented
  support for CSS @-rules and Ruby symbols.
- Yura Zaripov has sent two styles: Brown Paper and School Book.
- Oleg Volchkov has sent a definition for [Parser 3][p3].

[1]: http://softwaremaniacs.org/forum/highlightjs/6612/
[p3]: http://www.parser.ru/
[vp]: http://vasily.polovnyov.ru/
[vd]: http://dolzhenko.blogspot.com/


## Version 5.2

- at last it's possible to replace indentation TABs with something sensible
  (e.g. 2 or 4 spaces)
- new keywords and built-ins for 1C by Sergey Baranov
- a couple of small fixes to Apache highlighting


## Version 5.1

This is one of those nice version consisting entirely of new and shiny
contributions!

- [Vladimir Ermakov][vooon] created highlighting for AVR Assembler
- [Ruslan Keba][rukeba] created highlighting for Apache config file. Also his
  original visual style for it is now available for all highlight.js languages
  under the name "Magula".
- [Shuen-Huei Guan][drake] (aka Drake) sent new keywords for RenderMan
  languages. Also thanks go to [Konstantin Evdokimenko][ke] for his advice on
  the matter.

[vooon]: http://vehq.ru/about/
[rukeba]: http://rukeba.com/
[drake]: http://drakeguan.org/
[ke]: http://k-evdokimenko.moikrug.ru/


## Version 5.0

The main change in the new major version of highlight.js is a mechanism for
packing several languages along with the library itself into a single compressed
file. Now sites using several languages will load considerably faster because
the library won't dynamically include additional files while loading.

Also this version fixes a long-standing bug with Javascript highlighting that
couldn't distinguish between regular expressions and division operations.

And as usually there were a couple of minor correctness fixes.

Great thanks to all contributors! Keep using highlight.js.


## Version 4.3

This version comes with two contributions from [Jason Diamond][jd]:

- language definition for C# (yes! it was a long-missed thing!)
- Visual Studio-like highlighting style

Plus there are a couple of minor bug fixes for parsing HTML and XML attributes.

[jd]: http://jason.diamond.name/weblog/


## Version 4.2

The biggest news is highlighting for Lisp, courtesy of Vasily Polovnyov. It's
somewhat experimental meaning that for highlighting "keywords" it doesn't use
any pre-defined set of a Lisp dialect. Instead it tries to highlight first word
in parentheses wherever it makes sense. I'd like to ask people programming in
Lisp to confirm if it's a good idea and send feedback to [the forum][f].

Other changes:

- Smalltalk was excluded from DEFAULT_LANGUAGES to save traffic
- [Vladimir Epifanov][voldmar] has implemented javascript style switcher for
  test.html
- comments now allowed inside Ruby function definition
- [MEL][] language from [Shuen-Huei Guan][drake]
- whitespace now allowed between `<pre>` and `<code>`
- better auto-detection of C++ and PHP
- HTML allows embedded VBScript (`<% .. %>`)

[f]: http://softwaremaniacs.org/forum/highlightjs/
[voldmar]: http://voldmar.ya.ru/
[mel]: http://en.wikipedia.org/wiki/Maya_Embedded_Language
[drake]: http://drakeguan.org/


## Version 4.1

Languages:

- Bash from Vah
- DOS bat-files from Alexander Makarov (Sam)
- Diff files from Vasily Polovnyov
- Ini files from myself though initial idea was from Sam

Styles:

- Zenburn from Vladimir Epifanov, this is an imitation of a
  [well-known theme for Vim][zenburn].
- Ascetic from myself, as a realization of ideals of non-flashy highlighting:
  just one color in only three gradations :-)

In other news. [One small bug][bug] was fixed, built-in keywords were added for
Python and C++ which improved auto-detection for the latter (it was shame that
[my wife's blog][alenacpp] had issues with it from time to time). And lastly
thanks go to Sam for getting rid of my stylistic comments in code that were
getting in the way of [JSMin][].

[zenburn]: http://en.wikipedia.org/wiki/Zenburn
[alenacpp]: http://alenacpp.blogspot.com/
[bug]: http://softwaremaniacs.org/forum/viewtopic.php?id=1823
[jsmin]: http://code.google.com/p/jsmin-php/


## Version 4.0

New major version is a result of vast refactoring and of many contributions.

Visible new features:

- Highlighting of embedded languages. Currently is implemented highlighting of
  Javascript and CSS inside HTML.
- Bundled 5 ready-made style themes!

Invisible new features:

- Highlight.js no longer pollutes global namespace. Only one object and one
  function for backward compatibility.
- Performance is further increased by about 15%.

Changing of a major version number caused by a new format of language definition
files. If you use some third-party language files they should be updated.


## Version 3.5

A very nice version in my opinion fixing a number of small bugs and slightly
increased speed in a couple of corner cases. Thanks to everybody who reports
bugs in he [forum][f] and by email!

There is also a new language — XML. A custom XML formerly was detected as HTML
and didn't highlight custom tags. In this version I tried to make custom XML to
be detected and highlighted by its own rules. Which by the way include such
things as CDATA sections and processing instructions (`<? ... ?>`).

[f]: http://softwaremaniacs.org/forum/viewforum.php?id=6


## Version 3.3

[Vladimir Gubarkov][xonix] has provided an interesting and useful addition.
File export.html contains a little program that shows and allows to copy and
paste an HTML code generated by the highlighter for any code snippet. This can
be useful in situations when one can't use the script itself on a site.


[xonix]: http://xonixx.blogspot.com/


## Version 3.2 consists completely of contributions:

- Vladimir Gubarkov has described SmallTalk
- Yuri Ivanov has described 1C
- Peter Leonov has packaged the highlighter as a Firefox extension
- Vladimir Ermakov has compiled a mod for phpBB

Many thanks to you all!


## Version 3.1

Three new languages are available: Django templates, SQL and Axapta. The latter
two are sent by [Dmitri Roudakov][1]. However I've almost entirely rewrote an
SQL definition but I'd never started it be it from the ground up :-)

The engine itself has got a long awaited feature of grouping keywords
("keyword", "built-in function", "literal"). No more hacks!

[1]: http://roudakov.ru/


## Version 3.0

It is major mainly because now highlight.js has grown large and has become
modular. Now when you pass it a list of languages to highlight it will
dynamically load into a browser only those languages.

Also:

- Konstantin Evdokimenko of [RibKit][] project has created a highlighting for
  RenderMan Shading Language and RenderMan Interface Bytestream. Yay for more
  languages!
- Heuristics for C++ and HTML got better.
- I've implemented (at last) a correct handling of backslash escapes in C-like
  languages.

There is also a small backwards incompatible change in the new version. The
function initHighlighting that was used to initialize highlighting instead of
initHighlightingOnLoad a long time ago no longer works. If you by chance still
use it — replace it with the new one.

[RibKit]: http://ribkit.sourceforge.net/


## Version 2.9

Highlight.js is a parser, not just a couple of regular expressions. That said
I'm glad to announce that in the new version 2.9 has support for:

- in-string substitutions for Ruby -- `#{...}`
- strings from from numeric symbol codes (like #XX) for Delphi


## Version 2.8

A maintenance release with more tuned heuristics. Fully backwards compatible.


## Version 2.7

- Nikita Ledyaev presents highlighting for VBScript, yay!
- A couple of bugs with escaping in strings were fixed thanks to Mickle
- Ongoing tuning of heuristics

Fixed bugs were rather unpleasant so I encourage everyone to upgrade!


## Version 2.4

- Peter Leonov provides another improved highlighting for Perl
- Javascript gets a new kind of keywords — "literals". These are the words
  "true", "false" and "null"

Also highlight.js homepage now lists sites that use the library. Feel free to
add your site by [dropping me a message][mail] until I find the time to build a
submit form.

[mail]: mailto:Maniac@SoftwareManiacs.Org


## Version 2.3

This version fixes IE breakage in previous version. My apologies to all who have
already downloaded that one!


## Version 2.2

- added highlighting for Javascript
- at last fixed parsing of Delphi's escaped apostrophes in strings
- in Ruby fixed highlighting of keywords 'def' and 'class', same for 'sub' in
  Perl


## Version 2.0

- Ruby support by [Anton Kovalyov][ak]
- speed increased by orders of magnitude due to new way of parsing
- this same way allows now correct highlighting of keywords in some tricky
  places (like keyword "End" at the end of Delphi classes)

[ak]: http://anton.kovalyov.net/


## Version 1.0

Version 1.0 of javascript syntax highlighter is released!

It's the first version available with English description. Feel free to post
your comments and question to [highlight.js forum][forum]. And don't be afraid
if you find there some fancy Cyrillic letters -- it's for Russian users too :-)

[forum]: http://softwaremaniacs.org/forum/viewforum.php?id=6
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2 <beans_ xmlns="http://www. springframework. org/schema/beans"

5 xmlns:camel="http://camel.apache. org/ schema/ spring®
4 xmlnsixsi='http://wv. 3. org/ 2661/ XMSchena-instance" xs:

5 <bean

s class="org. springframework. aop. framework. AbstractAdvisingBeanPostProcessor®
7 id="Transformsean" scope="singleton" />

85  <camelContext id="camelContext-500b5988-86f7-4387-adbf-049d5220c1F2"

o trace="false" xmlns:

Eo endpoint 1d
11 <endpoint 1d=
12 <endpoint id="mydMs2* uri='jms:queue:destinationName'/>
139 <dataFormats>
14 <xmljson contentTypeHeader=" false"
15 ForceTopLevelObject="false' id="myDataFormat"
16 namespacelenient="false" removeNamespacePrefixes="false"
17 skipNamespaces="false' skiphhitespace="false" trimSpaces="false'/>
18 </dataFormats>
19 <route id="_routel"/>
</camelContext>’
</beans>
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CamelFileAbsolute false
‘CamelFileAbsolutePath [Users jmurphey/workspaceCR 1a/CBRroute /target/mess.
CamelFileLastModified 1464100947000
‘CamelFileLength 335
CamelFileName messaged.xmi
CamelFileNameConsumed  messaged.xmi
‘CamelFileNameOnly messaged.xmi
‘CamelFileParent target/messages/invalidOrders
CamelFilepath target/messages/invalidOrders/message4.xml
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el version="L0" encoding="UTF 87>
<order>
<customer>

‘<name>Bristol Zoological Gardens </name>
<city>Bristol < /city>
<country>Great Britain</country>
</customer>
<orderline>
<animal>emu< animal>
<quantity>5 </quantity>
<maxllowed>4 < /maxllowed>
</orderline>
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[ JFile - The file component is used for reading or witing files.

I FTP - The ftp component is used for uploading or downloading files from FTP servers.

(=1 FTPS - The ftps (FTP secure SSL/TLS) component is used for uploading or downloading files from FTP servers.
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MQTT - Component for communicating with MQTT M2M message brokers using FuseSource MQTT Client.

[BJMVEL - Transforms the message using a MVEL templte.

3 Netty - Socket level networking using TCP or UDP with the Netty 3. libary.
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232 <blueprint xmlns="http://mww. 0sgi.org/xmlns/blueprint/vl.6.6"

24 xmlns:xsi="http://ww. u3.org/2001/XM.Schema-instance xsi:schemalocation="http: //ww.0sgi.org/xmlns/blu
268 The namespace for the camelContext element in Blueprint is 'https://camel.apache.org/schema/blueprint
32 <bean class="com.mycompany. GreeterService" id="Greeterservice'/>

5335 <camelContext id='_contextl® xmlns="http://camel.apache.org/ schema/blueprint®s
Ed <restConfigurafion component="netty-http" host="localhost" port="16600"/>
3 <rest path='/say">
369 <get uri="hello/{name}">
37 <to uri="direct:service-hello"/>
E </get>
399 <get consumes="application/json" uri="/bye/{name}">
s <to uri="direct:service-bye' />
41 </get>
420 <post uri='/greeter'>
43 <to uri=*direct:service-greeter'/>
44 </post>
45 </rest>
468 <route id="service-hello">
a7 <from id="_froml" uri="direct:service-hello"/>
485 <setBody id="_setBodyl">
49 <sinple-Hello ${header.name}</simple>
50 </setBody>
s1 </route>
520 <route id="service-bye"s
s3 <from id="_from2" uri=tdirect:service-bye'/>
sae <transforn id="_transforml">
S5 <simple>Bye ${header.name}</simple>
s6 </transform
57 </route>
s8e <route id="service-grester's
9 <from id="_froms" uri="direct:service-greeter"/>
605 <unmarshal id="_unmarshall">
61 <json libraTy="Jackson" unmarshalTypeName="com. mycompany. Hel loRequest" />
62 </unmarshal>
63 <to 1d="_tol" uri="bean:GreeterService?method=createtello" />
625 <marshalid="_marshall’>
65 <json Library="Jackson" />
6 </marshal>
57 </route>
68 </camelContext>

69 </blueprint>
——
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(function(a,b){function cy(a){return f.isWindow(a)?a:a.nodeType===9?a.defaultView||a.parentWindow:!1}function cv(a){if(!ck[a]){var b=c.body,d=f("<"+a+">").appendTo(b),e=d.css("display");d.remove();if(e==="none"||e===""){cl||(cl=c.createElement("iframe"),cl.frameBorder=cl.width=cl.height=0),b.appendChild(cl);if(!cm||!cl.createElement)cm=(cl.contentWindow||cl.contentDocument).document,cm.write((c.compatMode==="CSS1Compat"?"<!doctype html>":"")+"<html><body>"),cm.close();d=cm.createElement(a),cm.body.appendChild(d),e=f.css(d,"display"),b.removeChild(cl)}ck[a]=e}return ck[a]}function cu(a,b){var c={};f.each(cq.concat.apply([],cq.slice(0,b)),function(){c[this]=a});return c}function ct(){cr=b}function cs(){setTimeout(ct,0);return cr=f.now()}function cj(){try{return new a.ActiveXObject("Microsoft.XMLHTTP")}catch(b){}}function ci(){try{return new a.XMLHttpRequest}catch(b){}}function cc(a,c){a.dataFilter&&(c=a.dataFilter(c,a.dataType));var d=a.dataTypes,e={},g,h,i=d.length,j,k=d[0],l,m,n,o,p;for(g=1;g<i;g++){if(g===1)for(h in a.converters)typeof h=="string"&&(e[h.toLowerCase()]=a.converters[h]);l=k,k=d[g];if(k==="*")k=l;else if(l!=="*"&&l!==k){m=l+" "+k,n=e[m]||e["* "+k];if(!n){p=b;for(o in e){j=o.split(" ");if(j[0]===l||j[0]==="*"){p=e[j[1]+" "+k];if(p){o=e[o],o===!0?n=p:p===!0&&(n=o);break}}}}!n&&!p&&f.error("No conversion from "+m.replace(" "," to ")),n!==!0&&(c=n?n(c):p(o(c)))}}return c}function cb(a,c,d){var e=a.contents,f=a.dataTypes,g=a.responseFields,h,i,j,k;for(i in g)i in d&&(c[g[i]]=d[i]);while(f[0]==="*")f.shift(),h===b&&(h=a.mimeType||c.getResponseHeader("content-type"));if(h)for(i in e)if(e[i]&&e[i].test(h)){f.unshift(i);break}if(f[0]in d)j=f[0];else{for(i in d){if(!f[0]||a.converters[i+" "+f[0]]){j=i;break}k||(k=i)}j=j||k}if(j){j!==f[0]&&f.unshift(j);return d[j]}}function ca(a,b,c,d){if(f.isArray(b))f.each(b,function(b,e){c||bE.test(a)?d(a,e):ca(a+"["+(typeof e=="object"||f.isArray(e)?b:"")+"]",e,c,d)});else if(!c&&b!=null&&typeof b=="object")for(var e in b)ca(a+"["+e+"]",b[e],c,d);else d(a,b)}function b_(a,c){var d,e,g=f.ajaxSettings.flatOptions||{};for(d in c)c[d]!==b&&((g[d]?a:e||(e={}))[d]=c[d]);e&&f.extend(!0,a,e)}function b$(a,c,d,e,f,g){f=f||c.dataTypes[0],g=g||{},g[f]=!0;var h=a[f],i=0,j=h?h.length:0,k=a===bT,l;for(;i<j&&(k||!l);i++)l=h[i](c,d,e),typeof l=="string"&&(!k||g[l]?l=b:(c.dataTypes.unshift(l),l=b$(a,c,d,e,l,g)));(k||!l)&&!g["*"]&&(l=b$(a,c,d,e,"*",g));return l}function bZ(a){return function(b,c){typeof b!="string"&&(c=b,b="*");if(f.isFunction(c)){var d=b.toLowerCase().split(bP),e=0,g=d.length,h,i,j;for(;e<g;e++)h=d[e],j=/^\+/.test(h),j&&(h=h.substr(1)||"*"),i=a[h]=a[h]||[],i[j?"unshift":"push"](c)}}}function bC(a,b,c){var d=b==="width"?a.offsetWidth:a.offsetHeight,e=b==="width"?bx:by,g=0,h=e.length;if(d>0){if(c!=="border")for(;g<h;g++)c||(d-=parseFloat(f.css(a,"padding"+e[g]))||0),c==="margin"?d+=parseFloat(f.css(a,c+e[g]))||0:d-=parseFloat(f.css(a,"border"+e[g]+"Width"))||0;return d+"px"}d=bz(a,b,b);if(d<0||d==null)d=a.style[b]||0;d=parseFloat(d)||0;if(c)for(;g<h;g++)d+=parseFloat(f.css(a,"padding"+e[g]))||0,c!=="padding"&&(d+=parseFloat(f.css(a,"border"+e[g]+"Width"))||0),c==="margin"&&(d+=parseFloat(f.css(a,c+e[g]))||0);return d+"px"}function bp(a,b){b.src?f.ajax({url:b.src,async:!1,dataType:"script"}):f.globalEval((b.text||b.textContent||b.innerHTML||"").replace(bf,"/*$0*/")),b.parentNode&&b.parentNode.removeChild(b)}function bo(a){var b=c.createElement("div");bh.appendChild(b),b.innerHTML=a.outerHTML;return b.firstChild}function bn(a){var b=(a.nodeName||"").toLowerCase();b==="input"?bm(a):b!=="script"&&typeof a.getElementsByTagName!="undefined"&&f.grep(a.getElementsByTagName("input"),bm)}function bm(a){if(a.type==="checkbox"||a.type==="radio")a.defaultChecked=a.checked}function bl(a){return typeof a.getElementsByTagName!="undefined"?a.getElementsByTagName("*"):typeof a.querySelectorAll!="undefined"?a.querySelectorAll("*"):[]}function bk(a,b){var c;if(b.nodeType===1){b.clearAttributes&&b.clearAttributes(),b.mergeAttributes&&b.mergeAttributes(a),c=b.nodeName.toLowerCase();if(c==="object")b.outerHTML=a.outerHTML;else if(c!=="input"||a.type!=="checkbox"&&a.type!=="radio"){if(c==="option")b.selected=a.defaultSelected;else if(c==="input"||c==="textarea")b.defaultValue=a.defaultValue}else a.checked&&(b.defaultChecked=b.checked=a.checked),b.value!==a.value&&(b.value=a.value);b.removeAttribute(f.expando)}}function bj(a,b){if(b.nodeType===1&&!!f.hasData(a)){var c,d,e,g=f._data(a),h=f._data(b,g),i=g.events;if(i){delete h.handle,h.events={};for(c in i)for(d=0,e=i[c].length;d<e;d++)f.event.add(b,c+(i[c][d].namespace?".":"")+i[c][d].namespace,i[c][d],i[c][d].data)}h.data&&(h.data=f.extend({},h.data))}}function bi(a,b){return f.nodeName(a,"table")?a.getElementsByTagName("tbody")[0]||a.appendChild(a.ownerDocument.createElement("tbody")):a}function U(a){var b=V.split("|"),c=a.createDocumentFragment();if(c.createElement)while(b.length)c.createElement(b.pop());return c}function T(a,b,c){b=b||0;if(f.isFunction(b))return f.grep(a,function(a,d){var e=!!b.call(a,d,a);return e===c});if(b.nodeType)return f.grep(a,function(a,d){return a===b===c});if(typeof b=="string"){var d=f.grep(a,function(a){return a.nodeType===1});if(O.test(b))return f.filter(b,d,!c);b=f.filter(b,d)}return f.grep(a,function(a,d){return f.inArray(a,b)>=0===c})}function S(a){return!a||!a.parentNode||a.parentNode.nodeType===11}function K(){return!0}function J(){return!1}function n(a,b,c){var d=b+"defer",e=b+"queue",g=b+"mark",h=f._data(a,d);h&&(c==="queue"||!f._data(a,e))&&(c==="mark"||!f._data(a,g))&&setTimeout(function(){!f._data(a,e)&&!f._data(a,g)&&(f.removeData(a,d,!0),h.fire())},0)}function m(a){for(var b in a){if(b==="data"&&f.isEmptyObject(a[b]))continue;if(b!=="toJSON")return!1}return!0}function l(a,c,d){if(d===b&&a.nodeType===1){var e="data-"+c.replace(k,"-$1").toLowerCase();d=a.getAttribute(e);if(typeof d=="string"){try{d=d==="true"?!0:d==="false"?!1:d==="null"?null:f.isNumeric(d)?parseFloat(d):j.test(d)?f.parseJSON(d):d}catch(g){}f.data(a,c,d)}else d=b}return d}function h(a){var b=g[a]={},c,d;a=a.split(/\s+/);for(c=0,d=a.length;c<d;c++)b[a[c]]=!0;return b}var c=a.document,d=a.navigator,e=a.location,f=function(){function J(){if(!e.isReady){try{c.documentElement.doScroll("left")}catch(a){setTimeout(J,1);return}e.ready()}}var e=function(a,b){return new e.fn.init(a,b,h)},f=a.jQuery,g=a.$,h,i=/^(?:[^#<]*(<[\w\W]+>)[^>]*$|#([\w\-]*)$)/,j=/\S/,k=/^\s+/,l=/\s+$/,m=/^<(\w+)\s*\/?>(?:<\/\1>)?$/,n=/^[\],:{}\s]*$/,o=/\\(?:["\\\/bfnrt]|u[0-9a-fA-F]{4})/g,p=/"[^"\\\n\r]*"|true|false|null|-?\d+(?:\.\d*)?(?:[eE][+\-]?\d+)?/g,q=/(?:^|:|,)(?:\s*\[)+/g,r=/(webkit)[ \/]([\w.]+)/,s=/(opera)(?:.*version)?[ \/]([\w.]+)/,t=/(msie) ([\w.]+)/,u=/(mozilla)(?:.*? rv:([\w.]+))?/,v=/-([a-z]|[0-9])/ig,w=/^-ms-/,x=function(a,b){return(b+"").toUpperCase()},y=d.userAgent,z,A,B,C=Object.prototype.toString,D=Object.prototype.hasOwnProperty,E=Array.prototype.push,F=Array.prototype.slice,G=String.prototype.trim,H=Array.prototype.indexOf,I={};e.fn=e.prototype={constructor:e,init:function(a,d,f){var g,h,j,k;if(!a)return this;if(a.nodeType){this.context=this[0]=a,this.length=1;return this}if(a==="body"&&!d&&c.body){this.context=c,this[0]=c.body,this.selector=a,this.length=1;return this}if(typeof a=="string"){a.charAt(0)!=="<"||a.charAt(a.length-1)!==">"||a.length<3?g=i.exec(a):g=[null,a,null];if(g&&(g[1]||!d)){if(g[1]){d=d instanceof e?d[0]:d,k=d?d.ownerDocument||d:c,j=m.exec(a),j?e.isPlainObject(d)?(a=[c.createElement(j[1])],e.fn.attr.call(a,d,!0)):a=[k.createElement(j[1])]:(j=e.buildFragment([g[1]],[k]),a=(j.cacheable?e.clone(j.fragment):j.fragment).childNodes);return e.merge(this,a)}h=c.getElementById(g[2]);if(h&&h.parentNode){if(h.id!==g[2])return f.find(a);this.length=1,this[0]=h}this.context=c,this.selector=a;return this}return!d||d.jquery?(d||f).find(a):this.constructor(d).find(a)}if(e.isFunction(a))return f.ready(a);a.selector!==b&&(this.selector=a.selector,this.context=a.context);return e.makeArray(a,this)},selector:"",jquery:"1.7.1",length:0,size:function(){return this.length},toArray:function(){return F.call(this,0)},get:function(a){return a==null?this.toArray():a<0?this[this.length+a]:this[a]},pushStack:function(a,b,c){var d=this.constructor();e.isArray(a)?E.apply(d,a):e.merge(d,a),d.prevObject=this,d.context=this.context,b==="find"?d.selector=this.selector+(this.selector?" ":"")+c:b&&(d.selector=this.selector+"."+b+"("+c+")");return d},each:function(a,b){return e.each(this,a,b)},ready:function(a){e.bindReady(),A.add(a);return this},eq:function(a){a=+a;return a===-1?this.slice(a):this.slice(a,a+1)},first:function(){return this.eq(0)},last:function(){return this.eq(-1)},slice:function(){return this.pushStack(F.apply(this,arguments),"slice",F.call(arguments).join(","))},map:function(a){return this.pushStack(e.map(this,function(b,c){return a.call(b,c,b)}))},end:function(){return this.prevObject||this.constructor(null)},push:E,sort:[].sort,splice:[].splice},e.fn.init.prototype=e.fn,e.extend=e.fn.extend=function(){var a,c,d,f,g,h,i=arguments[0]||{},j=1,k=arguments.length,l=!1;typeof i=="boolean"&&(l=i,i=arguments[1]||{},j=2),typeof i!="object"&&!e.isFunction(i)&&(i={}),k===j&&(i=this,--j);for(;j<k;j++)if((a=arguments[j])!=null)for(c in a){d=i[c],f=a[c];if(i===f)continue;l&&f&&(e.isPlainObject(f)||(g=e.isArray(f)))?(g?(g=!1,h=d&&e.isArray(d)?d:[]):h=d&&e.isPlainObject(d)?d:{},i[c]=e.extend(l,h,f)):f!==b&&(i[c]=f)}return i},e.extend({noConflict:function(b){a.$===e&&(a.$=g),b&&a.jQuery===e&&(a.jQuery=f);return e},isReady:!1,readyWait:1,holdReady:function(a){a?e.readyWait++:e.ready(!0)},ready:function(a){if(a===!0&&!--e.readyWait||a!==!0&&!e.isReady){if(!c.body)return setTimeout(e.ready,1);e.isReady=!0;if(a!==!0&&--e.readyWait>0)return;A.fireWith(c,[e]),e.fn.trigger&&e(c).trigger("ready").off("ready")}},bindReady:function(){if(!A){A=e.Callbacks("once memory");if(c.readyState==="complete")return setTimeout(e.ready,1);if(c.addEventListener)c.addEventListener("DOMContentLoaded",B,!1),a.addEventListener("load",e.ready,!1);else if(c.attachEvent){c.attachEvent("onreadystatechange",B),a.attachEvent("onload",e.ready);var b=!1;try{b=a.frameElement==null}catch(d){}c.documentElement.doScroll&&b&&J()}}},isFunction:function(a){return e.type(a)==="function"},isArray:Array.isArray||function(a){return e.type(a)==="array"},isWindow:function(a){return a&&typeof a=="object"&&"setInterval"in a},isNumeric:function(a){return!isNaN(parseFloat(a))&&isFinite(a)},type:function(a){return a==null?String(a):I[C.call(a)]||"object"},isPlainObject:function(a){if(!a||e.type(a)!=="object"||a.nodeType||e.isWindow(a))return!1;try{if(a.constructor&&!D.call(a,"constructor")&&!D.call(a.constructor.prototype,"isPrototypeOf"))return!1}catch(c){return!1}var d;for(d in a);return d===b||D.call(a,d)},isEmptyObject:function(a){for(var b in a)return!1;return!0},error:function(a){throw new Error(a)},parseJSON:function(b){if(typeof b!="string"||!b)return null;b=e.trim(b);if(a.JSON&&a.JSON.parse)return a.JSON.parse(b);if(n.test(b.replace(o,"@").replace(p,"]").replace(q,"")))return(new Function("return "+b))();e.error("Invalid JSON: "+b)},parseXML:function(c){var d,f;try{a.DOMParser?(f=new DOMParser,d=f.parseFromString(c,"text/xml")):(d=new ActiveXObject("Microsoft.XMLDOM"),d.async="false",d.loadXML(c))}catch(g){d=b}(!d||!d.documentElement||d.getElementsByTagName("parsererror").length)&&e.error("Invalid XML: "+c);return d},noop:function(){},globalEval:function(b){b&&j.test(b)&&(a.execScript||function(b){a.eval.call(a,b)})(b)},camelCase:function(a){return a.replace(w,"ms-").replace(v,x)},nodeName:function(a,b){return a.nodeName&&a.nodeName.toUpperCase()===b.toUpperCase()},each:function(a,c,d){var f,g=0,h=a.length,i=h===b||e.isFunction(a);if(d){if(i){for(f in a)if(c.apply(a[f],d)===!1)break}else for(;g<h;)if(c.apply(a[g++],d)===!1)break}else if(i){for(f in a)if(c.call(a[f],f,a[f])===!1)break}else for(;g<h;)if(c.call(a[g],g,a[g++])===!1)break;return a},trim:G?function(a){return a==null?"":G.call(a)}:function(a){return a==null?"":(a+"").replace(k,"").replace(l,"")},makeArray:function(a,b){var c=b||[];if(a!=null){var d=e.type(a);a.length==null||d==="string"||d==="function"||d==="regexp"||e.isWindow(a)?E.call(c,a):e.merge(c,a)}return c},inArray:function(a,b,c){var d;if(b){if(H)return H.call(b,a,c);d=b.length,c=c?c<0?Math.max(0,d+c):c:0;for(;c<d;c++)if(c in b&&b[c]===a)return c}return-1},merge:function(a,c){var d=a.length,e=0;if(typeof c.length=="number")for(var f=c.length;e<f;e++)a[d++]=c[e];else while(c[e]!==b)a[d++]=c[e++];a.length=d;return a},grep:function(a,b,c){var d=[],e;c=!!c;for(var f=0,g=a.length;f<g;f++)e=!!b(a[f],f),c!==e&&d.push(a[f]);return d},map:function(a,c,d){var f,g,h=[],i=0,j=a.length,k=a instanceof e||j!==b&&typeof j=="number"&&(j>0&&a[0]&&a[j-1]||j===0||e.isArray(a));if(k)for(;i<j;i++)f=c(a[i],i,d),f!=null&&(h[h.length]=f);else for(g in a)f=c(a[g],g,d),f!=null&&(h[h.length]=f);return h.concat.apply([],h)},guid:1,proxy:function(a,c){if(typeof c=="string"){var d=a[c];c=a,a=d}if(!e.isFunction(a))return b;var f=F.call(arguments,2),g=function(){return a.apply(c,f.concat(F.call(arguments)))};g.guid=a.guid=a.guid||g.guid||e.guid++;return g},access:function(a,c,d,f,g,h){var i=a.length;if(typeof c=="object"){for(var j in c)e.access(a,j,c[j],f,g,d);return a}if(d!==b){f=!h&&f&&e.isFunction(d);for(var k=0;k<i;k++)g(a[k],c,f?d.call(a[k],k,g(a[k],c)):d,h);return a}return i?g(a[0],c):b},now:function(){return(new Date).getTime()},uaMatch:function(a){a=a.toLowerCase();var b=r.exec(a)||s.exec(a)||t.exec(a)||a.indexOf("compatible")<0&&u.exec(a)||[];return{browser:b[1]||"",version:b[2]||"0"}},sub:function(){function a(b,c){return new a.fn.init(b,c)}e.extend(!0,a,this),a.superclass=this,a.fn=a.prototype=this(),a.fn.constructor=a,a.sub=this.sub,a.fn.init=function(d,f){f&&f instanceof e&&!(f instanceof a)&&(f=a(f));return e.fn.init.call(this,d,f,b)},a.fn.init.prototype=a.fn;var b=a(c);return a},browser:{}}),e.each("Boolean Number String Function Array Date RegExp Object".split(" "),function(a,b){I["[object "+b+"]"]=b.toLowerCase()}),z=e.uaMatch(y),z.browser&&(e.browser[z.browser]=!0,e.browser.version=z.version),e.browser.webkit&&(e.browser.safari=!0),j.test(" ")&&(k=/^[\s\xA0]+/,l=/[\s\xA0]+$/),h=e(c),c.addEventListener?B=function(){c.removeEventListener("DOMContentLoaded",B,!1),e.ready()}:c.attachEvent&&(B=function(){c.readyState==="complete"&&(c.detachEvent("onreadystatechange",B),e.ready())});return e}(),g={};f.Callbacks=function(a){a=a?g[a]||h(a):{};var c=[],d=[],e,i,j,k,l,m=function(b){var d,e,g,h,i;for(d=0,e=b.length;d<e;d++)g=b[d],h=f.type(g),h==="array"?m(g):h==="function"&&(!a.unique||!o.has(g))&&c.push(g)},n=function(b,f){f=f||[],e=!a.memory||[b,f],i=!0,l=j||0,j=0,k=c.length;for(;c&&l<k;l++)if(c[l].apply(b,f)===!1&&a.stopOnFalse){e=!0;break}i=!1,c&&(a.once?e===!0?o.disable():c=[]:d&&d.length&&(e=d.shift(),o.fireWith(e[0],e[1])))},o={add:function(){if(c){var a=c.length;m(arguments),i?k=c.length:e&&e!==!0&&(j=a,n(e[0],e[1]))}return this},remove:function(){if(c){var b=arguments,d=0,e=b.length;for(;d<e;d++)for(var f=0;f<c.length;f++)if(b[d]===c[f]){i&&f<=k&&(k--,f<=l&&l--),c.splice(f--,1);if(a.unique)break}}return this},has:function(a){if(c){var b=0,d=c.length;for(;b<d;b++)if(a===c[b])return!0}return!1},empty:function(){c=[];return this},disable:function(){c=d=e=b;return this},disabled:function(){return!c},lock:function(){d=b,(!e||e===!0)&&o.disable();return this},locked:function(){return!d},fireWith:function(b,c){d&&(i?a.once||d.push([b,c]):(!a.once||!e)&&n(b,c));return this},fire:function(){o.fireWith(this,arguments);return this},fired:function(){return!!e}};return o};var i=[].slice;f.extend({Deferred:function(a){var b=f.Callbacks("once memory"),c=f.Callbacks("once memory"),d=f.Callbacks("memory"),e="pending",g={resolve:b,reject:c,notify:d},h={done:b.add,fail:c.add,progress:d.add,state:function(){return e},isResolved:b.fired,isRejected:c.fired,then:function(a,b,c){i.done(a).fail(b).progress(c);return this},always:function(){i.done.apply(i,arguments).fail.apply(i,arguments);return this},pipe:function(a,b,c){return f.Deferred(function(d){f.each({done:[a,"resolve"],fail:[b,"reject"],progress:[c,"notify"]},function(a,b){var c=b[0],e=b[1],g;f.isFunction(c)?i[a](function(){g=c.apply(this,arguments),g&&f.isFunction(g.promise)?g.promise().then(d.resolve,d.reject,d.notify):d[e+"With"](this===i?d:this,[g])}):i[a](d[e])})}).promise()},promise:function(a){if(a==null)a=h;else for(var b in h)a[b]=h[b];return a}},i=h.promise({}),j;for(j in g)i[j]=g[j].fire,i[j+"With"]=g[j].fireWith;i.done(function(){e="resolved"},c.disable,d.lock).fail(function(){e="rejected"},b.disable,d.lock),a&&a.call(i,i);return i},when:function(a){function m(a){return function(b){e[a]=arguments.length>1?i.call(arguments,0):b,j.notifyWith(k,e)}}function l(a){return function(c){b[a]=arguments.length>1?i.call(arguments,0):c,--g||j.resolveWith(j,b)}}var b=i.call(arguments,0),c=0,d=b.length,e=Array(d),g=d,h=d,j=d<=1&&a&&f.isFunction(a.promise)?a:f.Deferred(),k=j.promise();if(d>1){for(;c<d;c++)b[c]&&b[c].promise&&f.isFunction(b[c].promise)?b[c].promise().then(l(c),j.reject,m(c)):--g;g||j.resolveWith(j,b)}else j!==a&&j.resolveWith(j,d?[a]:[]);return k}}),f.support=function(){var b,d,e,g,h,i,j,k,l,m,n,o,p,q=c.createElement("div"),r=c.documentElement;q.setAttribute("className","t"),q.innerHTML="   <link/><table></table><a href='/a' style='top:1px;float:left;opacity:.55;'>a</a><input type='checkbox'/>",d=q.getElementsByTagName("*"),e=q.getElementsByTagName("a")[0];if(!d||!d.length||!e)return{};g=c.createElement("select"),h=g.appendChild(c.createElement("option")),i=q.getElementsByTagName("input")[0],b={leadingWhitespace:q.firstChild.nodeType===3,tbody:!q.getElementsByTagName("tbody").length,htmlSerialize:!!q.getElementsByTagName("link").length,style:/top/.test(e.getAttribute("style")),hrefNormalized:e.getAttribute("href")==="/a",opacity:/^0.55/.test(e.style.opacity),cssFloat:!!e.style.cssFloat,checkOn:i.value==="on",optSelected:h.selected,getSetAttribute:q.className!=="t",enctype:!!c.createElement("form").enctype,html5Clone:c.createElement("nav").cloneNode(!0).outerHTML!=="<:nav></:nav>",submitBubbles:!0,changeBubbles:!0,focusinBubbles:!1,deleteExpando:!0,noCloneEvent:!0,inlineBlockNeedsLayout:!1,shrinkWrapBlocks:!1,reliableMarginRight:!0},i.checked=!0,b.noCloneChecked=i.cloneNode(!0).checked,g.disabled=!0,b.optDisabled=!h.disabled;try{delete q.test}catch(s){b.deleteExpando=!1}!q.addEventListener&&q.attachEvent&&q.fireEvent&&(q.attachEvent("onclick",function(){b.noCloneEvent=!1}),q.cloneNode(!0).fireEvent("onclick")),i=c.createElement("input"),i.value="t",i.setAttribute("type","radio"),b.radioValue=i.value==="t",i.setAttribute("checked","checked"),q.appendChild(i),k=c.createDocumentFragment(),k.appendChild(q.lastChild),b.checkClone=k.cloneNode(!0).cloneNode(!0).lastChild.checked,b.appendChecked=i.checked,k.removeChild(i),k.appendChild(q),q.innerHTML="",a.getComputedStyle&&(j=c.createElement("div"),j.style.width="0",j.style.marginRight="0",q.style.width="2px",q.appendChild(j),b.reliableMarginRight=(parseInt((a.getComputedStyle(j,null)||{marginRight:0}).marginRight,10)||0)===0);if(q.attachEvent)for(o in{submit:1,change:1,focusin:1})n="on"+o,p=n in q,p||(q.setAttribute(n,"return;"),p=typeof q[n]=="function"),b[o+"Bubbles"]=p;k.removeChild(q),k=g=h=j=q=i=null,f(function(){var a,d,e,g,h,i,j,k,m,n,o,r=c.getElementsByTagName("body")[0];!r||(j=1,k="position:absolute;top:0;left:0;width:1px;height:1px;margin:0;",m="visibility:hidden;border:0;",n="style='"+k+"border:5px solid #000;padding:0;'",o="<div "+n+"><div></div></div>"+"<table "+n+" cellpadding='0' cellspacing='0'>"+"<tr><td></td></tr></table>",a=c.createElement("div"),a.style.cssText=m+"width:0;height:0;position:static;top:0;margin-top:"+j+"px",r.insertBefore(a,r.firstChild),q=c.createElement("div"),a.appendChild(q),q.innerHTML="<table><tr><td style='padding:0;border:0;display:none'></td><td>t</td></tr></table>",l=q.getElementsByTagName("td"),p=l[0].offsetHeight===0,l[0].style.display="",l[1].style.display="none",b.reliableHiddenOffsets=p&&l[0].offsetHeight===0,q.innerHTML="",q.style.width=q.style.paddingLeft="1px",f.boxModel=b.boxModel=q.offsetWidth===2,typeof q.style.zoom!="undefined"&&(q.style.display="inline",q.style.zoom=1,b.inlineBlockNeedsLayout=q.offsetWidth===2,q.style.display="",q.innerHTML="<div style='width:4px;'></div>",b.shrinkWrapBlocks=q.offsetWidth!==2),q.style.cssText=k+m,q.innerHTML=o,d=q.firstChild,e=d.firstChild,h=d.nextSibling.firstChild.firstChild,i={doesNotAddBorder:e.offsetTop!==5,doesAddBorderForTableAndCells:h.offsetTop===5},e.style.position="fixed",e.style.top="20px",i.fixedPosition=e.offsetTop===20||e.offsetTop===15,e.style.position=e.style.top="",d.style.overflow="hidden",d.style.position="relative",i.subtractsBorderForOverflowNotVisible=e.offsetTop===-5,i.doesNotIncludeMarginInBodyOffset=r.offsetTop!==j,r.removeChild(a),q=a=null,f.extend(b,i))});return b}();var j=/^(?:\{.*\}|\[.*\])$/,k=/([A-Z])/g;f.extend({cache:{},uuid:0,expando:"jQuery"+(f.fn.jquery+Math.random()).replace(/\D/g,""),noData:{embed:!0,object:"clsid:D27CDB6E-AE6D-11cf-96B8-444553540000",applet:!0},hasData:function(a){a=a.nodeType?f.cache[a[f.expando]]:a[f.expando];return!!a&&!m(a)},data:function(a,c,d,e){if(!!f.acceptData(a)){var g,h,i,j=f.expando,k=typeof c=="string",l=a.nodeType,m=l?f.cache:a,n=l?a[j]:a[j]&&j,o=c==="events";if((!n||!m[n]||!o&&!e&&!m[n].data)&&k&&d===b)return;n||(l?a[j]=n=++f.uuid:n=j),m[n]||(m[n]={},l||(m[n].toJSON=f.noop));if(typeof c=="object"||typeof c=="function")e?m[n]=f.extend(m[n],c):m[n].data=f.extend(m[n].data,c);g=h=m[n],e||(h.data||(h.data={}),h=h.data),d!==b&&(h[f.camelCase(c)]=d);if(o&&!h[c])return g.events;k?(i=h[c],i==null&&(i=h[f.camelCase(c)])):i=h;return i}},removeData:function(a,b,c){if(!!f.acceptData(a)){var d,e,g,h=f.expando,i=a.nodeType,j=i?f.cache:a,k=i?a[h]:h;if(!j[k])return;if(b){d=c?j[k]:j[k].data;if(d){f.isArray(b)||(b in d?b=[b]:(b=f.camelCase(b),b in d?b=[b]:b=b.split(" ")));for(e=0,g=b.length;e<g;e++)delete d[b[e]];if(!(c?m:f.isEmptyObject)(d))return}}if(!c){delete j[k].data;if(!m(j[k]))return}f.support.deleteExpando||!j.setInterval?delete j[k]:j[k]=null,i&&(f.support.deleteExpando?delete a[h]:a.removeAttribute?a.removeAttribute(h):a[h]=null)}},_data:function(a,b,c){return f.data(a,b,c,!0)},acceptData:function(a){if(a.nodeName){var b=f.noData[a.nodeName.toLowerCase()];if(b)return b!==!0&&a.getAttribute("classid")===b}return!0}}),f.fn.extend({data:function(a,c){var d,e,g,h=null;if(typeof a=="undefined"){if(this.length){h=f.data(this[0]);if(this[0].nodeType===1&&!f._data(this[0],"parsedAttrs")){e=this[0].attributes;for(var i=0,j=e.length;i<j;i++)g=e[i].name,g.indexOf("data-")===0&&(g=f.camelCase(g.substring(5)),l(this[0],g,h[g]));f._data(this[0],"parsedAttrs",!0)}}return h}if(typeof a=="object")return this.each(function(){f.data(this,a)});d=a.split("."),d[1]=d[1]?"."+d[1]:"";if(c===b){h=this.triggerHandler("getData"+d[1]+"!",[d[0]]),h===b&&this.length&&(h=f.data(this[0],a),h=l(this[0],a,h));return h===b&&d[1]?this.data(d[0]):h}return this.each(function(){var b=f(this),e=[d[0],c];b.triggerHandler("setData"+d[1]+"!",e),f.data(this,a,c),b.triggerHandler("changeData"+d[1]+"!",e)})},removeData:function(a){return this.each(function(){f.removeData(this,a)})}}),f.extend({_mark:function(a,b){a&&(b=(b||"fx")+"mark",f._data(a,b,(f._data(a,b)||0)+1))},_unmark:function(a,b,c){a!==!0&&(c=b,b=a,a=!1);if(b){c=c||"fx";var d=c+"mark",e=a?0:(f._data(b,d)||1)-1;e?f._data(b,d,e):(f.removeData(b,d,!0),n(b,c,"mark"))}},queue:function(a,b,c){var d;if(a){b=(b||"fx")+"queue",d=f._data(a,b),c&&(!d||f.isArray(c)?d=f._data(a,b,f.makeArray(c)):d.push(c));return d||[]}},dequeue:function(a,b){b=b||"fx";var c=f.queue(a,b),d=c.shift(),e={};d==="inprogress"&&(d=c.shift()),d&&(b==="fx"&&c.unshift("inprogress"),f._data(a,b+".run",e),d.call(a,function(){f.dequeue(a,b)},e)),c.length||(f.removeData(a,b+"queue "+b+".run",!0),n(a,b,"queue"))}}),f.fn.extend({queue:function(a,c){typeof a!="string"&&(c=a,a="fx");if(c===b)return f.queue(this[0],a);return this.each(function(){var b=f.queue(this,a,c);a==="fx"&&b[0]!=="inprogress"&&f.dequeue(this,a)})},dequeue:function(a){return this.each(function(){f.dequeue(this,a)})},delay:function(a,b){a=f.fx?f.fx.speeds[a]||a:a,b=b||"fx";return this.queue(b,function(b,c){var d=setTimeout(b,a);c.stop=function(){clearTimeout(d)}})},clearQueue:function(a){return this.queue(a||"fx",[])},promise:function(a,c){function m(){--h||d.resolveWith(e,[e])}typeof a!="string"&&(c=a,a=b),a=a||"fx";var d=f.Deferred(),e=this,g=e.length,h=1,i=a+"defer",j=a+"queue",k=a+"mark",l;while(g--)if(l=f.data(e[g],i,b,!0)||(f.data(e[g],j,b,!0)||f.data(e[g],k,b,!0))&&f.data(e[g],i,f.Callbacks("once memory"),!0))h++,l.add(m);m();return d.promise()}});var o=/[\n\t\r]/g,p=/\s+/,q=/\r/g,r=/^(?:button|input)$/i,s=/^(?:button|input|object|select|textarea)$/i,t=/^a(?:rea)?$/i,u=/^(?:autofocus|autoplay|async|checked|controls|defer|disabled|hidden|loop|multiple|open|readonly|required|scoped|selected)$/i,v=f.support.getSetAttribute,w,x,y;f.fn.extend({attr:function(a,b){return f.access(this,a,b,!0,f.attr)},removeAttr:function(a){return this.each(function(){f.removeAttr(this,a)})},prop:function(a,b){return f.access(this,a,b,!0,f.prop)},removeProp:function(a){a=f.propFix[a]||a;return this.each(function(){try{this[a]=b,delete this[a]}catch(c){}})},addClass:function(a){var b,c,d,e,g,h,i;if(f.isFunction(a))return this.each(function(b){f(this).addClass(a.call(this,b,this.className))});if(a&&typeof a=="string"){b=a.split(p);for(c=0,d=this.length;c<d;c++){e=this[c];if(e.nodeType===1)if(!e.className&&b.length===1)e.className=a;else{g=" "+e.className+" ";for(h=0,i=b.length;h<i;h++)~g.indexOf(" "+b[h]+" ")||(g+=b[h]+" ");e.className=f.trim(g)}}}return this},removeClass:function(a){var c,d,e,g,h,i,j;if(f.isFunction(a))return this.each(function(b){f(this).removeClass(a.call(this,b,this.className))});if(a&&typeof a=="string"||a===b){c=(a||"").split(p);for(d=0,e=this.length;d<e;d++){g=this[d];if(g.nodeType===1&&g.className)if(a){h=(" "+g.className+" ").replace(o," ");for(i=0,j=c.length;i<j;i++)h=h.replace(" "+c[i]+" "," ");g.className=f.trim(h)}else g.className=""}}return this},toggleClass:function(a,b){var c=typeof a,d=typeof b=="boolean";if(f.isFunction(a))return this.each(function(c){f(this).toggleClass(a.call(this,c,this.className,b),b)});return this.each(function(){if(c==="string"){var e,g=0,h=f(this),i=b,j=a.split(p);while(e=j[g++])i=d?i:!h.hasClass(e),h[i?"addClass":"removeClass"](e)}else if(c==="undefined"||c==="boolean")this.className&&f._data(this,"__className__",this.className),this.className=this.className||a===!1?"":f._data(this,"__className__")||""})},hasClass:function(a){var b=" "+a+" ",c=0,d=this.length;for(;c<d;c++)if(this[c].nodeType===1&&(" "+this[c].className+" ").replace(o," ").indexOf(b)>-1)return!0;return!1},val:function(a){var c,d,e,g=this[0];{if(!!arguments.length){e=f.isFunction(a);return this.each(function(d){var g=f(this),h;if(this.nodeType===1){e?h=a.call(this,d,g.val()):h=a,h==null?h="":typeof h=="number"?h+="":f.isArray(h)&&(h=f.map(h,function(a){return a==null?"":a+""})),c=f.valHooks[this.nodeName.toLowerCase()]||f.valHooks[this.type];if(!c||!("set"in c)||c.set(this,h,"value")===b)this.value=h}})}if(g){c=f.valHooks[g.nodeName.toLowerCase()]||f.valHooks[g.type];if(c&&"get"in c&&(d=c.get(g,"value"))!==b)return d;d=g.value;return typeof d=="string"?d.replace(q,""):d==null?"":d}}}}),f.extend({valHooks:{option:{get:function(a){var b=a.attributes.value;return!b||b.specified?a.value:a.text}},select:{get:function(a){var b,c,d,e,g=a.selectedIndex,h=[],i=a.options,j=a.type==="select-one";if(g<0)return null;c=j?g:0,d=j?g+1:i.length;for(;c<d;c++){e=i[c];if(e.selected&&(f.support.optDisabled?!e.disabled:e.getAttribute("disabled")===null)&&(!e.parentNode.disabled||!f.nodeName(e.parentNode,"optgroup"))){b=f(e).val();if(j)return b;h.push(b)}}if(j&&!h.length&&i.length)return f(i[g]).val();return h},set:function(a,b){var c=f.makeArray(b);f(a).find("option").each(function(){this.selected=f.inArray(f(this).val(),c)>=0}),c.length||(a.selectedIndex=-1);return c}}},attrFn:{val:!0,css:!0,html:!0,text:!0,data:!0,width:!0,height:!0,offset:!0},attr:function(a,c,d,e){var g,h,i,j=a.nodeType;if(!!a&&j!==3&&j!==8&&j!==2){if(e&&c in f.attrFn)return f(a)[c](d);if(typeof a.getAttribute=="undefined")return f.prop(a,c,d);i=j!==1||!f.isXMLDoc(a),i&&(c=c.toLowerCase(),h=f.attrHooks[c]||(u.test(c)?x:w));if(d!==b){if(d===null){f.removeAttr(a,c);return}if(h&&"set"in h&&i&&(g=h.set(a,d,c))!==b)return g;a.setAttribute(c,""+d);return d}if(h&&"get"in h&&i&&(g=h.get(a,c))!==null)return g;g=a.getAttribute(c);return g===null?b:g}},removeAttr:function(a,b){var c,d,e,g,h=0;if(b&&a.nodeType===1){d=b.toLowerCase().split(p),g=d.length;for(;h<g;h++)e=d[h],e&&(c=f.propFix[e]||e,f.attr(a,e,""),a.removeAttribute(v?e:c),u.test(e)&&c in a&&(a[c]=!1))}},attrHooks:{type:{set:function(a,b){if(r.test(a.nodeName)&&a.parentNode)f.error("type property can't be changed");else if(!f.support.radioValue&&b==="radio"&&f.nodeName(a,"input")){var c=a.value;a.setAttribute("type",b),c&&(a.value=c);return b}}},value:{get:function(a,b){if(w&&f.nodeName(a,"button"))return w.get(a,b);return b in a?a.value:null},set:function(a,b,c){if(w&&f.nodeName(a,"button"))return w.set(a,b,c);a.value=b}}},propFix:{tabindex:"tabIndex",readonly:"readOnly","for":"htmlFor","class":"className",maxlength:"maxLength",cellspacing:"cellSpacing",cellpadding:"cellPadding",rowspan:"rowSpan",colspan:"colSpan",usemap:"useMap",frameborder:"frameBorder",contenteditable:"contentEditable"},prop:function(a,c,d){var e,g,h,i=a.nodeType;if(!!a&&i!==3&&i!==8&&i!==2){h=i!==1||!f.isXMLDoc(a),h&&(c=f.propFix[c]||c,g=f.propHooks[c]);return d!==b?g&&"set"in g&&(e=g.set(a,d,c))!==b?e:a[c]=d:g&&"get"in g&&(e=g.get(a,c))!==null?e:a[c]}},propHooks:{tabIndex:{get:function(a){var c=a.getAttributeNode("tabindex");return c&&c.specified?parseInt(c.value,10):s.test(a.nodeName)||t.test(a.nodeName)&&a.href?0:b}}}}),f.attrHooks.tabindex=f.propHooks.tabIndex,x={get:function(a,c){var d,e=f.prop(a,c);return e===!0||typeof e!="boolean"&&(d=a.getAttributeNode(c))&&d.nodeValue!==!1?c.toLowerCase():b},set:function(a,b,c){var d;b===!1?f.removeAttr(a,c):(d=f.propFix[c]||c,d in a&&(a[d]=!0),a.setAttribute(c,c.toLowerCase()));return c}},v||(y={name:!0,id:!0},w=f.valHooks.button={get:function(a,c){var d;d=a.getAttributeNode(c);return d&&(y[c]?d.nodeValue!=="":d.specified)?d.nodeValue:b},set:function(a,b,d){var e=a.getAttributeNode(d);e||(e=c.createAttribute(d),a.setAttributeNode(e));return e.nodeValue=b+""}},f.attrHooks.tabindex.set=w.set,f.each(["width","height"],function(a,b){f.attrHooks[b]=f.extend(f.attrHooks[b],{set:function(a,c){if(c===""){a.setAttribute(b,"auto");return c}}})}),f.attrHooks.contenteditable={get:w.get,set:function(a,b,c){b===""&&(b="false"),w.set(a,b,c)}}),f.support.hrefNormalized||f.each(["href","src","width","height"],function(a,c){f.attrHooks[c]=f.extend(f.attrHooks[c],{get:function(a){var d=a.getAttribute(c,2);return d===null?b:d}})}),f.support.style||(f.attrHooks.style={get:function(a){return a.style.cssText.toLowerCase()||b},set:function(a,b){return a.style.cssText=""+b}}),f.support.optSelected||(f.propHooks.selected=f.extend(f.propHooks.selected,{get:function(a){var b=a.parentNode;b&&(b.selectedIndex,b.parentNode&&b.parentNode.selectedIndex);return null}})),f.support.enctype||(f.propFix.enctype="encoding"),f.support.checkOn||f.each(["radio","checkbox"],function(){f.valHooks[this]={get:function(a){return a.getAttribute("value")===null?"on":a.value}}}),f.each(["radio","checkbox"],function(){f.valHooks[this]=f.extend(f.valHooks[this],{set:function(a,b){if(f.isArray(b))return a.checked=f.inArray(f(a).val(),b)>=0}})});var z=/^(?:textarea|input|select)$/i,A=/^([^\.]*)?(?:\.(.+))?$/,B=/\bhover(\.\S+)?\b/,C=/^key/,D=/^(?:mouse|contextmenu)|click/,E=/^(?:focusinfocus|focusoutblur)$/,F=/^(\w*)(?:#([\w\-]+))?(?:\.([\w\-]+))?$/,G=function(a){var b=F.exec(a);b&&(b[1]=(b[1]||"").toLowerCase(),b[3]=b[3]&&new RegExp("(?:^|\\s)"+b[3]+"(?:\\s|$)"));return b},H=function(a,b){var c=a.attributes||{};return(!b[1]||a.nodeName.toLowerCase()===b[1])&&(!b[2]||(c.id||{}).value===b[2])&&(!b[3]||b[3].test((c["class"]||{}).value))},I=function(a){return f.event.special.hover?a:a.replace(B,"mouseenter$1 mouseleave$1")};
f.event={add:function(a,c,d,e,g){var h,i,j,k,l,m,n,o,p,q,r,s;if(!(a.nodeType===3||a.nodeType===8||!c||!d||!(h=f._data(a)))){d.handler&&(p=d,d=p.handler),d.guid||(d.guid=f.guid++),j=h.events,j||(h.events=j={}),i=h.handle,i||(h.handle=i=function(a){return typeof f!="undefined"&&(!a||f.event.triggered!==a.type)?f.event.dispatch.apply(i.elem,arguments):b},i.elem=a),c=f.trim(I(c)).split(" ");for(k=0;k<c.length;k++){l=A.exec(c[k])||[],m=l[1],n=(l[2]||"").split(".").sort(),s=f.event.special[m]||{},m=(g?s.delegateType:s.bindType)||m,s=f.event.special[m]||{},o=f.extend({type:m,origType:l[1],data:e,handler:d,guid:d.guid,selector:g,quick:G(g),namespace:n.join(".")},p),r=j[m];if(!r){r=j[m]=[],r.delegateCount=0;if(!s.setup||s.setup.call(a,e,n,i)===!1)a.addEventListener?a.addEventListener(m,i,!1):a.attachEvent&&a.attachEvent("on"+m,i)}s.add&&(s.add.call(a,o),o.handler.guid||(o.handler.guid=d.guid)),g?r.splice(r.delegateCount++,0,o):r.push(o),f.event.global[m]=!0}a=null}},global:{},remove:function(a,b,c,d,e){var g=f.hasData(a)&&f._data(a),h,i,j,k,l,m,n,o,p,q,r,s;if(!!g&&!!(o=g.events)){b=f.trim(I(b||"")).split(" ");for(h=0;h<b.length;h++){i=A.exec(b[h])||[],j=k=i[1],l=i[2];if(!j){for(j in o)f.event.remove(a,j+b[h],c,d,!0);continue}p=f.event.special[j]||{},j=(d?p.delegateType:p.bindType)||j,r=o[j]||[],m=r.length,l=l?new RegExp("(^|\\.)"+l.split(".").sort().join("\\.(?:.*\\.)?")+"(\\.|$)"):null;for(n=0;n<r.length;n++)s=r[n],(e||k===s.origType)&&(!c||c.guid===s.guid)&&(!l||l.test(s.namespace))&&(!d||d===s.selector||d==="**"&&s.selector)&&(r.splice(n--,1),s.selector&&r.delegateCount--,p.remove&&p.remove.call(a,s));r.length===0&&m!==r.length&&((!p.teardown||p.teardown.call(a,l)===!1)&&f.removeEvent(a,j,g.handle),delete o[j])}f.isEmptyObject(o)&&(q=g.handle,q&&(q.elem=null),f.removeData(a,["events","handle"],!0))}},customEvent:{getData:!0,setData:!0,changeData:!0},trigger:function(c,d,e,g){if(!e||e.nodeType!==3&&e.nodeType!==8){var h=c.type||c,i=[],j,k,l,m,n,o,p,q,r,s;if(E.test(h+f.event.triggered))return;h.indexOf("!")>=0&&(h=h.slice(0,-1),k=!0),h.indexOf(".")>=0&&(i=h.split("."),h=i.shift(),i.sort());if((!e||f.event.customEvent[h])&&!f.event.global[h])return;c=typeof c=="object"?c[f.expando]?c:new f.Event(h,c):new f.Event(h),c.type=h,c.isTrigger=!0,c.exclusive=k,c.namespace=i.join("."),c.namespace_re=c.namespace?new RegExp("(^|\\.)"+i.join("\\.(?:.*\\.)?")+"(\\.|$)"):null,o=h.indexOf(":")<0?"on"+h:"";if(!e){j=f.cache;for(l in j)j[l].events&&j[l].events[h]&&f.event.trigger(c,d,j[l].handle.elem,!0);return}c.result=b,c.target||(c.target=e),d=d!=null?f.makeArray(d):[],d.unshift(c),p=f.event.special[h]||{};if(p.trigger&&p.trigger.apply(e,d)===!1)return;r=[[e,p.bindType||h]];if(!g&&!p.noBubble&&!f.isWindow(e)){s=p.delegateType||h,m=E.test(s+h)?e:e.parentNode,n=null;for(;m;m=m.parentNode)r.push([m,s]),n=m;n&&n===e.ownerDocument&&r.push([n.defaultView||n.parentWindow||a,s])}for(l=0;l<r.length&&!c.isPropagationStopped();l++)m=r[l][0],c.type=r[l][1],q=(f._data(m,"events")||{})[c.type]&&f._data(m,"handle"),q&&q.apply(m,d),q=o&&m[o],q&&f.acceptData(m)&&q.apply(m,d)===!1&&c.preventDefault();c.type=h,!g&&!c.isDefaultPrevented()&&(!p._default||p._default.apply(e.ownerDocument,d)===!1)&&(h!=="click"||!f.nodeName(e,"a"))&&f.acceptData(e)&&o&&e[h]&&(h!=="focus"&&h!=="blur"||c.target.offsetWidth!==0)&&!f.isWindow(e)&&(n=e[o],n&&(e[o]=null),f.event.triggered=h,e[h](),f.event.triggered=b,n&&(e[o]=n));return c.result}},dispatch:function(c){c=f.event.fix(c||a.event);var d=(f._data(this,"events")||{})[c.type]||[],e=d.delegateCount,g=[].slice.call(arguments,0),h=!c.exclusive&&!c.namespace,i=[],j,k,l,m,n,o,p,q,r,s,t;g[0]=c,c.delegateTarget=this;if(e&&!c.target.disabled&&(!c.button||c.type!=="click")){m=f(this),m.context=this.ownerDocument||this;for(l=c.target;l!=this;l=l.parentNode||this){o={},q=[],m[0]=l;for(j=0;j<e;j++)r=d[j],s=r.selector,o[s]===b&&(o[s]=r.quick?H(l,r.quick):m.is(s)),o[s]&&q.push(r);q.length&&i.push({elem:l,matches:q})}}d.length>e&&i.push({elem:this,matches:d.slice(e)});for(j=0;j<i.length&&!c.isPropagationStopped();j++){p=i[j],c.currentTarget=p.elem;for(k=0;k<p.matches.length&&!c.isImmediatePropagationStopped();k++){r=p.matches[k];if(h||!c.namespace&&!r.namespace||c.namespace_re&&c.namespace_re.test(r.namespace))c.data=r.data,c.handleObj=r,n=((f.event.special[r.origType]||{}).handle||r.handler).apply(p.elem,g),n!==b&&(c.result=n,n===!1&&(c.preventDefault(),c.stopPropagation()))}}return c.result},props:"attrChange attrName relatedNode srcElement altKey bubbles cancelable ctrlKey currentTarget eventPhase metaKey relatedTarget shiftKey target timeStamp view which".split(" "),fixHooks:{},keyHooks:{props:"char charCode key keyCode".split(" "),filter:function(a,b){a.which==null&&(a.which=b.charCode!=null?b.charCode:b.keyCode);return a}},mouseHooks:{props:"button buttons clientX clientY fromElement offsetX offsetY pageX pageY screenX screenY toElement".split(" "),filter:function(a,d){var e,f,g,h=d.button,i=d.fromElement;a.pageX==null&&d.clientX!=null&&(e=a.target.ownerDocument||c,f=e.documentElement,g=e.body,a.pageX=d.clientX+(f&&f.scrollLeft||g&&g.scrollLeft||0)-(f&&f.clientLeft||g&&g.clientLeft||0),a.pageY=d.clientY+(f&&f.scrollTop||g&&g.scrollTop||0)-(f&&f.clientTop||g&&g.clientTop||0)),!a.relatedTarget&&i&&(a.relatedTarget=i===a.target?d.toElement:i),!a.which&&h!==b&&(a.which=h&1?1:h&2?3:h&4?2:0);return a}},fix:function(a){if(a[f.expando])return a;var d,e,g=a,h=f.event.fixHooks[a.type]||{},i=h.props?this.props.concat(h.props):this.props;a=f.Event(g);for(d=i.length;d;)e=i[--d],a[e]=g[e];a.target||(a.target=g.srcElement||c),a.target.nodeType===3&&(a.target=a.target.parentNode),a.metaKey===b&&(a.metaKey=a.ctrlKey);return h.filter?h.filter(a,g):a},special:{ready:{setup:f.bindReady},load:{noBubble:!0},focus:{delegateType:"focusin"},blur:{delegateType:"focusout"},beforeunload:{setup:function(a,b,c){f.isWindow(this)&&(this.onbeforeunload=c)},teardown:function(a,b){this.onbeforeunload===b&&(this.onbeforeunload=null)}}},simulate:function(a,b,c,d){var e=f.extend(new f.Event,c,{type:a,isSimulated:!0,originalEvent:{}});d?f.event.trigger(e,null,b):f.event.dispatch.call(b,e),e.isDefaultPrevented()&&c.preventDefault()}},f.event.handle=f.event.dispatch,f.removeEvent=c.removeEventListener?function(a,b,c){a.removeEventListener&&a.removeEventListener(b,c,!1)}:function(a,b,c){a.detachEvent&&a.detachEvent("on"+b,c)},f.Event=function(a,b){if(!(this instanceof f.Event))return new f.Event(a,b);a&&a.type?(this.originalEvent=a,this.type=a.type,this.isDefaultPrevented=a.defaultPrevented||a.returnValue===!1||a.getPreventDefault&&a.getPreventDefault()?K:J):this.type=a,b&&f.extend(this,b),this.timeStamp=a&&a.timeStamp||f.now(),this[f.expando]=!0},f.Event.prototype={preventDefault:function(){this.isDefaultPrevented=K;var a=this.originalEvent;!a||(a.preventDefault?a.preventDefault():a.returnValue=!1)},stopPropagation:function(){this.isPropagationStopped=K;var a=this.originalEvent;!a||(a.stopPropagation&&a.stopPropagation(),a.cancelBubble=!0)},stopImmediatePropagation:function(){this.isImmediatePropagationStopped=K,this.stopPropagation()},isDefaultPrevented:J,isPropagationStopped:J,isImmediatePropagationStopped:J},f.each({mouseenter:"mouseover",mouseleave:"mouseout"},function(a,b){f.event.special[a]={delegateType:b,bindType:b,handle:function(a){var c=this,d=a.relatedTarget,e=a.handleObj,g=e.selector,h;if(!d||d!==c&&!f.contains(c,d))a.type=e.origType,h=e.handler.apply(this,arguments),a.type=b;return h}}}),f.support.submitBubbles||(f.event.special.submit={setup:function(){if(f.nodeName(this,"form"))return!1;f.event.add(this,"click._submit keypress._submit",function(a){var c=a.target,d=f.nodeName(c,"input")||f.nodeName(c,"button")?c.form:b;d&&!d._submit_attached&&(f.event.add(d,"submit._submit",function(a){this.parentNode&&!a.isTrigger&&f.event.simulate("submit",this.parentNode,a,!0)}),d._submit_attached=!0)})},teardown:function(){if(f.nodeName(this,"form"))return!1;f.event.remove(this,"._submit")}}),f.support.changeBubbles||(f.event.special.change={setup:function(){if(z.test(this.nodeName)){if(this.type==="checkbox"||this.type==="radio")f.event.add(this,"propertychange._change",function(a){a.originalEvent.propertyName==="checked"&&(this._just_changed=!0)}),f.event.add(this,"click._change",function(a){this._just_changed&&!a.isTrigger&&(this._just_changed=!1,f.event.simulate("change",this,a,!0))});return!1}f.event.add(this,"beforeactivate._change",function(a){var b=a.target;z.test(b.nodeName)&&!b._change_attached&&(f.event.add(b,"change._change",function(a){this.parentNode&&!a.isSimulated&&!a.isTrigger&&f.event.simulate("change",this.parentNode,a,!0)}),b._change_attached=!0)})},handle:function(a){var b=a.target;if(this!==b||a.isSimulated||a.isTrigger||b.type!=="radio"&&b.type!=="checkbox")return a.handleObj.handler.apply(this,arguments)},teardown:function(){f.event.remove(this,"._change");return z.test(this.nodeName)}}),f.support.focusinBubbles||f.each({focus:"focusin",blur:"focusout"},function(a,b){var d=0,e=function(a){f.event.simulate(b,a.target,f.event.fix(a),!0)};f.event.special[b]={setup:function(){d++===0&&c.addEventListener(a,e,!0)},teardown:function(){--d===0&&c.removeEventListener(a,e,!0)}}}),f.fn.extend({on:function(a,c,d,e,g){var h,i;if(typeof a=="object"){typeof c!="string"&&(d=c,c=b);for(i in a)this.on(i,c,d,a[i],g);return this}d==null&&e==null?(e=c,d=c=b):e==null&&(typeof c=="string"?(e=d,d=b):(e=d,d=c,c=b));if(e===!1)e=J;else if(!e)return this;g===1&&(h=e,e=function(a){f().off(a);return h.apply(this,arguments)},e.guid=h.guid||(h.guid=f.guid++));return this.each(function(){f.event.add(this,a,e,d,c)})},one:function(a,b,c,d){return this.on.call(this,a,b,c,d,1)},off:function(a,c,d){if(a&&a.preventDefault&&a.handleObj){var e=a.handleObj;f(a.delegateTarget).off(e.namespace?e.type+"."+e.namespace:e.type,e.selector,e.handler);return this}if(typeof a=="object"){for(var g in a)this.off(g,c,a[g]);return this}if(c===!1||typeof c=="function")d=c,c=b;d===!1&&(d=J);return this.each(function(){f.event.remove(this,a,d,c)})},bind:function(a,b,c){return this.on(a,null,b,c)},unbind:function(a,b){return this.off(a,null,b)},live:function(a,b,c){f(this.context).on(a,this.selector,b,c);return this},die:function(a,b){f(this.context).off(a,this.selector||"**",b);return this},delegate:function(a,b,c,d){return this.on(b,a,c,d)},undelegate:function(a,b,c){return arguments.length==1?this.off(a,"**"):this.off(b,a,c)},trigger:function(a,b){return this.each(function(){f.event.trigger(a,b,this)})},triggerHandler:function(a,b){if(this[0])return f.event.trigger(a,b,this[0],!0)},toggle:function(a){var b=arguments,c=a.guid||f.guid++,d=0,e=function(c){var e=(f._data(this,"lastToggle"+a.guid)||0)%d;f._data(this,"lastToggle"+a.guid,e+1),c.preventDefault();return b[e].apply(this,arguments)||!1};e.guid=c;while(d<b.length)b[d++].guid=c;return this.click(e)},hover:function(a,b){return this.mouseenter(a).mouseleave(b||a)}}),f.each("blur focus focusin focusout load resize scroll unload click dblclick mousedown mouseup mousemove mouseover mouseout mouseenter mouseleave change select submit keydown keypress keyup error contextmenu".split(" "),function(a,b){f.fn[b]=function(a,c){c==null&&(c=a,a=null);return arguments.length>0?this.on(b,null,a,c):this.trigger(b)},f.attrFn&&(f.attrFn[b]=!0),C.test(b)&&(f.event.fixHooks[b]=f.event.keyHooks),D.test(b)&&(f.event.fixHooks[b]=f.event.mouseHooks)}),function(){function x(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}if(j.nodeType===1){g||(j[d]=c,j.sizset=h);if(typeof b!="string"){if(j===b){k=!0;break}}else if(m.filter(b,[j]).length>0){k=j;break}}j=j[a]}e[h]=k}}}function w(a,b,c,e,f,g){for(var h=0,i=e.length;h<i;h++){var j=e[h];if(j){var k=!1;j=j[a];while(j){if(j[d]===c){k=e[j.sizset];break}j.nodeType===1&&!g&&(j[d]=c,j.sizset=h);if(j.nodeName.toLowerCase()===b){k=j;break}j=j[a]}e[h]=k}}}var a=/((?:\((?:\([^()]+\)|[^()]+)+\)|\[(?:\[[^\[\]]*\]|['"][^'"]*['"]|[^\[\]'"]+)+\]|\\.|[^ >+~,(\[\\]+)+|[>+~])(\s*,\s*)?((?:.|\r|\n)*)/g,d="sizcache"+(Math.random()+"").replace(".",""),e=0,g=Object.prototype.toString,h=!1,i=!0,j=/\\/g,k=/\r\n/g,l=/\W/;[0,0].sort(function(){i=!1;return 0});var m=function(b,d,e,f){e=e||[],d=d||c;var h=d;if(d.nodeType!==1&&d.nodeType!==9)return[];if(!b||typeof b!="string")return e;var i,j,k,l,n,q,r,t,u=!0,v=m.isXML(d),w=[],x=b;do{a.exec(""),i=a.exec(x);if(i){x=i[3],w.push(i[1]);if(i[2]){l=i[3];break}}}while(i);if(w.length>1&&p.exec(b))if(w.length===2&&o.relative[w[0]])j=y(w[0]+w[1],d,f);else{j=o.relative[w[0]]?[d]:m(w.shift(),d);while(w.length)b=w.shift(),o.relative[b]&&(b+=w.shift()),j=y(b,j,f)}else{!f&&w.length>1&&d.nodeType===9&&!v&&o.match.ID.test(w[0])&&!o.match.ID.test(w[w.length-1])&&(n=m.find(w.shift(),d,v),d=n.expr?m.filter(n.expr,n.set)[0]:n.set[0]);if(d){n=f?{expr:w.pop(),set:s(f)}:m.find(w.pop(),w.length===1&&(w[0]==="~"||w[0]==="+")&&d.parentNode?d.parentNode:d,v),j=n.expr?m.filter(n.expr,n.set):n.set,w.length>0?k=s(j):u=!1;while(w.length)q=w.pop(),r=q,o.relative[q]?r=w.pop():q="",r==null&&(r=d),o.relative[q](k,r,v)}else k=w=[]}k||(k=j),k||m.error(q||b);if(g.call(k)==="[object Array]")if(!u)e.push.apply(e,k);else if(d&&d.nodeType===1)for(t=0;k[t]!=null;t++)k[t]&&(k[t]===!0||k[t].nodeType===1&&m.contains(d,k[t]))&&e.push(j[t]);else for(t=0;k[t]!=null;t++)k[t]&&k[t].nodeType===1&&e.push(j[t]);else s(k,e);l&&(m(l,h,e,f),m.uniqueSort(e));return e};m.uniqueSort=function(a){if(u){h=i,a.sort(u);if(h)for(var b=1;b<a.length;b++)a[b]===a[b-1]&&a.splice(b--,1)}return a},m.matches=function(a,b){return m(a,null,null,b)},m.matchesSelector=function(a,b){return m(b,null,null,[a]).length>0},m.find=function(a,b,c){var d,e,f,g,h,i;if(!a)return[];for(e=0,f=o.order.length;e<f;e++){h=o.order[e];if(g=o.leftMatch[h].exec(a)){i=g[1],g.splice(1,1);if(i.substr(i.length-1)!=="\\"){g[1]=(g[1]||"").replace(j,""),d=o.find[h](g,b,c);if(d!=null){a=a.replace(o.match[h],"");break}}}}d||(d=typeof b.getElementsByTagName!="undefined"?b.getElementsByTagName("*"):[]);return{set:d,expr:a}},m.filter=function(a,c,d,e){var f,g,h,i,j,k,l,n,p,q=a,r=[],s=c,t=c&&c[0]&&m.isXML(c[0]);while(a&&c.length){for(h in o.filter)if((f=o.leftMatch[h].exec(a))!=null&&f[2]){k=o.filter[h],l=f[1],g=!1,f.splice(1,1);if(l.substr(l.length-1)==="\\")continue;s===r&&(r=[]);if(o.preFilter[h]){f=o.preFilter[h](f,s,d,r,e,t);if(!f)g=i=!0;else if(f===!0)continue}if(f)for(n=0;(j=s[n])!=null;n++)j&&(i=k(j,f,n,s),p=e^i,d&&i!=null?p?g=!0:s[n]=!1:p&&(r.push(j),g=!0));if(i!==b){d||(s=r),a=a.replace(o.match[h],"");if(!g)return[];break}}if(a===q)if(g==null)m.error(a);else break;q=a}return s},m.error=function(a){throw new Error("Syntax error, unrecognized expression: "+a)};var n=m.getText=function(a){var b,c,d=a.nodeType,e="";if(d){if(d===1||d===9){if(typeof a.textContent=="string")return a.textContent;if(typeof a.innerText=="string")return a.innerText.replace(k,"");for(a=a.firstChild;a;a=a.nextSibling)e+=n(a)}else if(d===3||d===4)return a.nodeValue}else for(b=0;c=a[b];b++)c.nodeType!==8&&(e+=n(c));return e},o=m.selectors={order:["ID","NAME","TAG"],match:{ID:/#((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,CLASS:/\.((?:[\w\u00c0-\uFFFF\-]|\\.)+)/,NAME:/\[name=['"]*((?:[\w\u00c0-\uFFFF\-]|\\.)+)['"]*\]/,ATTR:/\[\s*((?:[\w\u00c0-\uFFFF\-]|\\.)+)\s*(?:(\S?=)\s*(?:(['"])(.*?)\3|(#?(?:[\w\u00c0-\uFFFF\-]|\\.)*)|)|)\s*\]/,TAG:/^((?:[\w\u00c0-\uFFFF\*\-]|\\.)+)/,CHILD:/:(only|nth|last|first)-child(?:\(\s*(even|odd|(?:[+\-]?\d+|(?:[+\-]?\d*)?n\s*(?:[+\-]\s*\d+)?))\s*\))?/,POS:/:(nth|eq|gt|lt|first|last|even|odd)(?:\((\d*)\))?(?=[^\-]|$)/,PSEUDO:/:((?:[\w\u00c0-\uFFFF\-]|\\.)+)(?:\((['"]?)((?:\([^\)]+\)|[^\(\)]*)+)\2\))?/},leftMatch:{},attrMap:{"class":"className","for":"htmlFor"},attrHandle:{href:function(a){return a.getAttribute("href")},type:function(a){return a.getAttribute("type")}},relative:{"+":function(a,b){var c=typeof b=="string",d=c&&!l.test(b),e=c&&!d;d&&(b=b.toLowerCase());for(var f=0,g=a.length,h;f<g;f++)if(h=a[f]){while((h=h.previousSibling)&&h.nodeType!==1);a[f]=e||h&&h.nodeName.toLowerCase()===b?h||!1:h===b}e&&m.filter(b,a,!0)},">":function(a,b){var c,d=typeof b=="string",e=0,f=a.length;if(d&&!l.test(b)){b=b.toLowerCase();for(;e<f;e++){c=a[e];if(c){var g=c.parentNode;a[e]=g.nodeName.toLowerCase()===b?g:!1}}}else{for(;e<f;e++)c=a[e],c&&(a[e]=d?c.parentNode:c.parentNode===b);d&&m.filter(b,a,!0)}},"":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("parentNode",b,f,a,d,c)},"~":function(a,b,c){var d,f=e++,g=x;typeof b=="string"&&!l.test(b)&&(b=b.toLowerCase(),d=b,g=w),g("previousSibling",b,f,a,d,c)}},find:{ID:function(a,b,c){if(typeof b.getElementById!="undefined"&&!c){var d=b.getElementById(a[1]);return d&&d.parentNode?[d]:[]}},NAME:function(a,b){if(typeof b.getElementsByName!="undefined"){var c=[],d=b.getElementsByName(a[1]);for(var e=0,f=d.length;e<f;e++)d[e].getAttribute("name")===a[1]&&c.push(d[e]);return c.length===0?null:c}},TAG:function(a,b){if(typeof b.getElementsByTagName!="undefined")return b.getElementsByTagName(a[1])}},preFilter:{CLASS:function(a,b,c,d,e,f){a=" "+a[1].replace(j,"")+" ";if(f)return a;for(var g=0,h;(h=b[g])!=null;g++)h&&(e^(h.className&&(" "+h.className+" ").replace(/[\t\n\r]/g," ").indexOf(a)>=0)?c||d.push(h):c&&(b[g]=!1));return!1},ID:function(a){return a[1].replace(j,"")},TAG:function(a,b){return a[1].replace(j,"").toLowerCase()},CHILD:function(a){if(a[1]==="nth"){a[2]||m.error(a[0]),a[2]=a[2].replace(/^\+|\s*/g,"");var b=/(-?)(\d*)(?:n([+\-]?\d*))?/.exec(a[2]==="even"&&"2n"||a[2]==="odd"&&"2n+1"||!/\D/.test(a[2])&&"0n+"+a[2]||a[2]);a[2]=b[1]+(b[2]||1)-0,a[3]=b[3]-0}else a[2]&&m.error(a[0]);a[0]=e++;return a},ATTR:function(a,b,c,d,e,f){var g=a[1]=a[1].replace(j,"");!f&&o.attrMap[g]&&(a[1]=o.attrMap[g]),a[4]=(a[4]||a[5]||"").replace(j,""),a[2]==="~="&&(a[4]=" "+a[4]+" ");return a},PSEUDO:function(b,c,d,e,f){if(b[1]==="not")if((a.exec(b[3])||"").length>1||/^\w/.test(b[3]))b[3]=m(b[3],null,null,c);else{var g=m.filter(b[3],c,d,!0^f);d||e.push.apply(e,g);return!1}else if(o.match.POS.test(b[0])||o.match.CHILD.test(b[0]))return!0;return b},POS:function(a){a.unshift(!0);return a}},filters:{enabled:function(a){return a.disabled===!1&&a.type!=="hidden"},disabled:function(a){return a.disabled===!0},checked:function(a){return a.checked===!0},selected:function(a){a.parentNode&&a.parentNode.selectedIndex;return a.selected===!0},parent:function(a){return!!a.firstChild},empty:function(a){return!a.firstChild},has:function(a,b,c){return!!m(c[3],a).length},header:function(a){return/h\d/i.test(a.nodeName)},text:function(a){var b=a.getAttribute("type"),c=a.type;return a.nodeName.toLowerCase()==="input"&&"text"===c&&(b===c||b===null)},radio:function(a){return a.nodeName.toLowerCase()==="input"&&"radio"===a.type},checkbox:function(a){return a.nodeName.toLowerCase()==="input"&&"checkbox"===a.type},file:function(a){return a.nodeName.toLowerCase()==="input"&&"file"===a.type},password:function(a){return a.nodeName.toLowerCase()==="input"&&"password"===a.type},submit:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"submit"===a.type},image:function(a){return a.nodeName.toLowerCase()==="input"&&"image"===a.type},reset:function(a){var b=a.nodeName.toLowerCase();return(b==="input"||b==="button")&&"reset"===a.type},button:function(a){var b=a.nodeName.toLowerCase();return b==="input"&&"button"===a.type||b==="button"},input:function(a){return/input|select|textarea|button/i.test(a.nodeName)},focus:function(a){return a===a.ownerDocument.activeElement}},setFilters:{first:function(a,b){return b===0},last:function(a,b,c,d){return b===d.length-1},even:function(a,b){return b%2===0},odd:function(a,b){return b%2===1},lt:function(a,b,c){return b<c[3]-0},gt:function(a,b,c){return b>c[3]-0},nth:function(a,b,c){return c[3]-0===b},eq:function(a,b,c){return c[3]-0===b}},filter:{PSEUDO:function(a,b,c,d){var e=b[1],f=o.filters[e];if(f)return f(a,c,b,d);if(e==="contains")return(a.textContent||a.innerText||n([a])||"").indexOf(b[3])>=0;if(e==="not"){var g=b[3];for(var h=0,i=g.length;h<i;h++)if(g[h]===a)return!1;return!0}m.error(e)},CHILD:function(a,b){var c,e,f,g,h,i,j,k=b[1],l=a;switch(k){case"only":case"first":while(l=l.previousSibling)if(l.nodeType===1)return!1;if(k==="first")return!0;l=a;case"last":while(l=l.nextSibling)if(l.nodeType===1)return!1;return!0;case"nth":c=b[2],e=b[3];if(c===1&&e===0)return!0;f=b[0],g=a.parentNode;if(g&&(g[d]!==f||!a.nodeIndex)){i=0;for(l=g.firstChild;l;l=l.nextSibling)l.nodeType===1&&(l.nodeIndex=++i);g[d]=f}j=a.nodeIndex-e;return c===0?j===0:j%c===0&&j/c>=0}},ID:function(a,b){return a.nodeType===1&&a.getAttribute("id")===b},TAG:function(a,b){return b==="*"&&a.nodeType===1||!!a.nodeName&&a.nodeName.toLowerCase()===b},CLASS:function(a,b){return(" "+(a.className||a.getAttribute("class"))+" ").indexOf(b)>-1},ATTR:function(a,b){var c=b[1],d=m.attr?m.attr(a,c):o.attrHandle[c]?o.attrHandle[c](a):a[c]!=null?a[c]:a.getAttribute(c),e=d+"",f=b[2],g=b[4];return d==null?f==="!=":!f&&m.attr?d!=null:f==="="?e===g:f==="*="?e.indexOf(g)>=0:f==="~="?(" "+e+" ").indexOf(g)>=0:g?f==="!="?e!==g:f==="^="?e.indexOf(g)===0:f==="$="?e.substr(e.length-g.length)===g:f==="|="?e===g||e.substr(0,g.length+1)===g+"-":!1:e&&d!==!1},POS:function(a,b,c,d){var e=b[2],f=o.setFilters[e];if(f)return f(a,c,b,d)}}},p=o.match.POS,q=function(a,b){return"\\"+(b-0+1)};for(var r in o.match)o.match[r]=new RegExp(o.match[r].source+/(?![^\[]*\])(?![^\(]*\))/.source),o.leftMatch[r]=new RegExp(/(^(?:.|\r|\n)*?)/.source+o.match[r].source.replace(/\\(\d+)/g,q));var s=function(a,b){a=Array.prototype.slice.call(a,0);if(b){b.push.apply(b,a);return b}return a};try{Array.prototype.slice.call(c.documentElement.childNodes,0)[0].nodeType}catch(t){s=function(a,b){var c=0,d=b||[];if(g.call(a)==="[object Array]")Array.prototype.push.apply(d,a);else if(typeof a.length=="number")for(var e=a.length;c<e;c++)d.push(a[c]);else for(;a[c];c++)d.push(a[c]);return d}}var u,v;c.documentElement.compareDocumentPosition?u=function(a,b){if(a===b){h=!0;return 0}if(!a.compareDocumentPosition||!b.compareDocumentPosition)return a.compareDocumentPosition?-1:1;return a.compareDocumentPosition(b)&4?-1:1}:(u=function(a,b){if(a===b){h=!0;return 0}if(a.sourceIndex&&b.sourceIndex)return a.sourceIndex-b.sourceIndex;var c,d,e=[],f=[],g=a.parentNode,i=b.parentNode,j=g;if(g===i)return v(a,b);if(!g)return-1;if(!i)return 1;while(j)e.unshift(j),j=j.parentNode;j=i;while(j)f.unshift(j),j=j.parentNode;c=e.length,d=f.length;for(var k=0;k<c&&k<d;k++)if(e[k]!==f[k])return v(e[k],f[k]);return k===c?v(a,f[k],-1):v(e[k],b,1)},v=function(a,b,c){if(a===b)return c;var d=a.nextSibling;while(d){if(d===b)return-1;d=d.nextSibling}return 1}),function(){var a=c.createElement("div"),d="script"+(new Date).getTime(),e=c.documentElement;a.innerHTML="<a name='"+d+"'/>",e.insertBefore(a,e.firstChild),c.getElementById(d)&&(o.find.ID=function(a,c,d){if(typeof c.getElementById!="undefined"&&!d){var e=c.getElementById(a[1]);return e?e.id===a[1]||typeof e.getAttributeNode!="undefined"&&e.getAttributeNode("id").nodeValue===a[1]?[e]:b:[]}},o.filter.ID=function(a,b){var c=typeof a.getAttributeNode!="undefined"&&a.getAttributeNode("id");return a.nodeType===1&&c&&c.nodeValue===b}),e.removeChild(a),e=a=null}(),function(){var a=c.createElement("div");a.appendChild(c.createComment("")),a.getElementsByTagName("*").length>0&&(o.find.TAG=function(a,b){var c=b.getElementsByTagName(a[1]);if(a[1]==="*"){var d=[];for(var e=0;c[e];e++)c[e].nodeType===1&&d.push(c[e]);c=d}return c}),a.innerHTML="<a href='#'></a>",a.firstChild&&typeof a.firstChild.getAttribute!="undefined"&&a.firstChild.getAttribute("href")!=="#"&&(o.attrHandle.href=function(a){return a.getAttribute("href",2)}),a=null}(),c.querySelectorAll&&function(){var a=m,b=c.createElement("div"),d="__sizzle__";b.innerHTML="<p class='TEST'></p>";if(!b.querySelectorAll||b.querySelectorAll(".TEST").length!==0){m=function(b,e,f,g){e=e||c;if(!g&&!m.isXML(e)){var h=/^(\w+$)|^\.([\w\-]+$)|^#([\w\-]+$)/.exec(b);if(h&&(e.nodeType===1||e.nodeType===9)){if(h[1])return s(e.getElementsByTagName(b),f);if(h[2]&&o.find.CLASS&&e.getElementsByClassName)return s(e.getElementsByClassName(h[2]),f)}if(e.nodeType===9){if(b==="body"&&e.body)return s([e.body],f);if(h&&h[3]){var i=e.getElementById(h[3]);if(!i||!i.parentNode)return s([],f);if(i.id===h[3])return s([i],f)}try{return s(e.querySelectorAll(b),f)}catch(j){}}else if(e.nodeType===1&&e.nodeName.toLowerCase()!=="object"){var k=e,l=e.getAttribute("id"),n=l||d,p=e.parentNode,q=/^\s*[+~]/.test(b);l?n=n.replace(/'/g,"\\$&"):e.setAttribute("id",n),q&&p&&(e=e.parentNode);try{if(!q||p)return s(e.querySelectorAll("[id='"+n+"'] "+b),f)}catch(r){}finally{l||k.removeAttribute("id")}}}return a(b,e,f,g)};for(var e in a)m[e]=a[e];b=null}}(),function(){var a=c.documentElement,b=a.matchesSelector||a.mozMatchesSelector||a.webkitMatchesSelector||a.msMatchesSelector;if(b){var d=!b.call(c.createElement("div"),"div"),e=!1;try{b.call(c.documentElement,"[test!='']:sizzle")}catch(f){e=!0}m.matchesSelector=function(a,c){c=c.replace(/\=\s*([^'"\]]*)\s*\]/g,"='$1']");if(!m.isXML(a))try{if(e||!o.match.PSEUDO.test(c)&&!/!=/.test(c)){var f=b.call(a,c);if(f||!d||a.document&&a.document.nodeType!==11)return f}}catch(g){}return m(c,null,null,[a]).length>0}}}(),function(){var a=c.createElement("div");a.innerHTML="<div class='test e'></div><div class='test'></div>";if(!!a.getElementsByClassName&&a.getElementsByClassName("e").length!==0){a.lastChild.className="e";if(a.getElementsByClassName("e").length===1)return;o.order.splice(1,0,"CLASS"),o.find.CLASS=function(a,b,c){if(typeof b.getElementsByClassName!="undefined"&&!c)return b.getElementsByClassName(a[1])},a=null}}(),c.documentElement.contains?m.contains=function(a,b){return a!==b&&(a.contains?a.contains(b):!0)}:c.documentElement.compareDocumentPosition?m.contains=function(a,b){return!!(a.compareDocumentPosition(b)&16)}:m.contains=function(){return!1},m.isXML=function(a){var b=(a?a.ownerDocument||a:0).documentElement;return b?b.nodeName!=="HTML":!1};var y=function(a,b,c){var d,e=[],f="",g=b.nodeType?[b]:b;while(d=o.match.PSEUDO.exec(a))f+=d[0],a=a.replace(o.match.PSEUDO,"");a=o.relative[a]?a+"*":a;for(var h=0,i=g.length;h<i;h++)m(a,g[h],e,c);return m.filter(f,e)};m.attr=f.attr,m.selectors.attrMap={},f.find=m,f.expr=m.selectors,f.expr[":"]=f.expr.filters,f.unique=m.uniqueSort,f.text=m.getText,f.isXMLDoc=m.isXML,f.contains=m.contains}();var L=/Until$/,M=/^(?:parents|prevUntil|prevAll)/,N=/,/,O=/^.[^:#\[\.,]*$/,P=Array.prototype.slice,Q=f.expr.match.POS,R={children:!0,contents:!0,next:!0,prev:!0};f.fn.extend({find:function(a){var b=this,c,d;if(typeof a!="string")return f(a).filter(function(){for(c=0,d=b.length;c<d;c++)if(f.contains(b[c],this))return!0});var e=this.pushStack("","find",a),g,h,i;for(c=0,d=this.length;c<d;c++){g=e.length,f.find(a,this[c],e);if(c>0)for(h=g;h<e.length;h++)for(i=0;i<g;i++)if(e[i]===e[h]){e.splice(h--,1);break}}return e},has:function(a){var b=f(a);return this.filter(function(){for(var a=0,c=b.length;a<c;a++)if(f.contains(this,b[a]))return!0})},not:function(a){return this.pushStack(T(this,a,!1),"not",a)},filter:function(a){return this.pushStack(T(this,a,!0),"filter",a)},is:function(a){return!!a&&(typeof a=="string"?Q.test(a)?f(a,this.context).index(this[0])>=0:f.filter(a,this).length>0:this.filter(a).length>0)},closest:function(a,b){var c=[],d,e,g=this[0];if(f.isArray(a)){var h=1;while(g&&g.ownerDocument&&g!==b){for(d=0;d<a.length;d++)f(g).is(a[d])&&c.push({selector:a[d],elem:g,level:h});g=g.parentNode,h++}return c}var i=Q.test(a)||typeof a!="string"?f(a,b||this.context):0;for(d=0,e=this.length;d<e;d++){g=this[d];while(g){if(i?i.index(g)>-1:f.find.matchesSelector(g,a)){c.push(g);break}g=g.parentNode;if(!g||!g.ownerDocument||g===b||g.nodeType===11)break}}c=c.length>1?f.unique(c):c;return this.pushStack(c,"closest",a)},index:function(a){if(!a)return this[0]&&this[0].parentNode?this.prevAll().length:-1;if(typeof a=="string")return f.inArray(this[0],f(a));return f.inArray(a.jquery?a[0]:a,this)},add:function(a,b){var c=typeof a=="string"?f(a,b):f.makeArray(a&&a.nodeType?[a]:a),d=f.merge(this.get(),c);return this.pushStack(S(c[0])||S(d[0])?d:f.unique(d))},andSelf:function(){return this.add(this.prevObject)}}),f.each({parent:function(a){var b=a.parentNode;return b&&b.nodeType!==11?b:null},parents:function(a){return f.dir(a,"parentNode")},parentsUntil:function(a,b,c){return f.dir(a,"parentNode",c)},next:function(a){return f.nth(a,2,"nextSibling")},prev:function(a){return f.nth(a,2,"previousSibling")},nextAll:function(a){return f.dir(a,"nextSibling")},prevAll:function(a){return f.dir(a,"previousSibling")},nextUntil:function(a,b,c){return f.dir(a,"nextSibling",c)},prevUntil:function(a,b,c){return f.dir(a,"previousSibling",c)},siblings:function(a){return f.sibling(a.parentNode.firstChild,a)},children:function(a){return f.sibling(a.firstChild)},contents:function(a){return f.nodeName(a,"iframe")?a.contentDocument||a.contentWindow.document:f.makeArray(a.childNodes)}},function(a,b){f.fn[a]=function(c,d){var e=f.map(this,b,c);L.test(a)||(d=c),d&&typeof d=="string"&&(e=f.filter(d,e)),e=this.length>1&&!R[a]?f.unique(e):e,(this.length>1||N.test(d))&&M.test(a)&&(e=e.reverse());return this.pushStack(e,a,P.call(arguments).join(","))}}),f.extend({filter:function(a,b,c){c&&(a=":not("+a+")");return b.length===1?f.find.matchesSelector(b[0],a)?[b[0]]:[]:f.find.matches(a,b)},dir:function(a,c,d){var e=[],g=a[c];while(g&&g.nodeType!==9&&(d===b||g.nodeType!==1||!f(g).is(d)))g.nodeType===1&&e.push(g),g=g[c];return e},nth:function(a,b,c,d){b=b||1;var e=0;for(;a;a=a[c])if(a.nodeType===1&&++e===b)break;return a},sibling:function(a,b){var c=[];for(;a;a=a.nextSibling)a.nodeType===1&&a!==b&&c.push(a);return c}});var V="abbr|article|aside|audio|canvas|datalist|details|figcaption|figure|footer|header|hgroup|mark|meter|nav|output|progress|section|summary|time|video",W=/ jQuery\d+="(?:\d+|null)"/g,X=/^\s+/,Y=/<(?!area|br|col|embed|hr|img|input|link|meta|param)(([\w:]+)[^>]*)\/>/ig,Z=/<([\w:]+)/,$=/<tbody/i,_=/<|&#?\w+;/,ba=/<(?:script|style)/i,bb=/<(?:script|object|embed|option|style)/i,bc=new RegExp("<(?:"+V+")","i"),bd=/checked\s*(?:[^=]|=\s*.checked.)/i,be=/\/(java|ecma)script/i,bf=/^\s*<!(?:\[CDATA\[|\-\-)/,bg={option:[1,"<select multiple='multiple'>","</select>"],legend:[1,"<fieldset>","</fieldset>"],thead:[1,"<table>","</table>"],tr:[2,"<table><tbody>","</tbody></table>"],td:[3,"<table><tbody><tr>","</tr></tbody></table>"],col:[2,"<table><tbody></tbody><colgroup>","</colgroup></table>"],area:[1,"<map>","</map>"],_default:[0,"",""]},bh=U(c);bg.optgroup=bg.option,bg.tbody=bg.tfoot=bg.colgroup=bg.caption=bg.thead,bg.th=bg.td,f.support.htmlSerialize||(bg._default=[1,"div<div>","</div>"]),f.fn.extend({text:function(a){if(f.isFunction(a))return this.each(function(b){var c=f(this);c.text(a.call(this,b,c.text()))});if(typeof a!="object"&&a!==b)return this.empty().append((this[0]&&this[0].ownerDocument||c).createTextNode(a));return f.text(this)},wrapAll:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapAll(a.call(this,b))});if(this[0]){var b=f(a,this[0].ownerDocument).eq(0).clone(!0);this[0].parentNode&&b.insertBefore(this[0]),b.map(function(){var a=this;while(a.firstChild&&a.firstChild.nodeType===1)a=a.firstChild;return a}).append(this)}return this},wrapInner:function(a){if(f.isFunction(a))return this.each(function(b){f(this).wrapInner(a.call(this,b))});return this.each(function(){var b=f(this),c=b.contents();c.length?c.wrapAll(a):b.append(a)})},wrap:function(a){var b=f.isFunction(a);return this.each(function(c){f(this).wrapAll(b?a.call(this,c):a)})},unwrap:function(){return this.parent().each(function(){f.nodeName(this,"body")||f(this).replaceWith(this.childNodes)}).end()},append:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.appendChild(a)})},prepend:function(){return this.domManip(arguments,!0,function(a){this.nodeType===1&&this.insertBefore(a,this.firstChild)})},before:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this)});if(arguments.length){var a=f.clean(arguments);a.push.apply(a,this.toArray());return this.pushStack(a,"before",arguments)}},after:function(){if(this[0]&&this[0].parentNode)return this.domManip(arguments,!1,function(a){this.parentNode.insertBefore(a,this.nextSibling)});if(arguments.length){var a=this.pushStack(this,"after",arguments);a.push.apply(a,f.clean(arguments));return a}},remove:function(a,b){for(var c=0,d;(d=this[c])!=null;c++)if(!a||f.filter(a,[d]).length)!b&&d.nodeType===1&&(f.cleanData(d.getElementsByTagName("*")),f.cleanData([d])),d.parentNode&&d.parentNode.removeChild(d);return this},empty:function()
{for(var a=0,b;(b=this[a])!=null;a++){b.nodeType===1&&f.cleanData(b.getElementsByTagName("*"));while(b.firstChild)b.removeChild(b.firstChild)}return this},clone:function(a,b){a=a==null?!1:a,b=b==null?a:b;return this.map(function(){return f.clone(this,a,b)})},html:function(a){if(a===b)return this[0]&&this[0].nodeType===1?this[0].innerHTML.replace(W,""):null;if(typeof a=="string"&&!ba.test(a)&&(f.support.leadingWhitespace||!X.test(a))&&!bg[(Z.exec(a)||["",""])[1].toLowerCase()]){a=a.replace(Y,"<$1></$2>");try{for(var c=0,d=this.length;c<d;c++)this[c].nodeType===1&&(f.cleanData(this[c].getElementsByTagName("*")),this[c].innerHTML=a)}catch(e){this.empty().append(a)}}else f.isFunction(a)?this.each(function(b){var c=f(this);c.html(a.call(this,b,c.html()))}):this.empty().append(a);return this},replaceWith:function(a){if(this[0]&&this[0].parentNode){if(f.isFunction(a))return this.each(function(b){var c=f(this),d=c.html();c.replaceWith(a.call(this,b,d))});typeof a!="string"&&(a=f(a).detach());return this.each(function(){var b=this.nextSibling,c=this.parentNode;f(this).remove(),b?f(b).before(a):f(c).append(a)})}return this.length?this.pushStack(f(f.isFunction(a)?a():a),"replaceWith",a):this},detach:function(a){return this.remove(a,!0)},domManip:function(a,c,d){var e,g,h,i,j=a[0],k=[];if(!f.support.checkClone&&arguments.length===3&&typeof j=="string"&&bd.test(j))return this.each(function(){f(this).domManip(a,c,d,!0)});if(f.isFunction(j))return this.each(function(e){var g=f(this);a[0]=j.call(this,e,c?g.html():b),g.domManip(a,c,d)});if(this[0]){i=j&&j.parentNode,f.support.parentNode&&i&&i.nodeType===11&&i.childNodes.length===this.length?e={fragment:i}:e=f.buildFragment(a,this,k),h=e.fragment,h.childNodes.length===1?g=h=h.firstChild:g=h.firstChild;if(g){c=c&&f.nodeName(g,"tr");for(var l=0,m=this.length,n=m-1;l<m;l++)d.call(c?bi(this[l],g):this[l],e.cacheable||m>1&&l<n?f.clone(h,!0,!0):h)}k.length&&f.each(k,bp)}return this}}),f.buildFragment=function(a,b,d){var e,g,h,i,j=a[0];b&&b[0]&&(i=b[0].ownerDocument||b[0]),i.createDocumentFragment||(i=c),a.length===1&&typeof j=="string"&&j.length<512&&i===c&&j.charAt(0)==="<"&&!bb.test(j)&&(f.support.checkClone||!bd.test(j))&&(f.support.html5Clone||!bc.test(j))&&(g=!0,h=f.fragments[j],h&&h!==1&&(e=h)),e||(e=i.createDocumentFragment(),f.clean(a,i,e,d)),g&&(f.fragments[j]=h?e:1);return{fragment:e,cacheable:g}},f.fragments={},f.each({appendTo:"append",prependTo:"prepend",insertBefore:"before",insertAfter:"after",replaceAll:"replaceWith"},function(a,b){f.fn[a]=function(c){var d=[],e=f(c),g=this.length===1&&this[0].parentNode;if(g&&g.nodeType===11&&g.childNodes.length===1&&e.length===1){e[b](this[0]);return this}for(var h=0,i=e.length;h<i;h++){var j=(h>0?this.clone(!0):this).get();f(e[h])[b](j),d=d.concat(j)}return this.pushStack(d,a,e.selector)}}),f.extend({clone:function(a,b,c){var d,e,g,h=f.support.html5Clone||!bc.test("<"+a.nodeName)?a.cloneNode(!0):bo(a);if((!f.support.noCloneEvent||!f.support.noCloneChecked)&&(a.nodeType===1||a.nodeType===11)&&!f.isXMLDoc(a)){bk(a,h),d=bl(a),e=bl(h);for(g=0;d[g];++g)e[g]&&bk(d[g],e[g])}if(b){bj(a,h);if(c){d=bl(a),e=bl(h);for(g=0;d[g];++g)bj(d[g],e[g])}}d=e=null;return h},clean:function(a,b,d,e){var g;b=b||c,typeof b.createElement=="undefined"&&(b=b.ownerDocument||b[0]&&b[0].ownerDocument||c);var h=[],i;for(var j=0,k;(k=a[j])!=null;j++){typeof k=="number"&&(k+="");if(!k)continue;if(typeof k=="string")if(!_.test(k))k=b.createTextNode(k);else{k=k.replace(Y,"<$1></$2>");var l=(Z.exec(k)||["",""])[1].toLowerCase(),m=bg[l]||bg._default,n=m[0],o=b.createElement("div");b===c?bh.appendChild(o):U(b).appendChild(o),o.innerHTML=m[1]+k+m[2];while(n--)o=o.lastChild;if(!f.support.tbody){var p=$.test(k),q=l==="table"&&!p?o.firstChild&&o.firstChild.childNodes:m[1]==="<table>"&&!p?o.childNodes:[];for(i=q.length-1;i>=0;--i)f.nodeName(q[i],"tbody")&&!q[i].childNodes.length&&q[i].parentNode.removeChild(q[i])}!f.support.leadingWhitespace&&X.test(k)&&o.insertBefore(b.createTextNode(X.exec(k)[0]),o.firstChild),k=o.childNodes}var r;if(!f.support.appendChecked)if(k[0]&&typeof (r=k.length)=="number")for(i=0;i<r;i++)bn(k[i]);else bn(k);k.nodeType?h.push(k):h=f.merge(h,k)}if(d){g=function(a){return!a.type||be.test(a.type)};for(j=0;h[j];j++)if(e&&f.nodeName(h[j],"script")&&(!h[j].type||h[j].type.toLowerCase()==="text/javascript"))e.push(h[j].parentNode?h[j].parentNode.removeChild(h[j]):h[j]);else{if(h[j].nodeType===1){var s=f.grep(h[j].getElementsByTagName("script"),g);h.splice.apply(h,[j+1,0].concat(s))}d.appendChild(h[j])}}return h},cleanData:function(a){var b,c,d=f.cache,e=f.event.special,g=f.support.deleteExpando;for(var h=0,i;(i=a[h])!=null;h++){if(i.nodeName&&f.noData[i.nodeName.toLowerCase()])continue;c=i[f.expando];if(c){b=d[c];if(b&&b.events){for(var j in b.events)e[j]?f.event.remove(i,j):f.removeEvent(i,j,b.handle);b.handle&&(b.handle.elem=null)}g?delete i[f.expando]:i.removeAttribute&&i.removeAttribute(f.expando),delete d[c]}}}});var bq=/alpha\([^)]*\)/i,br=/opacity=([^)]*)/,bs=/([A-Z]|^ms)/g,bt=/^-?\d+(?:px)?$/i,bu=/^-?\d/,bv=/^([\-+])=([\-+.\de]+)/,bw={position:"absolute",visibility:"hidden",display:"block"},bx=["Left","Right"],by=["Top","Bottom"],bz,bA,bB;f.fn.css=function(a,c){if(arguments.length===2&&c===b)return this;return f.access(this,a,c,!0,function(a,c,d){return d!==b?f.style(a,c,d):f.css(a,c)})},f.extend({cssHooks:{opacity:{get:function(a,b){if(b){var c=bz(a,"opacity","opacity");return c===""?"1":c}return a.style.opacity}}},cssNumber:{fillOpacity:!0,fontWeight:!0,lineHeight:!0,opacity:!0,orphans:!0,widows:!0,zIndex:!0,zoom:!0},cssProps:{"float":f.support.cssFloat?"cssFloat":"styleFloat"},style:function(a,c,d,e){if(!!a&&a.nodeType!==3&&a.nodeType!==8&&!!a.style){var g,h,i=f.camelCase(c),j=a.style,k=f.cssHooks[i];c=f.cssProps[i]||i;if(d===b){if(k&&"get"in k&&(g=k.get(a,!1,e))!==b)return g;return j[c]}h=typeof d,h==="string"&&(g=bv.exec(d))&&(d=+(g[1]+1)*+g[2]+parseFloat(f.css(a,c)),h="number");if(d==null||h==="number"&&isNaN(d))return;h==="number"&&!f.cssNumber[i]&&(d+="px");if(!k||!("set"in k)||(d=k.set(a,d))!==b)try{j[c]=d}catch(l){}}},css:function(a,c,d){var e,g;c=f.camelCase(c),g=f.cssHooks[c],c=f.cssProps[c]||c,c==="cssFloat"&&(c="float");if(g&&"get"in g&&(e=g.get(a,!0,d))!==b)return e;if(bz)return bz(a,c)},swap:function(a,b,c){var d={};for(var e in b)d[e]=a.style[e],a.style[e]=b[e];c.call(a);for(e in b)a.style[e]=d[e]}}),f.curCSS=f.css,f.each(["height","width"],function(a,b){f.cssHooks[b]={get:function(a,c,d){var e;if(c){if(a.offsetWidth!==0)return bC(a,b,d);f.swap(a,bw,function(){e=bC(a,b,d)});return e}},set:function(a,b){if(!bt.test(b))return b;b=parseFloat(b);if(b>=0)return b+"px"}}}),f.support.opacity||(f.cssHooks.opacity={get:function(a,b){return br.test((b&&a.currentStyle?a.currentStyle.filter:a.style.filter)||"")?parseFloat(RegExp.$1)/100+"":b?"1":""},set:function(a,b){var c=a.style,d=a.currentStyle,e=f.isNumeric(b)?"alpha(opacity="+b*100+")":"",g=d&&d.filter||c.filter||"";c.zoom=1;if(b>=1&&f.trim(g.replace(bq,""))===""){c.removeAttribute("filter");if(d&&!d.filter)return}c.filter=bq.test(g)?g.replace(bq,e):g+" "+e}}),f(function(){f.support.reliableMarginRight||(f.cssHooks.marginRight={get:function(a,b){var c;f.swap(a,{display:"inline-block"},function(){b?c=bz(a,"margin-right","marginRight"):c=a.style.marginRight});return c}})}),c.defaultView&&c.defaultView.getComputedStyle&&(bA=function(a,b){var c,d,e;b=b.replace(bs,"-$1").toLowerCase(),(d=a.ownerDocument.defaultView)&&(e=d.getComputedStyle(a,null))&&(c=e.getPropertyValue(b),c===""&&!f.contains(a.ownerDocument.documentElement,a)&&(c=f.style(a,b)));return c}),c.documentElement.currentStyle&&(bB=function(a,b){var c,d,e,f=a.currentStyle&&a.currentStyle[b],g=a.style;f===null&&g&&(e=g[b])&&(f=e),!bt.test(f)&&bu.test(f)&&(c=g.left,d=a.runtimeStyle&&a.runtimeStyle.left,d&&(a.runtimeStyle.left=a.currentStyle.left),g.left=b==="fontSize"?"1em":f||0,f=g.pixelLeft+"px",g.left=c,d&&(a.runtimeStyle.left=d));return f===""?"auto":f}),bz=bA||bB,f.expr&&f.expr.filters&&(f.expr.filters.hidden=function(a){var b=a.offsetWidth,c=a.offsetHeight;return b===0&&c===0||!f.support.reliableHiddenOffsets&&(a.style&&a.style.display||f.css(a,"display"))==="none"},f.expr.filters.visible=function(a){return!f.expr.filters.hidden(a)});var bD=/%20/g,bE=/\[\]$/,bF=/\r?\n/g,bG=/#.*$/,bH=/^(.*?):[ \t]*([^\r\n]*)\r?$/mg,bI=/^(?:color|date|datetime|datetime-local|email|hidden|month|number|password|range|search|tel|text|time|url|week)$/i,bJ=/^(?:about|app|app\-storage|.+\-extension|file|res|widget):$/,bK=/^(?:GET|HEAD)$/,bL=/^\/\//,bM=/\?/,bN=/<script\b[^<]*(?:(?!<\/script>)<[^<]*)*<\/script>/gi,bO=/^(?:select|textarea)/i,bP=/\s+/,bQ=/([?&])_=[^&]*/,bR=/^([\w\+\.\-]+:)(?:\/\/([^\/?#:]*)(?::(\d+))?)?/,bS=f.fn.load,bT={},bU={},bV,bW,bX=["*/"]+["*"];try{bV=e.href}catch(bY){bV=c.createElement("a"),bV.href="",bV=bV.href}bW=bR.exec(bV.toLowerCase())||[],f.fn.extend({load:function(a,c,d){if(typeof a!="string"&&bS)return bS.apply(this,arguments);if(!this.length)return this;var e=a.indexOf(" ");if(e>=0){var g=a.slice(e,a.length);a=a.slice(0,e)}var h="GET";c&&(f.isFunction(c)?(d=c,c=b):typeof c=="object"&&(c=f.param(c,f.ajaxSettings.traditional),h="POST"));var i=this;f.ajax({url:a,type:h,dataType:"html",data:c,complete:function(a,b,c){c=a.responseText,a.isResolved()&&(a.done(function(a){c=a}),i.html(g?f("<div>").append(c.replace(bN,"")).find(g):c)),d&&i.each(d,[c,b,a])}});return this},serialize:function(){return f.param(this.serializeArray())},serializeArray:function(){return this.map(function(){return this.elements?f.makeArray(this.elements):this}).filter(function(){return this.name&&!this.disabled&&(this.checked||bO.test(this.nodeName)||bI.test(this.type))}).map(function(a,b){var c=f(this).val();return c==null?null:f.isArray(c)?f.map(c,function(a,c){return{name:b.name,value:a.replace(bF,"\r\n")}}):{name:b.name,value:c.replace(bF,"\r\n")}}).get()}}),f.each("ajaxStart ajaxStop ajaxComplete ajaxError ajaxSuccess ajaxSend".split(" "),function(a,b){f.fn[b]=function(a){return this.on(b,a)}}),f.each(["get","post"],function(a,c){f[c]=function(a,d,e,g){f.isFunction(d)&&(g=g||e,e=d,d=b);return f.ajax({type:c,url:a,data:d,success:e,dataType:g})}}),f.extend({getScript:function(a,c){return f.get(a,b,c,"script")},getJSON:function(a,b,c){return f.get(a,b,c,"json")},ajaxSetup:function(a,b){b?b_(a,f.ajaxSettings):(b=a,a=f.ajaxSettings),b_(a,b);return a},ajaxSettings:{url:bV,isLocal:bJ.test(bW[1]),global:!0,type:"GET",contentType:"application/x-www-form-urlencoded",processData:!0,async:!0,accepts:{xml:"application/xml, text/xml",html:"text/html",text:"text/plain",json:"application/json, text/javascript","*":bX},contents:{xml:/xml/,html:/html/,json:/json/},responseFields:{xml:"responseXML",text:"responseText"},converters:{"* text":a.String,"text html":!0,"text json":f.parseJSON,"text xml":f.parseXML},flatOptions:{context:!0,url:!0}},ajaxPrefilter:bZ(bT),ajaxTransport:bZ(bU),ajax:function(a,c){function w(a,c,l,m){if(s!==2){s=2,q&&clearTimeout(q),p=b,n=m||"",v.readyState=a>0?4:0;var o,r,u,w=c,x=l?cb(d,v,l):b,y,z;if(a>=200&&a<300||a===304){if(d.ifModified){if(y=v.getResponseHeader("Last-Modified"))f.lastModified[k]=y;if(z=v.getResponseHeader("Etag"))f.etag[k]=z}if(a===304)w="notmodified",o=!0;else try{r=cc(d,x),w="success",o=!0}catch(A){w="parsererror",u=A}}else{u=w;if(!w||a)w="error",a<0&&(a=0)}v.status=a,v.statusText=""+(c||w),o?h.resolveWith(e,[r,w,v]):h.rejectWith(e,[v,w,u]),v.statusCode(j),j=b,t&&g.trigger("ajax"+(o?"Success":"Error"),[v,d,o?r:u]),i.fireWith(e,[v,w]),t&&(g.trigger("ajaxComplete",[v,d]),--f.active||f.event.trigger("ajaxStop"))}}typeof a=="object"&&(c=a,a=b),c=c||{};var d=f.ajaxSetup({},c),e=d.context||d,g=e!==d&&(e.nodeType||e instanceof f)?f(e):f.event,h=f.Deferred(),i=f.Callbacks("once memory"),j=d.statusCode||{},k,l={},m={},n,o,p,q,r,s=0,t,u,v={readyState:0,setRequestHeader:function(a,b){if(!s){var c=a.toLowerCase();a=m[c]=m[c]||a,l[a]=b}return this},getAllResponseHeaders:function(){return s===2?n:null},getResponseHeader:function(a){var c;if(s===2){if(!o){o={};while(c=bH.exec(n))o[c[1].toLowerCase()]=c[2]}c=o[a.toLowerCase()]}return c===b?null:c},overrideMimeType:function(a){s||(d.mimeType=a);return this},abort:function(a){a=a||"abort",p&&p.abort(a),w(0,a);return this}};h.promise(v),v.success=v.done,v.error=v.fail,v.complete=i.add,v.statusCode=function(a){if(a){var b;if(s<2)for(b in a)j[b]=[j[b],a[b]];else b=a[v.status],v.then(b,b)}return this},d.url=((a||d.url)+"").replace(bG,"").replace(bL,bW[1]+"//"),d.dataTypes=f.trim(d.dataType||"*").toLowerCase().split(bP),d.crossDomain==null&&(r=bR.exec(d.url.toLowerCase()),d.crossDomain=!(!r||r[1]==bW[1]&&r[2]==bW[2]&&(r[3]||(r[1]==="http:"?80:443))==(bW[3]||(bW[1]==="http:"?80:443)))),d.data&&d.processData&&typeof d.data!="string"&&(d.data=f.param(d.data,d.traditional)),b$(bT,d,c,v);if(s===2)return!1;t=d.global,d.type=d.type.toUpperCase(),d.hasContent=!bK.test(d.type),t&&f.active++===0&&f.event.trigger("ajaxStart");if(!d.hasContent){d.data&&(d.url+=(bM.test(d.url)?"&":"?")+d.data,delete d.data),k=d.url;if(d.cache===!1){var x=f.now(),y=d.url.replace(bQ,"$1_="+x);d.url=y+(y===d.url?(bM.test(d.url)?"&":"?")+"_="+x:"")}}(d.data&&d.hasContent&&d.contentType!==!1||c.contentType)&&v.setRequestHeader("Content-Type",d.contentType),d.ifModified&&(k=k||d.url,f.lastModified[k]&&v.setRequestHeader("If-Modified-Since",f.lastModified[k]),f.etag[k]&&v.setRequestHeader("If-None-Match",f.etag[k])),v.setRequestHeader("Accept",d.dataTypes[0]&&d.accepts[d.dataTypes[0]]?d.accepts[d.dataTypes[0]]+(d.dataTypes[0]!=="*"?", "+bX+"; q=0.01":""):d.accepts["*"]);for(u in d.headers)v.setRequestHeader(u,d.headers[u]);if(d.beforeSend&&(d.beforeSend.call(e,v,d)===!1||s===2)){v.abort();return!1}for(u in{success:1,error:1,complete:1})v[u](d[u]);p=b$(bU,d,c,v);if(!p)w(-1,"No Transport");else{v.readyState=1,t&&g.trigger("ajaxSend",[v,d]),d.async&&d.timeout>0&&(q=setTimeout(function(){v.abort("timeout")},d.timeout));try{s=1,p.send(l,w)}catch(z){if(s<2)w(-1,z);else throw z}}return v},param:function(a,c){var d=[],e=function(a,b){b=f.isFunction(b)?b():b,d[d.length]=encodeURIComponent(a)+"="+encodeURIComponent(b)};c===b&&(c=f.ajaxSettings.traditional);if(f.isArray(a)||a.jquery&&!f.isPlainObject(a))f.each(a,function(){e(this.name,this.value)});else for(var g in a)ca(g,a[g],c,e);return d.join("&").replace(bD,"+")}}),f.extend({active:0,lastModified:{},etag:{}});var cd=f.now(),ce=/(\=)\?(&|$)|\?\?/i;f.ajaxSetup({jsonp:"callback",jsonpCallback:function(){return f.expando+"_"+cd++}}),f.ajaxPrefilter("json jsonp",function(b,c,d){var e=b.contentType==="application/x-www-form-urlencoded"&&typeof b.data=="string";if(b.dataTypes[0]==="jsonp"||b.jsonp!==!1&&(ce.test(b.url)||e&&ce.test(b.data))){var g,h=b.jsonpCallback=f.isFunction(b.jsonpCallback)?b.jsonpCallback():b.jsonpCallback,i=a[h],j=b.url,k=b.data,l="$1"+h+"$2";b.jsonp!==!1&&(j=j.replace(ce,l),b.url===j&&(e&&(k=k.replace(ce,l)),b.data===k&&(j+=(/\?/.test(j)?"&":"?")+b.jsonp+"="+h))),b.url=j,b.data=k,a[h]=function(a){g=[a]},d.always(function(){a[h]=i,g&&f.isFunction(i)&&a[h](g[0])}),b.converters["script json"]=function(){g||f.error(h+" was not called");return g[0]},b.dataTypes[0]="json";return"script"}}),f.ajaxSetup({accepts:{script:"text/javascript, application/javascript, application/ecmascript, application/x-ecmascript"},contents:{script:/javascript|ecmascript/},converters:{"text script":function(a){f.globalEval(a);return a}}}),f.ajaxPrefilter("script",function(a){a.cache===b&&(a.cache=!1),a.crossDomain&&(a.type="GET",a.global=!1)}),f.ajaxTransport("script",function(a){if(a.crossDomain){var d,e=c.head||c.getElementsByTagName("head")[0]||c.documentElement;return{send:function(f,g){d=c.createElement("script"),d.async="async",a.scriptCharset&&(d.charset=a.scriptCharset),d.src=a.url,d.onload=d.onreadystatechange=function(a,c){if(c||!d.readyState||/loaded|complete/.test(d.readyState))d.onload=d.onreadystatechange=null,e&&d.parentNode&&e.removeChild(d),d=b,c||g(200,"success")},e.insertBefore(d,e.firstChild)},abort:function(){d&&d.onload(0,1)}}}});var cf=a.ActiveXObject?function(){for(var a in ch)ch[a](0,1)}:!1,cg=0,ch;f.ajaxSettings.xhr=a.ActiveXObject?function(){return!this.isLocal&&ci()||cj()}:ci,function(a){f.extend(f.support,{ajax:!!a,cors:!!a&&"withCredentials"in a})}(f.ajaxSettings.xhr()),f.support.ajax&&f.ajaxTransport(function(c){if(!c.crossDomain||f.support.cors){var d;return{send:function(e,g){var h=c.xhr(),i,j;c.username?h.open(c.type,c.url,c.async,c.username,c.password):h.open(c.type,c.url,c.async);if(c.xhrFields)for(j in c.xhrFields)h[j]=c.xhrFields[j];c.mimeType&&h.overrideMimeType&&h.overrideMimeType(c.mimeType),!c.crossDomain&&!e["X-Requested-With"]&&(e["X-Requested-With"]="XMLHttpRequest");try{for(j in e)h.setRequestHeader(j,e[j])}catch(k){}h.send(c.hasContent&&c.data||null),d=function(a,e){var j,k,l,m,n;try{if(d&&(e||h.readyState===4)){d=b,i&&(h.onreadystatechange=f.noop,cf&&delete ch[i]);if(e)h.readyState!==4&&h.abort();else{j=h.status,l=h.getAllResponseHeaders(),m={},n=h.responseXML,n&&n.documentElement&&(m.xml=n),m.text=h.responseText;try{k=h.statusText}catch(o){k=""}!j&&c.isLocal&&!c.crossDomain?j=m.text?200:404:j===1223&&(j=204)}}}catch(p){e||g(-1,p)}m&&g(j,k,m,l)},!c.async||h.readyState===4?d():(i=++cg,cf&&(ch||(ch={},f(a).unload(cf)),ch[i]=d),h.onreadystatechange=d)},abort:function(){d&&d(0,1)}}}});var ck={},cl,cm,cn=/^(?:toggle|show|hide)$/,co=/^([+\-]=)?([\d+.\-]+)([a-z%]*)$/i,cp,cq=[["height","marginTop","marginBottom","paddingTop","paddingBottom"],["width","marginLeft","marginRight","paddingLeft","paddingRight"],["opacity"]],cr;f.fn.extend({show:function(a,b,c){var d,e;if(a||a===0)return this.animate(cu("show",3),a,b,c);for(var g=0,h=this.length;g<h;g++)d=this[g],d.style&&(e=d.style.display,!f._data(d,"olddisplay")&&e==="none"&&(e=d.style.display=""),e===""&&f.css(d,"display")==="none"&&f._data(d,"olddisplay",cv(d.nodeName)));for(g=0;g<h;g++){d=this[g];if(d.style){e=d.style.display;if(e===""||e==="none")d.style.display=f._data(d,"olddisplay")||""}}return this},hide:function(a,b,c){if(a||a===0)return this.animate(cu("hide",3),a,b,c);var d,e,g=0,h=this.length;for(;g<h;g++)d=this[g],d.style&&(e=f.css(d,"display"),e!=="none"&&!f._data(d,"olddisplay")&&f._data(d,"olddisplay",e));for(g=0;g<h;g++)this[g].style&&(this[g].style.display="none");return this},_toggle:f.fn.toggle,toggle:function(a,b,c){var d=typeof a=="boolean";f.isFunction(a)&&f.isFunction(b)?this._toggle.apply(this,arguments):a==null||d?this.each(function(){var b=d?a:f(this).is(":hidden");f(this)[b?"show":"hide"]()}):this.animate(cu("toggle",3),a,b,c);return this},fadeTo:function(a,b,c,d){return this.filter(":hidden").css("opacity",0).show().end().animate({opacity:b},a,c,d)},animate:function(a,b,c,d){function g(){e.queue===!1&&f._mark(this);var b=f.extend({},e),c=this.nodeType===1,d=c&&f(this).is(":hidden"),g,h,i,j,k,l,m,n,o;b.animatedProperties={};for(i in a){g=f.camelCase(i),i!==g&&(a[g]=a[i],delete a[i]),h=a[g],f.isArray(h)?(b.animatedProperties[g]=h[1],h=a[g]=h[0]):b.animatedProperties[g]=b.specialEasing&&b.specialEasing[g]||b.easing||"swing";if(h==="hide"&&d||h==="show"&&!d)return b.complete.call(this);c&&(g==="height"||g==="width")&&(b.overflow=[this.style.overflow,this.style.overflowX,this.style.overflowY],f.css(this,"display")==="inline"&&f.css(this,"float")==="none"&&(!f.support.inlineBlockNeedsLayout||cv(this.nodeName)==="inline"?this.style.display="inline-block":this.style.zoom=1))}b.overflow!=null&&(this.style.overflow="hidden");for(i in a)j=new f.fx(this,b,i),h=a[i],cn.test(h)?(o=f._data(this,"toggle"+i)||(h==="toggle"?d?"show":"hide":0),o?(f._data(this,"toggle"+i,o==="show"?"hide":"show"),j[o]()):j[h]()):(k=co.exec(h),l=j.cur(),k?(m=parseFloat(k[2]),n=k[3]||(f.cssNumber[i]?"":"px"),n!=="px"&&(f.style(this,i,(m||1)+n),l=(m||1)/j.cur()*l,f.style(this,i,l+n)),k[1]&&(m=(k[1]==="-="?-1:1)*m+l),j.custom(l,m,n)):j.custom(l,h,""));return!0}var e=f.speed(b,c,d);if(f.isEmptyObject(a))return this.each(e.complete,[!1]);a=f.extend({},a);return e.queue===!1?this.each(g):this.queue(e.queue,g)},stop:function(a,c,d){typeof a!="string"&&(d=c,c=a,a=b),c&&a!==!1&&this.queue(a||"fx",[]);return this.each(function(){function h(a,b,c){var e=b[c];f.removeData(a,c,!0),e.stop(d)}var b,c=!1,e=f.timers,g=f._data(this);d||f._unmark(!0,this);if(a==null)for(b in g)g[b]&&g[b].stop&&b.indexOf(".run")===b.length-4&&h(this,g,b);else g[b=a+".run"]&&g[b].stop&&h(this,g,b);for(b=e.length;b--;)e[b].elem===this&&(a==null||e[b].queue===a)&&(d?e[b](!0):e[b].saveState(),c=!0,e.splice(b,1));(!d||!c)&&f.dequeue(this,a)})}}),f.each({slideDown:cu("show",1),slideUp:cu("hide",1),slideToggle:cu("toggle",1),fadeIn:{opacity:"show"},fadeOut:{opacity:"hide"},fadeToggle:{opacity:"toggle"}},function(a,b){f.fn[a]=function(a,c,d){return this.animate(b,a,c,d)}}),f.extend({speed:function(a,b,c){var d=a&&typeof a=="object"?f.extend({},a):{complete:c||!c&&b||f.isFunction(a)&&a,duration:a,easing:c&&b||b&&!f.isFunction(b)&&b};d.duration=f.fx.off?0:typeof d.duration=="number"?d.duration:d.duration in f.fx.speeds?f.fx.speeds[d.duration]:f.fx.speeds._default;if(d.queue==null||d.queue===!0)d.queue="fx";d.old=d.complete,d.complete=function(a){f.isFunction(d.old)&&d.old.call(this),d.queue?f.dequeue(this,d.queue):a!==!1&&f._unmark(this)};return d},easing:{linear:function(a,b,c,d){return c+d*a},swing:function(a,b,c,d){return(-Math.cos(a*Math.PI)/2+.5)*d+c}},timers:[],fx:function(a,b,c){this.options=b,this.elem=a,this.prop=c,b.orig=b.orig||{}}}),f.fx.prototype={update:function(){this.options.step&&this.options.step.call(this.elem,this.now,this),(f.fx.step[this.prop]||f.fx.step._default)(this)},cur:function(){if(this.elem[this.prop]!=null&&(!this.elem.style||this.elem.style[this.prop]==null))return this.elem[this.prop];var a,b=f.css(this.elem,this.prop);return isNaN(a=parseFloat(b))?!b||b==="auto"?0:b:a},custom:function(a,c,d){function h(a){return e.step(a)}var e=this,g=f.fx;this.startTime=cr||cs(),this.end=c,this.now=this.start=a,this.pos=this.state=0,this.unit=d||this.unit||(f.cssNumber[this.prop]?"":"px"),h.queue=this.options.queue,h.elem=this.elem,h.saveState=function(){e.options.hide&&f._data(e.elem,"fxshow"+e.prop)===b&&f._data(e.elem,"fxshow"+e.prop,e.start)},h()&&f.timers.push(h)&&!cp&&(cp=setInterval(g.tick,g.interval))},show:function(){var a=f._data(this.elem,"fxshow"+this.prop);this.options.orig[this.prop]=a||f.style(this.elem,this.prop),this.options.show=!0,a!==b?this.custom(this.cur(),a):this.custom(this.prop==="width"||this.prop==="height"?1:0,this.cur()),f(this.elem).show()},hide:function(){this.options.orig[this.prop]=f._data(this.elem,"fxshow"+this.prop)||f.style(this.elem,this.prop),this.options.hide=!0,this.custom(this.cur(),0)},step:function(a){var b,c,d,e=cr||cs(),g=!0,h=this.elem,i=this.options;if(a||e>=i.duration+this.startTime){this.now=this.end,this.pos=this.state=1,this.update(),i.animatedProperties[this.prop]=!0;for(b in i.animatedProperties)i.animatedProperties[b]!==!0&&(g=!1);if(g){i.overflow!=null&&!f.support.shrinkWrapBlocks&&f.each(["","X","Y"],function(a,b){h.style["overflow"+b]=i.overflow[a]}),i.hide&&f(h).hide();if(i.hide||i.show)for(b in i.animatedProperties)f.style(h,b,i.orig[b]),f.removeData(h,"fxshow"+b,!0),f.removeData(h,"toggle"+b,!0);d=i.complete,d&&(i.complete=!1,d.call(h))}return!1}i.duration==Infinity?this.now=e:(c=e-this.startTime,this.state=c/i.duration,this.pos=f.easing[i.animatedProperties[this.prop]](this.state,c,0,1,i.duration),this.now=this.start+(this.end-this.start)*this.pos),this.update();return!0}},f.extend(f.fx,{tick:function(){var a,b=f.timers,c=0;for(;c<b.length;c++)a=b[c],!a()&&b[c]===a&&b.splice(c--,1);b.length||f.fx.stop()},interval:13,stop:function(){clearInterval(cp),cp=null},speeds:{slow:600,fast:200,_default:400},step:{opacity:function(a){f.style(a.elem,"opacity",a.now)},_default:function(a){a.elem.style&&a.elem.style[a.prop]!=null?a.elem.style[a.prop]=a.now+a.unit:a.elem[a.prop]=a.now}}}),f.each(["width","height"],function(a,b){f.fx.step[b]=function(a){f.style(a.elem,b,Math.max(0,a.now)+a.unit)}}),f.expr&&f.expr.filters&&(f.expr.filters.animated=function(a){return f.grep(f.timers,function(b){return a===b.elem}).length});var cw=/^t(?:able|d|h)$/i,cx=/^(?:body|html)$/i;"getBoundingClientRect"in c.documentElement?f.fn.offset=function(a){var b=this[0],c;if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);try{c=b.getBoundingClientRect()}catch(d){}var e=b.ownerDocument,g=e.documentElement;if(!c||!f.contains(g,b))return c?{top:c.top,left:c.left}:{top:0,left:0};var h=e.body,i=cy(e),j=g.clientTop||h.clientTop||0,k=g.clientLeft||h.clientLeft||0,l=i.pageYOffset||f.support.boxModel&&g.scrollTop||h.scrollTop,m=i.pageXOffset||f.support.boxModel&&g.scrollLeft||h.scrollLeft,n=c.top+l-j,o=c.left+m-k;return{top:n,left:o}}:f.fn.offset=function(a){var b=this[0];if(a)return this.each(function(b){f.offset.setOffset(this,a,b)});if(!b||!b.ownerDocument)return null;if(b===b.ownerDocument.body)return f.offset.bodyOffset(b);var c,d=b.offsetParent,e=b,g=b.ownerDocument,h=g.documentElement,i=g.body,j=g.defaultView,k=j?j.getComputedStyle(b,null):b.currentStyle,l=b.offsetTop,m=b.offsetLeft;while((b=b.parentNode)&&b!==i&&b!==h){if(f.support.fixedPosition&&k.position==="fixed")break;c=j?j.getComputedStyle(b,null):b.currentStyle,l-=b.scrollTop,m-=b.scrollLeft,b===d&&(l+=b.offsetTop,m+=b.offsetLeft,f.support.doesNotAddBorder&&(!f.support.doesAddBorderForTableAndCells||!cw.test(b.nodeName))&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),e=d,d=b.offsetParent),f.support.subtractsBorderForOverflowNotVisible&&c.overflow!=="visible"&&(l+=parseFloat(c.borderTopWidth)||0,m+=parseFloat(c.borderLeftWidth)||0),k=c}if(k.position==="relative"||k.position==="static")l+=i.offsetTop,m+=i.offsetLeft;f.support.fixedPosition&&k.position==="fixed"&&(l+=Math.max(h.scrollTop,i.scrollTop),m+=Math.max(h.scrollLeft,i.scrollLeft));return{top:l,left:m}},f.offset={bodyOffset:function(a){var b=a.offsetTop,c=a.offsetLeft;f.support.doesNotIncludeMarginInBodyOffset&&(b+=parseFloat(f.css(a,"marginTop"))||0,c+=parseFloat(f.css(a,"marginLeft"))||0);return{top:b,left:c}},setOffset:function(a,b,c){var d=f.css(a,"position");d==="static"&&(a.style.position="relative");var e=f(a),g=e.offset(),h=f.css(a,"top"),i=f.css(a,"left"),j=(d==="absolute"||d==="fixed")&&f.inArray("auto",[h,i])>-1,k={},l={},m,n;j?(l=e.position(),m=l.top,n=l.left):(m=parseFloat(h)||0,n=parseFloat(i)||0),f.isFunction(b)&&(b=b.call(a,c,g)),b.top!=null&&(k.top=b.top-g.top+m),b.left!=null&&(k.left=b.left-g.left+n),"using"in b?b.using.call(a,k):e.css(k)}},f.fn.extend({position:function(){if(!this[0])return null;var a=this[0],b=this.offsetParent(),c=this.offset(),d=cx.test(b[0].nodeName)?{top:0,left:0}:b.offset();c.top-=parseFloat(f.css(a,"marginTop"))||0,c.left-=parseFloat(f.css(a,"marginLeft"))||0,d.top+=parseFloat(f.css(b[0],"borderTopWidth"))||0,d.left+=parseFloat(f.css(b[0],"borderLeftWidth"))||0;return{top:c.top-d.top,left:c.left-d.left}},offsetParent:function(){return this.map(function(){var a=this.offsetParent||c.body;while(a&&!cx.test(a.nodeName)&&f.css(a,"position")==="static")a=a.offsetParent;return a})}}),f.each(["Left","Top"],function(a,c){var d="scroll"+c;f.fn[d]=function(c){var e,g;if(c===b){e=this[0];if(!e)return null;g=cy(e);return g?"pageXOffset"in g?g[a?"pageYOffset":"pageXOffset"]:f.support.boxModel&&g.document.documentElement[d]||g.document.body[d]:e[d]}return this.each(function(){g=cy(this),g?g.scrollTo(a?f(g).scrollLeft():c,a?c:f(g).scrollTop()):this[d]=c})}}),f.each(["Height","Width"],function(a,c){var d=c.toLowerCase();f.fn["inner"+c]=function(){var a=this[0];return a?a.style?parseFloat(f.css(a,d,"padding")):this[d]():null},f.fn["outer"+c]=function(a){var b=this[0];return b?b.style?parseFloat(f.css(b,d,a?"margin":"border")):this[d]():null},f.fn[d]=function(a){var e=this[0];if(!e)return a==null?null:this;if(f.isFunction(a))return this.each(function(b){var c=f(this);c[d](a.call(this,b,c[d]()))});if(f.isWindow(e)){var g=e.document.documentElement["client"+c],h=e.document.body;return e.document.compatMode==="CSS1Compat"&&g||h&&h["client"+c]||g}if(e.nodeType===9)return Math.max(e.documentElement["client"+c],e.body["scroll"+c],e.documentElement["scroll"+c],e.body["offset"+c],e.documentElement["offset"+c]);if(a===b){var i=f.css(e,d),j=parseFloat(i);return f.isNumeric(j)?j:i}return this.css(d,typeof a=="string"?a:a+"px")}}),a.jQuery=a.$=f,typeof define=="function"&&define.amd&&define.amd.jQuery&&define("jquery",[],function(){return f})})(window);
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B 1 Foxml version="1.0" encoding="UTF-8"7>
3% Copyright 2014-2017, Red Hat, Inc. and/or its affiliates, and individuall]

176 This is the 0SGi Blueprint XML file defining the Camel context and routes. Because the file is in the[]

235 <blueprint xmlns="http: //www.0sgi. org/xmlns/blueprint/v1.0.0"

24 xmlns:xsi="http://waw. w3.org/2601/XM.Schema-instance" xsi:schemalocation=" http://war. 0sgi. org/xr
268 The. namespace for the cancleontext slomnt in Blucprint 15 hetpes//canel .apache.ora/schanayblusprint’ -0
516 <camelContext id="cbr-example-context" xmlns="http://camel.apache. org/schema/blueprint">

33 when this route is started, it will automatically create the work/cbr/input directory where you can drop
440 <route id="cbr-route">

45 <from id="_from1" uri="file:work/cbr/input"/>

26 _Togl" message="Receiving order ${file:name}"/>

478 choicel">

489 _when1">

49 <xpath id="_xpathl">/order/customer/country = 'LK'</xpath>

50 <log 1d="_l0g2" message="Sending order ${file:name} to the UK'/>

s1 <to id="_Fol* uri="file:work/chr/output/uk' />

52 </uhen>

539 <when id="_when2">

54 <xpath id="_xpath2">/order /customer/country = 'US'</xpath>

s5 <log 1d="_l0g3" message="Sending order ${file:name} to the US'/>

56 <to id="_Fo2" uri="file:work/chr/output/us"/>

57 </uhen>

se2 <otherwise id="_otherwisel">

s9 <log 1d="_l0g4" message="Sending order ${file:name} to another country"/>

0 <to id="_Fo3* uri="file:work/cbr/output/others"/>

61 </otherwise>]

62 </choice>

63 <log id="_log5" message='Done processing ${file:name}"/>

4 </route>

65 </camelContext>

66 </blueprint>
———

B soure ) Contauraions |
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1 K2xnl version="1.6" encoding="UTF-8"75
29 <beans xmlns="http://wa. springframework. org/schema/beans"

5 xmlns:camel="http://camel.apache. org/ schema/ spring®
4 xmlnsixsi="http://wv.u3.org/2601/XHLSchema-instance" xsi:schemalocation="http: //waw. spr
5 <bean

s class="org. springframework. aop. framework. AbstractAdvisingBeanPostProcessor®

7 id="Transformsean" scope="singleton" />

85 <camelContext id="camelContext-500b5988-86f7-4387-adbf-049d5220c1F2"
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# Highlight.js

[![Build Status](https://travis-ci.org/isagalaev/highlight.js.svg?branch=master)](https://travis-ci.org/isagalaev/highlight.js)

Highlight.js is a syntax highlighter written in JavaScript. It works in the
browser as well as on the server. It works with pretty much any markup,
doesn't depend on any framework and has automatic language detection.


## Getting Started

The bare minimum for using highlight.js on a web page is linking to the library
along with one of the styles and calling [`initHighlightingOnLoad`][1]:

```html
<link rel="stylesheet" href="/path/to/styles/default.css">
<script src="/path/to/highlight.pack.js"></script>
<script>hljs.initHighlightingOnLoad();</script>
```

This will find and highlight code inside of `<pre><code>` tags trying to detect
the language automatically. If automatic detection doesn't work for you, you can
specify the language in the class attribute:

```html
<pre><code class="html">...</code></pre>
```

The list of supported language classes is available in the [class reference][8].
Classes can also be prefixed with either `language-` or `lang-`.

To disable highlighting altogether use the `nohighlight` class:

```html
<pre><code class="nohighlight">...</code></pre>
```

## Custom Initialization

When you need a bit more control over the initialization of
highlight.js, you can use the [`highlightBlock`][2] and [`configure`][3]
functions. This allows you to control *what* to highlight and *when*.

Here's an equivalent way to calling [`initHighlightingOnLoad`][1] using jQuery:

```javascript
$(document).ready(function() {
  $('pre code').each(function(i, block) {
    hljs.highlightBlock(block);
  });
});
```

You can use any tags instead of `<pre><code>` to mark up your code. If you don't
use a container that preserve line breaks you will need to configure
highlight.js to use the `<br>` tag:

```javascript
hljs.configure({useBR: true});

$('div.code').each(function(i, block) {
  hljs.highlightBlock(block);
});
```

For other options refer to the documentation for [`configure`][3].


## Getting the Library

You can get highlight.js as a hosted or custom-build browser script or as a
server module. Head over to the [download page][4] for all the options.

Note, that the library is not supposed to work straight from the source on
GitHub, it requires building. If none of the pre-packaged options work for you
refer to the [building documentation][5].


## License

Highlight.js is released under the BSD License. See [LICENSE][10] file for
details.


## Links

The official site for the library is at <https://highlightjs.org/>.

Further in-depth documentation for the API and other topics is at
<http://highlightjs.readthedocs.org/>.

Authors and contributors are listed in the [AUTHORS.en.txt][9] file.

[1]: http://highlightjs.readthedocs.org/en/latest/api.html#inithighlightingonload
[2]: http://highlightjs.readthedocs.org/en/latest/api.html#highlightblock-block
[3]: http://highlightjs.readthedocs.org/en/latest/api.html#configure-options
[4]: https://highlightjs.org/download/
[5]: http://highlightjs.readthedocs.org/en/latest/building-testing.html
[8]: http://highlightjs.readthedocs.org/en/latest/css-classes-reference.html
[9]: https://github.com/isagalaev/highlight.js/blob/master/AUTHORS.en.txt
[10]: https://github.com/isagalaev/highlight.js/blob/master/LICENSE
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var work = 1;

function pop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popper/,"popped");
	}
}
function unpop(entity) {
	if(entity) {
		var my_parent = entity.parentNode;
		var my_class = my_parent.className;
		my_parent.className = my_class.replace(/popped/,"popper");
	}
}

function siblings(entity){
	var r = [];
	for ( var n = entity.parentNode.firstChild; n; n = n.nextSibling ) 
		if ( n.nodeType == 1 && n != entity)
			r.push( n );		
	return r;
}

/* This activates an element and deactivates all it's siblings */
function activateElement(id) {
	var entity = document.getElementById(id);
	if(entity.className.indexOf("active") == -1) {
		entity.className = entity.className + " active";
	}
	var sibs = siblings(entity);

	for(var i=0; i < sibs.length; i++) {
		if(sibs[i].className.indexOf("active") != -1) {
			deactivateElement(sibs[i]);
		}
	}
}

function deactivateElement(entity) {
	if(entity.className.indexOf("active") != -1) {
		 entity.className = entity.className.replace(/[ ]*active/, '');
	}
}

function getCookie(name) {
	var name_c = window.location.hostname + '-' + name;

	if(document.cookie) {
		var cookies = document.cookie.split(/ *; */);
		for(var i=0; i < cookies.length; i++) {
			var current_c = cookies[i].split("=");
			if(current_c[0] == name_c) {
				return(current_c[1]);
				break;
			}
		}
	}
	return('');
}

function setCookie(name, value, expires, path) {
	name = window.location.hostname + '-' + name;

	var curCookie = name + "=" + value + 
		((expires) ? ";expires=" + expires.toGMTString() : "") + 
		((path) ? ";path=" + path : "");
	document.cookie = curCookie; 
}

function setDefLangCookie(entity) {
	setCookie('switchery', entity.options[entity.selectedIndex].value, '', '/');
}

function initSwitchery() {
	var divs = document.getElementsByTagName('div');
	for(i in divs) {
		if(typeof(divs[i].className) != 'undefined' && divs[i].className.indexOf("switchery") != -1) {
			var lang = getCookie('switchery');
			if(lang != '') {
				var entity = document.getElementById(divs[i].id + '-' + lang);
				if(entity) {
					entity.onclick();
					entity.parentNode.lastChild.value = lang;
				} else {
					divs[i].firstChild.firstChild.onclick();
				}
			} else {
				divs[i].firstChild.firstChild.onclick();
			}
		}
	}

}

function showhide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("hidden") != -1) {
				entity.className = my_class.replace(/hidden/,"visible");
			}
			else if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	}

	return false;
}

function hide(id) {
	if(work) {
		work = 0;
		var entity = document.getElementById(id);
		if(entity) {
			var my_class = entity.className;
			if(my_class.indexOf("visible") != -1) {
				entity.className = my_class.replace(/visible/,"hidden");
			}
		}
	} else {
		work=1;
	}
}

var preventReset = 0;

function dehighlightTarget(entity) {
	if(preventReset == 0 && entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		var target = document.getElementById(id);
		if(target) {
			deactivateElement(target);
		}
		}
}

function highlightTarget(entity, norefresh) {
	if(entity) {
		var id = entity.href;
		if(id.indexOf("#") != -1) {
			id = id.substr(id.indexOf('#')+1);
		}
		activateElement(id);
		preventReset = 0;
	} 
	if(norefresh == 1) {
		preventReset=1;
	}
}
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